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in this document without notice.
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out of or relating to this documentation or the information contained in it, even
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from tort (including negligence), breach of contract or otherwise.
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information and a proprietary product of Saba Software, Inc.
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with the terms of this Commercial Software Agreement as specified in 48 C.F.R.
12.212 of the Federal Acquisition Regulations and its successors; (ii) for
acquisition by or on behalf of units of the Department of Defense ("DOD") as
necessary to obtain protection as "commercial computer software" and related
documentation in accordance with the terms of this commercial computer
software license as specified in 48 C.F.R. 227-7202-2 of the DOD F.A.R.
Supplement and its successors.

Saba and the Saba logo are registered trademarks of Saba Software, Inc. and
Saba product names are the trademarks of Saba Software, Inc. All other product
names mentioned in this manual are the property and may be trademarks or
registered trademarks of their respective owners, and are used for identification
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Change log

The below table summarizes the list of changes introduced in a particular version of this document.

Table 1: Summary of changes

FeatureFunctional
area

Change
description

DateVersion

N/AN/AInitial version
28-Oct-20161.0





New features at a glance by functional area

The below table summarizes the list of features introduced in the release and their potential impact on your environment.

Note:  * Enabled by default does not necessary imply that the feature is immediately available to your users; it
may require a user with an appropriate administrator role to turn on applicable functionality, business rules, etc.

 indicates a new feature introduced in this update, others are enhancements/changes to the existing functionality.

Table 2: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPI to retrieve completion de~
tail of the learning event

REST APIs

DeveloperAPIs to retrieve, create and
manage resources on the Saba
Activity Stream

DeveloperAPIs to retrieve or update de~
tails of job requisitions

DeveloperAPI to retrieve public/private
attachments

DeveloperAPIs to retrieve social interac~
tions of a user

DeveloperAPIs to create, update and de~
lete Smartlists

DeveloperCertification and Curriculum
APIs to return additional details

DeveloperEnrollment search APIs to sup~
port created_on field

DeveloperHeld learning APIs to return
additional details

DeveloperAPIs to create, update and find
Sub audience types



Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPIs to retrieve, create, update
and delete countries and states

DeveloperAPIs to retrieve details of the
recurring course completions

DeveloperAPI to retrieve existing registra~
tion details or auto enroll user
and get registration details

DeveloperGet completion and lesson de~
tails of the learning event

DeveloperAPI to retrieve the Audience
Type / Audience Sub Types
assigned to a Person

DeveloperNew attribute added for the
CREATE A NEW JOB RE~
QUISITION API

DeveloperUser-friendly IDs and lookup
support for REST APIs

DeveloperNew attribute added for the
CREATE A NEW VIRTUAL
CLASS API

DeveloperAPI to report the content result
back to Saba

DeveloperNew attribute added for the
Subscription APIs

System adminConfigure Labels supports addi~
tional labels and all locales

System

System admin

Social admin
System ad~

min

Control visibility of navigation
links using menu visibility
privileges

People admin

Recruiting admin
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System admin
Legacy attributes deprecated

End user

Developer

End userSystem ad~
min

Privilege to change own man~
ager

ManagerSystem ad~
min

Organization Manager

HR admin

System admin
System ad~

min

Record-level selective deletion
of associations using data im~
port

System adminSystem ad~
min

Merge person profiles in bulk
through data import

Learning admin
System ad~

min

Dynamically update currency
for blended classes through
data import

Learning admin
System ad~

min

Associate multiple currency
prices for course and class
through data import

System adminSystem ad~
min

Advanced data import configur~
ation in Integration Studio

System adminAuditing support for data im~
port job configuration

End userSystem ad~
min

Skip omitted columns from
data import file

HR adminSystem ad~
min

New Organization Administrat~
or association in data import

System adminNew column in Person data
import

People adminPrompt to save member selec~
tion details when using existing
criteria
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

People adminAssign job role to person via
prescriptive rule

All

System admin

Support for additional locales

System adminLocale support for notification
keywords

System adminEnhancement to mobile brand~
ing configuration in microsites

System admin

All

Protect your account with two
factor authentication

Analytics admin

Analytics user

Add exceptions to reportsAnalytics

Analytics admin

Analytics user

New Attributes

Analytics admin

Analytics user

Updated Attributes

Analytics admin

Analytics user

New Reports

Analytics admin

Analytics user

New operator (Logged-in Per~
son's Organization)

Analytics admin

Analytics user

Embed an Analytics Dash~
board, Report or Chart in an
external portal

Analytics admin

Analytics user

Support Data Is Protected indi~
vidually for Person and Organ~
ization fix custom dimensions

Analytics admin

Analytics user

Line charts to now support
sorting on dimension attributes

 | New features at a glance by functional area | 16



Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Learning adminSearch enhancements for tests,
surveys and questions

Learning

Learning adminSystem ad~
min

Add video content to courses
using course wizard

Learning adminHandle deletion of Saba Meet~
ing event in a class session

Learning adminEdit Is Sensitive field while
updating a course

End userSystem ad~
min

One click registration for extern~
al users

End user
Learning

admin

Control the display of custom
course fields during bulk regis~
tration

End userSystem ad~
min

New named queries for learn~
ing activities

Learning admin
System ad~

min

Create audience type/sub-type
on-the-fly for certifications and
curricula

End userSystem ad~
min

Hide unsuccessful completions
from learner's transcript

End user
System ad~

min

Display for Learner, Display
for Call Center, and Self-regis~
tration options for certifications
and curricula

Registrar

End userLearning
admin

Remove discontinued courses
from learner's plan

Manager

End userEnhanced View Classes popup
page

End userIncreased default max count for
VLE providers
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Registrar
Registrars and managers can
enroll learners to certifications
and curricula Manager

Learning adminTrack number of attempts for
unlimited attempts on content

Learning adminSystem ad~
min

Import Panopto videos as
SCORM content

Learning adminLearning
admin

Deployed SCORM content
support for mobile

System adminBulk import of states within
country

E-commerce

System admin

Learning adminSystem ad~
min

Add private video channel or
group to subscription

End user

System admin

Learning admin
System ad~

min

Currency conversion for class
price is dynamic

System admin

HR admin
System ad~

min

Country and State fields shown
as LOV in organization details

System adminSystem ad~
min

Expand Tax API

System admin

Registrar
System ad~

min

Invoice Me enhancements

System admin

Catalog adminSystem ad~
min

Make payments to course own~
er's organization

End user

End user

Registrar
System ad~

min

New notification for pay later
functionality
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userSystem ad~
min

Organizational Chart available
under People tab

Social

End user
End user

Control access to workspaces

End userDisplay images and videos in~
line in group and activity
stream

End userSystem ad~
min

Learning Record Store for
tracking social resource contri~
butions in Saba Cloud Learning admin

End userSystem ad~
min

Bookmarklet for tracking in~
formal learning resources out~
side of Saba Cloud Learning admin

Marketplace Ad~
min

End User

Courses retired in lynda.com
should not appear in Saba

Marketplace

Marketplace Ad~
min, Saba Ap~
prover

Saba Approver can see applica~
tion details before approval

Marketplace Ad~
min

Audit option is available for
marketplace configuration
changes

Partner admin,
Marketplace ad~
min

Partner admin can choose
which view the microapp
should be available in Saba
home page/profile page

Partner Admin,
Marketplace Ad~
min

Partners can publish Micro
Apps to specific tenants

Partner Ap~
prover, Market~
place Admin

Enhancement to the Partner
Approval Flow
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Partner admin,
Saba Approvers,

API dashboard available for
Micro Apps created in Exten~
ded Integration Marketplace Ad~

min

Manager, Com~
pensation Admin,
Approver, HRBP

Send notifications when com~
pensation letter is published

Compensa~
tion

Manager, AdminImport and export plan cycle
worksheets

ManagerFreeze header row in manager's
worksheet

Compensation
Administrator

Delete Compensation Plan
Cycles

End UserSupport for string translation in
Compensation

Compensation
Admin

I18N support for Plan Cycle
names and descriptions

Compensation
Admin, Manager,
Employees

Localization support for Lib~
rary Fields

Compensation
Admin

Translation support for com~
pensation categories

Manager, Ap~
prover

Comment field added

Compensation
Admin, Manager,

Out of the Box notifications to
display text

Approver, Em~
ployee

ManagerAllow compensation managers
to access compensation data on
profile page

Compensation
Admin

Cancelled plan Cycle data to be
removed from Analytics
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Compensation
Admin

Separate plan activation and
analytics data synchronization

Compensation
Admin, Manager,
Approver

Synchronize Compensation
data with Analytics Reporting

Compensation
Admin, Manager

Create Custom Manager hier~
archy to distribute budget

Performance ad~
min

Manager

Perform~
ance admin

New policy for review owners
to release review

Performance

People admin

End user

Assign skill through PR
without any goal

Performance ad~
min

Perform~
ance admin

Add locale to Additional Info
section of review form

Manager

End user

Filter skills by skill group

System admin

Manager

System ad~
min

Limit access to reviews for new
managers

System admin

Manager

System ad~
min

Edit or delete goal progress
comments

End user

Performance ad~
min

Perform~
ance admin

Export and import review
cycle

Performance ad~
min

Perform~
ance admin

Anniversary reviews update

Pulse admin

End user

Pulse ad~
min

New question in Company cat~
egory for Pulse 360

Pulse 360
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Pulse admin
System ad~

min
Pulse custom surveys

End user

Recruiting admin

Manager
Recruiting

admin

New setting to pull job descrip~
tion in requisition

Recruiting

System admin
System ad~

min

Auto reject candidates with in~
complete profile

Recruiting admin

Hiring team

Recruiting admin

Recruiter

Display custom and extended
custom fields on candidate's
profile

Hiring manager

Recruiter

Hiring manager

Job requisition summary

Recruiting admin

Hiring manager
Recruiting

admin

Multiple career sites

Hiring manager

Recruiter

New keywords in offer letter
template

System admin

Candidate
System ad~

min

Notification triggered when
new user signs up on career site

ApproverSmarter one click approval
from email

Recruiting adminManage onboarding forms in
HR admin flow

CandidateReposition Terms and Condi~
tions

Hiring manager

Recruiter

UI enhancements on the Hiring
Team page
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Talent admin
Display Career Planning sec~
tion on Talent Profile irrespect~
ive of career paths

Talent

Manager

End user

Talent admin

Manager

Display talent attributes on
hovering person in N-box view

System adminSystem ad~
min

Control display of experts in
career planning

End user

Talent admin

Manager

Hover messages for potential
rating and departure risk on
Talent pool views

HR admin
Surface job details and attach~
ments from Job details on Pro~
file page and in Career Plan~
ning

End user

ManagerSurface Actions menu on N-
box view

Talent admin

Manager

Export/print n-box view to Ex~
cel and PDF
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New features at a glance by audience

The below tables summarize the list of features introduced in the release and their potential impact on your environment.

Note:  * Enabled by default does not necessary imply that the feature is immediately available to your users; it
may require a user with an appropriate administrator role to turn on applicable functionality, business rules, etc.

 indicates a new feature introduced in this update, others are enhancements/changes to the existing functionality.

All

Table 3: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

All

System admin

Support for additional localesSystem

System admin

All

Protect your account with two
factor authentication

Analytics Admin, Analytics User

Table 4: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Analytics admin

Analytics user

Add exceptions to reportsAnalytics



Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Analytics admin

Analytics user

New Attributes

Analytics admin

Analytics user

Updated Attributes

Analytics admin

Analytics user

New Reports

Analytics admin

Analytics user

New operator (Logged-in Per~
son's Organization)

Analytics admin

Analytics user

Embed an Analytics Dash~
board, Report or Chart in an
external portal

Analytics admin

Analytics user

Support Data Is Protected indi~
vidually for Person and Organ~
ization fix custom dimensions

Analytics admin

Analytics user

Line charts to now support
sorting on dimension attributes

Approver

Table 5: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Manager, Ap~
prover

Comment field addedCompensa~
tion
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Compensation
Admin, Manager,

Out of the Box notifications to
display text

Approver, Em~
ployee

Compensation
Admin, Manager,
Approver

Synchronize Compensation
data with Analytics Reporting

ApproverSmarter one click approval
from email

Recruiting

Catalog Admin

Table 6: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System admin

Catalog adminSystem ad~
min

Make payments to course own~
er's organization

E-commerce

End user
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Candidate

Table 7: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System admin

Candidate
System ad~

min

Notification triggered when
new user signs up on career site

Recruiting

CandidateReposition Terms and Condi~
tions

Compensation Admin

Table 8: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Manager, Com~
pensation Admin,
Approver, HRBP

Send notifications when com~
pensation letter is published

Compensa~
tion

Compensation
Admin

Delete Compensation Plan
Cycles

Compensation
Admin

I18N support for Plan Cycle
names and descriptions

Compensation
Admin, Manager,
Employees

Localization support for Lib~
rary Fields

Compensation
Admin

Translation support for com~
pensation categories
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Compensation
Admin, Manager,

Out of the Box notifications to
display text

Approver, Em~
ployee

Compensation
Admin

Cancelled plan Cycle data to be
removed from Analytics

Compensation
Admin

Separate plan activation and
analytics data synchronization

Compensation
Admin, Manager,
Approver

Synchronize Compensation
data with Analytics Reporting

Compensation
Admin, Manager

Create Custom Manager hier~
archy to distribute budget

Developer

Table 9: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPI to retrieve completion de~
tail of the learning event

REST APIs

DeveloperAPIs to retrieve, create and
manage resources on the Saba
Activity Stream

DeveloperAPIs to retrieve or update de~
tails of job requisitions

DeveloperAPI to retrieve public/private
attachments
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPIs to retrieve social interac~
tions of a user

DeveloperAPIs to create, update and de~
lete Smartlists

DeveloperCertification and Curriculum
APIs to return additional details

DeveloperEnrollment search APIs to sup~
port created_on field

DeveloperHeld learning APIs to return
additional details

DeveloperAPIs to create, update and find
Sub audience types

DeveloperAPIs to retrieve, create, update
and delete countries and states

DeveloperAPIs to retrieve details of the
recurring course completions

DeveloperAPI to retrieve existing registra~
tion details or auto enroll user
and get registration details

DeveloperGet completion and lesson de~
tails of the learning event

DeveloperAPI to retrieve the Audience
Type / Audience Sub Types
assigned to a Person

DeveloperNew attribute added for the
CREATE A NEW JOB RE~
QUISITION API

DeveloperUser-friendly IDs and lookup
support for REST APIs

DeveloperNew attribute added for the
CREATE A NEW VIRTUAL
CLASS API
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPI to report the content result
back to Saba

DeveloperNew attribute added for the
Subscription APIs

End User

Table 10: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userSystem ad~
min

Privilege to change own man~
ager

System

End userSystem ad~
min

Skip omitted columns from
data import file

End userSystem ad~
min

One click registration for extern~
al users

Learning

End user
Learning

admin

Control the display of custom
course fields during bulk regis~
tration

End userSystem ad~
min

New named queries for learn~
ing activities

End userSystem ad~
min

Hide unsuccessful completions
from learner's transcript

End user
System ad~

min

Display for Learner, Display
for Call Center, and Self-regis~
tration options for certifications
and curricula

Registrar
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userLearning
admin

Remove discontinued courses
from learner's plan

Manager

End userEnhanced View Classes popup
page

End userIncreased default max count for
VLE providers

System admin

Learning adminSystem ad~
min

Add private video channel or
group to subscription

E-commerce

End user

System admin

Catalog adminSystem ad~
min

Make payments to course own~
er's organization

End user

End user

Registrar
System ad~

min

New notification for pay later
functionality

End userSystem ad~
min

Organizational Chart available
under People tab

Social

End user
End user

Control access to workspaces

End userDisplay images and videos in~
line in group and activity
stream

End userSystem ad~
min

Learning Record Store for
tracking social resource contri~
butions in Saba Cloud Learning admin

End userSystem ad~
min

Bookmarklet for tracking in~
formal learning resources out~
side of Saba Cloud Learning admin

End UserSupport for string translation in
Compensation

Compensa~
tion
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End User

Marketplace Ad~
min

Courses retired in lynda.com
should not appear in Saba on
page 356Courses retired in
lynda.com should not appear in
Saba

Marketplace

People admin

End user

Assign skill through PR
without any goal

Performance

Manager

End user

Filter skills by skill group

System admin

Manager

System ad~
min

Edit or delete goal progress
comments

End user

Pulse admin

End user

Pulse ad~
min

New question in Company cat~
egory for Pulse 360

Pulse 360

Pulse admin
System ad~

min
Pulse custom surveys

End user

Talent admin
Display Career Planning sec~
tion on Talent Profile irrespect~
ive of career paths

Talent

Manager

End user

System adminSystem ad~
min

Control display of experts in
career planning

End user

HR admin
Surface job details and attach~
ments from Job details on Pro~
file page and in Career Plan~
ning

End user
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HR Admin & HRBP

Table 11: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

ManagerSystem ad~
min

Organization ManagerSystem

HR admin

HR adminSystem ad~
min

New Organization Administrat~
or association in data import

System admin

HR admin
System ad~

min

Country and State fields shown
as LOV in organization details

E-commerce

Manager, Com~
pensation Admin,
Approver, HRBP

Send notifications when com~
pensation letter is published

Compensa~
tion

HR admin
Surface job details and attach~
ments from Job details on Pro~
file page and in Career Plan~
ning

Talent

End user

Hiring Team, Hiring Manager, Recruiter

Table 12: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System adminSystem ad~
min

Auto reject candidates with in~
complete profile

Recruiting

Recruiting admin
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Hiring team

Recruiting admin

Recruiter

Display custom and extended
custom fields on candidate's
profile

Hiring manager

Recruiter

Hiring manager

Job requisition summary

Recruiting admin

Hiring manager
Recruiting

admin

Multiple career sites

Hiring manager

Recruiter

New keywords in offer letter
template

Hiring manager

Recruiter

UI enhancements on the Hiring
Team page

Learning Admin

Table 13: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Learning admin
System ad~

min

Dynamically update currency
for blended classes through
data import

System

Learning admin
System ad~

min

Associate multiple currency
prices for course and class
through data import
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Learning adminSearch enhancements for tests,
surveys and questions

Learning

Learning adminSystem ad~
min

Add video content to courses
using course wizard

Learning adminHandle deletion of Saba Meet~
ing event in a class session

Learning adminEdit Is Sensitive field while
updating a course

End userSystem ad~
min

New named queries for learn~
ing activities

Learning admin
System ad~

min

Create audience type/sub-type
on-the-fly for certifications and
curricula

Learning adminTrack number of attempts for
unlimited attempts on content

Learning adminSystem ad~
min

Import Panopto videos as
SCORM content

Learning adminLearning
admin

Deployed SCORM content
support for mobile

System admin

Learning adminSystem ad~
min

Add private video channel or
group to subscription

E-commerce

End user

System admin

Learning admin
System ad~

min

Currency conversion for class
price is dynamic

End userSystem ad~
min

Learning Record Store for
tracking social resource contri~
butions in Saba Cloud

Social

Learning admin

End userSystem ad~
min

Bookmarklet for tracking in~
formal learning resources out~
side of Saba Cloud Learning admin
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Marketplace admin

Table 14: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Marketplace Ad~
min

Courses retired in lynda.com
should not appear in Saba

Marketplace

Marketplace Ad~
min, Saba Ap~
prover

Saba Approver can see applica~
tion details before approval

Marketplace Ad~
min

Audit option is available for
marketplace configuration
changes

Partner admin,
Marketplace ad~
min

Partner admin can choose
which view the microapp
should be available in Saba
home page/profile page

Partner Admin,
Marketplace ad~
min

Partners can publish Micro
Apps to specific tenants

Partner Ap~
prover, Market~
place admin

Enhancement to the Partner
Approval Flow

Partner, Saba Ap~
provers, Market~
place admin

API dashboard available for
Micro Apps created in Exten~
ded Integration
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Manager

Table 15: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

ManagerSystem ad~
min

Organization ManagerSystem

HR admin

End userLearning
admin

Remove discontinued courses
from learner's plan

Learning

Manager

Registrar
Registrars and managers can
enroll learners to certifications
and curricula Manager

Manager, Com~
pensation Admin,
Approver, HRBP

Send notifications when com~
pensation letter is published

Compensa~
tion

Manager, AdminImport and export plan cycle
worksheets

ManagerFreeze header row in manager's
worksheet

Compensation
Admin, Manager,
Employees

Localization support for Lib~
rary Fields

Manager, Ap~
prover

Comment field added

Compensation
Admin, Manager,

Out of the Box notifications to
display text

Approver, Em~
ployee

ManagerAllow compensation managers
to access compensation data on
profile page
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Compensation
Admin, Manager,
Approver

Synchronize Compensation
data with Analytics Reporting

Compensation
Admin, Manager

Create Custom Manager hier~
archy to distribute budget

Performance ad~
min

Manager

Perform~
ance admin

New policy for review owners
to release review

Performance

Manager

End user

Filter skills by skill group

System admin

Manager

System ad~
min

Limit access to reviews for new
managers

System admin

Manager

System ad~
min

Edit or delete goal progress
comments

End user

Talent admin
Display Career Planning sec~
tion on Talent Profile irrespect~
ive of career paths

Talent

Manager

End user

Talent admin

Manager

Display talent attributes on
hovering person in N-box view

Talent admin

Manager

Hover messages for potential
rating and departure risk on
Talent pool views

ManagerSurface Actions menu on N-
box view

Talent admin

Manager

Export/print n-box view to Ex~
cel and PDF
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Performance Admin

Table 16: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Performance ad~
min

Manager

Perform~
ance admin

New policy for review owners
to release review

Performance

Performance ad~
min

Perform~
ance admin

Add locale to Additional Info
section of review form

Performance ad~
min

Perform~
ance admin

Export and import review
cycle

Performance ad~
min

Perform~
ance admin

Anniversary reviews update

Pulse Admin

Table 17: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Pulse admin

End user

Pulse ad~
min

New question in Company cat~
egory for Pulse 360

Pulse 360

Pulse admin
System ad~

min
Pulse custom surveys

End user
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People Admin

Table 18: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System admin

Social admin
System ad~

min

Control visibility of navigation
links using menu visibility
privileges

System

People admin

Recruiting admin

People adminPrompt to save member selec~
tion details when using existing
criteria

People adminAssign job role to person via
prescriptive rule

People admin

End user

Assign skill through PR
without any goal

Performance

Partner Admin

Table 19: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Partner admin,
Marketplace ad~
min

Partner admin can choose
which view the microapp
should be available in Saba
home page/profile page

Marketplace
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Partner admin,
Marketplace Ad~
min

Partners can publish Micro
Apps to specific tenants

Partner admin,
Saba Approvers,

API dashboard available for
Micro Apps created in Exten~
ded Integration Marketplace Ad~

min

Recruiting Admin

Table 20: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Recruiting admin

Manager
Recruiting

admin

New setting to pull job descrip~
tion in requisition

Recruiting

System admin
System ad~

min

Auto reject candidates with in~
complete profile

Recruiting admin

Hiring team

Recruiting admin

Recruiter

Display custom and extended
custom fields on candidate's
profile

Hiring manager

Recruiting admin

Hiring manager
Recruiting

admin

Multiple career sites

Recruiting adminManage onboarding forms in
HR admin flow
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Registrar

Table 21: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End user
System ad~

min

Display for Learner, Display
for Call Center, and Self-regis~
tration options for certifications
and curricula

Learning

Registrar

Registrar
Registrars and managers can
enroll learners to certifications
and curricula Manager

System admin

Registrar
System ad~

min

Invoice Me enhancementsE-commerce

End user

Registrar
System ad~

min

New notification for pay later
functionality

Saba Approver

Table 22: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Marketplace Ad~
min, Saba Ap~
prover

Saba Approver can see applica~
tion details before approval

Marketplace

Partner, Saba Ap~
provers, Market~
place Admin

API dashboard available for
Micro Apps created in Exten~
ded Integration
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System Admin

Table 23: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System adminConfigure Labels supports addi~
tional labels and all locales

System

System admin

Social admin
System ad~

min

Control visibility of navigation
links using menu visibility
privileges

People admin

Recruiting admin

System admin
Legacy attributes deprecated

End user

Developer

System admin
System ad~

min

Record-level selective deletion
of associations using data im~
port

System adminSystem ad~
min

Merge person profiles in bulk
through data import

System adminSystem ad~
min

Advanced data import configur~
ation in Integration Studio

System adminAuditing support for data im~
port job configuration

System adminNew column in Person data
import

All

System admin

Support for additional locales

System adminLocale support for notification
keywords
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

System adminEnhancement to mobile brand~
ing configuration in microsites

System admin

All

Protect your account with two
factor authentication

System adminBulk import of states within
country

E-commerce

System admin

Learning adminSystem ad~
min

Add private video channel or
group to subscription

End user

System admin

Learning admin
System ad~

min

Currency conversion for class
price is dynamic

System admin

HR admin
System ad~

min

Country and State fields shown
as LOV in organization details

System adminSystem ad~
min

Expand Tax API

System admin

Registrar
System ad~

min

Invoice Me enhancements

System admin

Catalog adminSystem ad~
min

Make payments to course own~
er's organization

End user

System admin

Manager

System ad~
min

Limit access to reviews for new
managers

Performance

System admin

Manager

System ad~
min

Edit or delete goal progress
comments

End user

System admin
System ad~

min
Auto reject candidates with in~
complete profile

Recruiting
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Recruiting admin

Hiring team

System admin

Candidate
System ad~

min

Notification triggered when
new user signs up on career site

System adminSystem ad~
min

Control display of experts in
career planning

Talent

End user

Talent admin

Table 24: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Talent admin
Display Career Planning sec~
tion on Talent Profile irrespect~
ive of career paths

Talent

Manager

End user

Talent admin

Manager

Display talent attributes on
hovering person in N-box view

Talent admin

Manager

Hover messages for potential
rating and departure risk on
Talent pool views

Talent admin

Manager

Export/print n-box view to Ex~
cel and PDF
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Chapter

1

System

Topics:

• Core
• Data Integration
• Prescriptive Rule and Smart List
• REST API



Core

Organization Manager

N/A

This update introduces the new Organizations I Manage view under the My Team tab. This view enables designated
users to view members belonging to organizations where they are the organization managers. Currently, organization
managers can perform only learning-related actions on the members of their organization.

New Security Privilege and Security Role

Only users with the following new privilege on the System component can access the new organization manager view:

• Can Access Organization Manager Role

By default, this privilege is granted only to the following roles:

• Organization Manager Basic Privileges
• Super User

Assigning and Removing an Organization Manager

HR administrators can designate a user as the Organization Manager for an organization. A user having home domain
equivalent or parent hierarchy of the organization domain can be added as an Organization Manager for an organization.
An internal user can be designated as the organization manager for an external organization and vice versa. While adding
a user as an organization manager, the corresponding security role is automatically assigned to the user on the
organization's domain.

To add organization managers to an organization, go to ADMIN > HR > Manage Organizations > Internal or External
and click the Add Organization Managers link.

When removing an organization manager from an organization, Saba Cloud removes user as the organization manager
for the particular organization. However, the Organization Manager Basic Privileges security role for the user is
removed only if the user is not the organization manager for any other organization in same domain.

Figure 1: Add an Organization Manager to organization

Organizations I Manage View
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A user can view the My Team > Overview > Organization I manage view only if the user is the organization manager
for at least one organization. Only learning activities that are in Pending, Overdue, and Upcoming states are displayed
for organization members.

If the logged in user himself is a member of an organization where he is the organization manager, then the manager is
not visible to self in this view; however, he is visible to other organization managers for that organization.

Figure 2: Organizations I Manage view under My Team

The following learning-related team actions are available to the organization manager:

• Assign learning

• Add learning events to plan
• Register for classes
• Assign and enroll for certifications and curricula

The organization manager can use these links to add up to 100 order items at a time.

• Add completed course

The organization manager can add completed courses for up to 100 learners at a time.

• Assign Checklist

The organization manager can assign checklists for up to 100 learners at a time.

Figure 3:Team Actions
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The following learning-related Go to actions are available to the organization manager:

• Plan
• Courses
• Curricula
• Certifications
• Order History
• Completed Learning
• Profile
• Continuing Education Credits

Note: The availability of certain actions are service driven.

Clicking on these links opens the organization member's plan page with the corresponding filter already applied.

Figure 4: Go to Actions

Learner's Plan Page

The organization manager can view the following on a member's plan page:

• Learning & Certifications tab
• Evaluations; however, they cannot launch them.
• Links in the left pane:

• Plan
• Profile
• Completed Learning
• Order History
• Message

Clicking the Return to My Team link takes the organization manager back to the Organizations I Manage View page
for the organization that was selected.
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Figure 5: Organization member's plan page

Pending Approvals Page

The organization manager can view the following on the team's pending approval page:

• Learning registrations

Displays pending requests for learning registrations of the organization members for the selected organization.
Actions for learning requests are based on privileges. If the organization manager is an approver for the any of the
learning requests pending approval, then they can see the Approve/Reject action.

• Externally completed courses

Displays pending requests for externally completed course of the organization members for the selected organization.
Organization managers can approve or reject an ad hoc completed course only if they have the "Can approve/reject
completed courses for others" privilege.

Figure 6: Organization member's plan page

Currently, the following Learning features are not available to the organization manager:

• To–Do List
• Learning Requests
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Organizations need a way to manage training for a group of people who are not all managed by the same person. For
example, this model is common in the retail franchise and necessary to meet their training requirement needs.

Configure Labels supports additional labels and all locales

The following labels were not supported by System > Configure Labels > Master:

• Launch
• Acquired On

Configure Labels > Master was earlier supported only for the following locales:

• Japanese
• French Canadian
• English (UK)

With this update, you can now configure the following additional labels using System > Configure Labels > Master:

• Launch
• Acquired On

Also the Configure Labels > Master is now supported for all the locales.

This enhancement will help configure new strings for these additional labels.

Control visibility of navigation links using menu visibility privileges

The left navigation links accessible to each administrator for their respective areas were governed by privileges on the
corresponding MenuVisibility component. For example, if Can access > System > System Home privilege was enabled
on the MenuVisibility-SystemAdmin component for the system admin security role, then the System Home link
appeared. The menu visibility privileges are available for all administrator roles in Saba Cloud.
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Figure 7: MenuVisibility component privileges

But, the links under the Go to dropdown list on the Admin Home page for each administrator area were not governed
by these privileges. For example, if Can access->System->Configure System privilege was disabled on the
MenuVisibility-SystemAdmin component for the system admin role, then the Configure System link did not appear
in Admin > System. However, if the Configure System page was accessed through the System Admin portlet on the
Admin Home page via Go to > Configure System link, then that link was visible and the page was accessible.

For Human Capital Admin security role

Additionally, for "Human Capital Admin" security role, the visibility of learning-related navigation links was controlled
by the "Can Access HR Admin Links" privilege on the System component, and not by the privileges on the
MenuVisibility-PeopleAdmin component.

With this update, Saba Cloud now hides even the links under the Go to dropdown list through the MenuVisibility
component privileges. For example, if Can access > System > Configure System privilege is disabled on the
MenuVisibility-SystemAdmin component for a system admin, then the Configure System link does not appear in
Admin > System and in Go to dropdown list.

This is applicable for the following areas:

Menu visibility changes for People Admin security role
The following links under Admin Home > People Admin portlet > Go to dropdown list are now governed by their
corresponding privileges in MenuVisibility-PeopleAdmin component:

• Manage People
• Manage Signup Rules
• Rules Engine
• Message Center

Menu visibility changes for System Admin security role
The following links under Admin Home > System Admin portlet > Go to dropdown list are now governed by their
corresponding privileges in MenuVisibility-SystemAdmin component:

• Configure System
• Manage Search
• Manage Integrations
• Manage Security
• Manage Engagement Tools
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• System Statistics

Menu visibility changes for Social Admin security role
The following links under Admin Home > Social Admin portlet > Go to dropdown list are now governed by their
corresponding privileges in MenuVisibility-SocialAdmin component:

• Manage Groups
• User-generated Content
• Featured Categories

Menu visibility changes for Recruiting Admin & Recruiter security role
The menu navigation links on the left hand side can now be hidden from the security roles. The following links under
Admin Home > Recruiting Admin portlet > Go to dropdown list and recruiting-related left navigation menu links are
now governed by their corresponding privileges in MenuVisibility-RecruitingAdmin component:

Table 25: Visibility of Recruiting admin links

Visible toGo to Menu ListLeft Navigation Menu
Link

Security Privilege

Recruiting HomeRecruiting HomeCan access -> Recruiting -
>Recruiting Home

• Recruiting admin
• Recruiter

Manage Job RequisitionsManage Job RequisitionsCan access - >Recruiting -
>Manage Job Requisitions

• Recruiting admin
• Recruiter

-Job RequisitionsCan access - >Recruiting -
>Manage Job Requisitions -
>Job Requisitions

• Recruiting admin
• Recruiter

-Job Requisition TemplatesCan access - >Recruiting -
>Manage Job Requisitions -
>Job Requisition Templates

• Recruiting admin
• Recruiter

Recruiting adminManage Job OffersManage Job OffersCan access - >Recruiting -
>Manage Job Offers  

Recruiting admin-Job Offer TemplatesCan access - >Recruiting -
>Manage Job Offers - >Job
Offer Templates

Recruiting admin-Offer Letter TemplatesCan access - >Recruiting -
>Manage Job Offers - >Of~
fer Letter Templates

Recruiting adminManage Career SitesManage Career SitesCan access - >Recruiting -
>Manage Career Sites

Recruiting admin-Career SitesCan access - >Recruiting -
>Manage Career Sites -
>Career Sites
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Visible toGo to Menu ListLeft Navigation Menu
Link

Security Privilege

Recruiting adminManage AssessmentsManage AssessmentsCan access - >Recruiting -
>Manage Assessments

Recruiting admin-Manage Test and SurveyCan access - >Recruiting -
>Manage Assessments -
>Manage Test and Survey

Recruiting admin-Test Question PoolCan access - >Recruiting -
>Test Question Pool

Recruiting admin-Survey Question PoolCan access - >Recruiting -
>Manage Assessments -
>Survey Question Pool

Recruiting admin-Manage ScalesCan access - >Recruiting -
>Manage Assessments -
>Manage Scales

Manage CandidatesManage CandidatesCan access - >Recruiting -
>Manage Candidates

• Recruiting admin
• Recruiter

-CandidatesCan access - >Recruiting -
>Candidates

• Recruiting admin
• Recruiter

Recruiting admin-Manage ConfigurationsCan access - >Recruiting -
>Candidates - >Manage
Configurations

Recruiting admin-Terms and ConditionsCan access - >Recruiting -
>Manage Configurations -
>Terms and Conditions

Recruiting admin-Job Application FormCan access - >Recruiting -
>Manage Configurations -
>Job Application Form

Recruiting admin-Job Offer ConfigurationsCan access - >Recruiting -
>Manage Configurations -
>Job Offer Configurations

Recruiting admin-Job Requisition Configura~
tions

Can access - >Recruiting -
>Manage Configurations -
>Job Requisition Configura~
tions

Manage I-9 VerificationsManage I-9 VerificationsCan access - >Recruiting -
>Manage I-9 Verifications

• Recruiting admin
• Recruiter
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Visible toGo to Menu ListLeft Navigation Menu
Link

Security Privilege

Note:  Ensure that
Can Access I-9
Verification Links
privilege at System
component is en~
abled.

Note:  If a user does not have privilege to view any of the child menus, then the parent menu is also hidden. For
example, Can access - >Recruiting - >Manage Job Requisitions privilege is enabled, but Can access - >Recruiting
- >Manage Job Requisitions - >Job Requisitions privilege is disabled, then on the Recruiting Home page, both the
links will be hidden from the user.

Figure 8: Left navigation links for Recruiting admin & Recruiter

Figure 9: Recruiting Admin portlet > Go to links
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Menu visibility changes for Human Capital Admin security role

With this update, the following privileges in MenuVisibility-PeopleAdmin component control the visibility of the
learning-related left navigation menu links as well as Profile Quicklinks section under Edit Profile Information and
Licenses and Certifications tab under Full Profile. Their visibility is no more controlled by the "Can Access HR Admin
Links" privilege on the System component,

Table 26: Visibility of People admin links

Left Navigation Menu LinkSecurity Privilege

EnrollmentsCan access People > Manage People > Enrollments

Completed CoursesCan access People > Manage People > Completed Courses

CertificationsCan access People > Manage People > Certifications

CurriculaCan access People > Manage People > Curricula

Recurring CoursesCan access People > Manage People > Recurring Courses

Continuing EducationCan access People > Manage People > Continuing Educa~
tion
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Figure 10: Left navigation links for People admin

The display of all navigation menus and links for administrators can now be consistently governed by the MenuVisibility
component privileges for the respective security roles.

Legacy attributes deprecated

The following were legacy attributes under the External Work History and Internal Work History components:

• External Work History > KEY ACCOMPLISHMENTS
• Internal Work History > ADDITIONAL RESPONSIBILITIES

The following legacy attributes under the External Work History and Internal Work History components are now
deprecated:

• External Work History > KEY ACCOMPLISHMENTS
• Internal Work History > ADDITIONAL RESPONSIBILITIES

These attributes will no longer be available on the UI or in the component details page.
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N/A

Privilege to change own manager

Saba Cloud did not permit users to modify their manager from their Profile page.

With this update, Saba Cloud provides the ability for users to modify their own managers by introducing the following
privilege on Person, Internal and Person, External components:

• Can Assign-Remove Manager to Self

If this privilege is enabled, then users having this privilege can edit their own managers from their Profile page.
Such users can search only users whose "Manager Access" is enabled. 

By default, this privilege is disabled.

If you want to enable this privilege for certain users, then note that it can allow a user to change their reporting to higher
or lateral managers. Thereby, the administrator must take precaution while enabling this privilege for users.

Saba Cloud supports Silent Auditing for this feature, so administrators can track users who made the updates.

To execute their business processes, certain organizations require their employees to have the ability to update their own
managers.

Support for additional locales

The following locales were not supported:

• Bahasa Indonesia (Indonesia) - in_ID
• Lithuanian (Lithuania) - lt_LT
• Estonian (Estonia) - et_EE
• Hindi (India) - hi_IN
• Cambodia (KH) - km_KH
• Latvian (Latvia) - lv_LV
• Romanian (Romania) - ro_RO

Saba Cloud now supports the following additional locales.

• Bahasa Indonesia (Indonesia) - in_ID
• Lithuanian (Lithuania) - lt_LT
• Estonian (Estonia) - et_EE
• Hindi (India) - hi_IN
• Cambodia (KH) - km_KH
• Latvian (Latvia) - lv_LV
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• Romanian (Romania) - ro_RO

Note: These locales are not enabled by default. To enable a locale, submit a support request. For assistance, contact
Saba Support.

The users can now login to Saba Cloud using these additional locales.

Locale support for notification keywords

Saba Cloud did not display notification keywords in the logged-in user's locale. Irrespective of the locale, the keywords
were displayed in English.

With this update, Saba Cloud displays notification keywords and their categories in the logged in user's locale.

The keywords are displayed as follows in the dropdown:

<Localized_category_name : Localized_Keyword_name | @Group_Keyword@>

The notification category names are translated in the dropdown list only.

Other keyword-related functions are not affected by this change. They work as before.

Administrators who configure notifications in Saba Cloud need to view keywords in the locale they are logged in to so
that they can accurately define the notification.

Enhancement to mobile branding configuration in microsites

While configuring the branding of a microsite, system administrators could upload the mobile assets ZIP file. When
they selected the ZIP file, it took some time to upload the file but the waiting indicator was not clearly visible and so
the administrators would immediately click the Validate button before the upload was actually complete. Resultantly,
Saba Cloud would validate the old ZIP file and displayed the error accordingly.

With this update, Saba Cloud enhances the usability of the mobile branding configuration in microsites as follows:

• Removes the Validate button.
• When the ZIP file is selected, Saba Cloud validates it first and then uploads it based on the validation.
• If file validation fails, then Saba Cloud displays an error message, does not upload the file, and does not apply the

file as the mobile theme.
• If file validation is successful, then Saba Cloud uploads the file and applies the file as the mobile theme.

There is a need to enhance the usability of the option to upload mobile assets while configuring branding for a microsite.
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Protect your account with two factor authentication

Saba Cloud did not support Two factor authentication.

With this update, Saba Cloud supports Two factor authentication. Two factor authentication is an extra layer of security
designed to ensure that you're the only person who can access your account, even if someone knows your password.
Each time you sign in to your Saba Account, you'll need your password and a Security Code that is sent to your email
address.

Note:  By default, the Two factor authentication functionality is disabled. To enable this functionality, please submit
a Support request. For assistance, contact Saba support.

System admin: Enabling the Two factor authentication service

The system admin can enable the Two factor authentication service under System > Configure System > Services.

Figure 11:Two factor authentication service

The service provides the following settings:

• Mobile based two factor authentication: This requires you to install the mobile app called Google Authenticator.
This app generates 2-Step Verification codes on your phone.

• Mail based two factor authentication: This will send the code to your email ID that is registered with Saba.

Note: The user needs to have view privilege on the user's own email ID, if mail based two factor authentication
is enabled.
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Note: This service is not Domain aware.

Figure 12: Settings under Two factor authentication service

People admin: Enabling the Two factor authentication for the required users

After the system admin enables the service, the people admin (or the system admin) needs to enable the Two Factor
Authentication for the required users by editing the user's profile or using RDI.

Figure 13: Editing the user's profile

Enable the Two Factor Authentication for the required user.
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Figure 14: Enable the Two Factor Authentication for the required user

User logging in using the two factor authentication

After this is enabled, now when the user tries to login, the user is prompted for the Security Code and the Secret key
depending on the settings (Mobile based two factor authentication and Mobile based two factor authentication)
that are set by the system admin.

Figure 15:The Two factor Authentication in action

For email based two factor authentication, you can click Generate Security Code which will send you an email with
the Security Code that you need to enter here.
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Figure 16: Security Code via email

You can also choose to use the mobile based two factor authentication by clicking Re-generate Secret Key. This requires
the mobile app called Google Authenticator which will provide the Secret key that you need to enter here.

Figure 17: Code via Google Authenticator app

Note: Two factor authentication is not available for the candidates who login using the Recruiting career site.

Two factor authentication is only available for the following authentication methods:
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• LDAP
• Saba database based authentication

Note:  SAML, CertSSO, JWT, OAUTH and REST APIs do not support Two factor authentication.

This enhancement provides an enhanced security when accessing the application from the internet than when using it
from within the company network.

Data Integration

Record-level selective deletion of associations using data import

Saba Cloud provided the ability to delete object associations at record level using data import for certain objects. However,
this ability was not available for certain other objects like Skill, Skill Group, Certification and Curriculum. To delete
associations of these remaining objects, users required the intervention of Saba Cloud administrators, who would then
configure the functional metadata of the specific association configured for that object.

With this update, Saba Cloud allows system administrators to delete object associations at record level using data import
for the following objects:

• Skill
• Skill Group
• Certification
• Curriculum

System administrators can selectively remove or remove all existing associations of records from these objects as follows:

• DELETE_ prefix (Delete specific association of a record)

To support deletion of specific association, system administrators must add association with
DELETE_<ASSOCIATION_COLUMN> prefix in header and pass corresponding values in the data file. It also
supports "N" number of association deletion with a number suffix.

For example, when the import encounters the following record for association, it processes deletion first, deleting
uthree and ufour owners passed under DELETE_OWNER1|DELETE_OWNER2 and then associates uone and utwo
passed under OWNER1|OWNER2 for the specific record. The sequence number for add and delete actions is
independent of each other.

OWNER1|OWNER2|DELETE_OWNER1|DELETE_OWNER2
uone|utwo|uthree|ufour    

Note:  For the new record-level delete feature to work, the object-level delete functionality
DROP_EXISTING_<Association> (e.g.; DROP_EXISTING_OWNERS) must be OFF (add association
cumulatively, which is the default setting). If this functionality is ON, then it takes precedence and all associations
are deleted (current behavior).

• DELETE_ALL_ prefix (Delete all existing associations of a specific type of record)

 | System | 65



To support deletion of all existing associations of a specific type of record, system administrators must add association
with DELETE_ALL_<ASSOCIATION_COLUMN> prefix in header and pass corresponding values in the data file.
When the import process encounters "yes" in this column, all associations are processed for deletion. Records with
Null and other values are not affected.

For example, when the import encounters the following record for association, it processes deletion first, deleting
all existing owner associations and then associates uone passed under OWNER1 for the specific record.

OWNER1|DELETE_ALL_OWNER
uone|yes  

Note:  For this option, the numeric suffix is not required and first the association column as per template (for
grouped association columns) must be placed in the file. For example, in case of security role association:

ADD role association to the user: SECURITY_ROLE1|DOMAIN1   
DELETE role association from the user : 
DELETE_SECURITY_ROLE1|DELETE_DOMAIN1   
DELETE_ALL roles association for the user record : DELTE_ALL_SECURITY_ROLE

There is a need to allow users to selectively remove or remove all existing associations of records in data import objects
without the need to contact Saba Cloud administrators.

Merge person profiles in bulk through data import

Saba Cloud allowed administrators to merge person profiles from the UI and through Web Service. However, this
restricted them to merging one profile at a time.

Saba Cloud now allows system administrators to merge person profiles in bulk using the new Profile Merge object in
data import.

The Profile Merge data file includes the following fields:

• PRIMARY_PROFILE - This is a mandatory field.
• SECONDARY_PROFILE- This is a mandatory field.
• SECONDARY_PROFILE_MERGE_STATUS
• MERGE_SECURITY_ROLES
• MERGE_AUDIENCE_TYPE
• MERGE_VIRTUAL_AND_BLENDED_CLASS_TRANSCRIPT
• RECALCULATE_COMPLETION_STATUS_FOR_CERTIFICATION_AND_CURRICULUM
• SWAP_PERSON_NUMBER

To download the sample data files for the new object, navigate to System > Manage Integrations > Integration Studio
> Configure, select Profile Merge option from the Object Name dropdown list, and click the Download Sample
button.

Once the import is successful, Saba Cloud merges profiles specified in each row of the data file and generates
corresponding log files.
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There is a need to reduce the time required for administrators to merge large number of person profiles through bulk
import.

Dynamically update currency for blended classes through data
import

Saba Cloud supported the ability to add dynamic currency for blended classes through data import. However, there was
no support to update the currency dynamically.

Saba Cloud now provides the ability to dynamically update price currency for blended classes in bulk using data import.

The MULTICURRENCY_PREF column for Blended Offering data import object now supports the insert as well as
update actions.

For insert action, this column supports the following three values:

• 1 for "DesignatedCurrency" - The class is created only in the passed currency
• 2 for "DesignatedAndDefaultCurrency" - The class is created in the passed currency and its value in default currency

based on the exchange rate
• 3 for "AllCurrenciesInSystem" - The class is created in the passed currency and all other active currencies based on

the exchange rate.

For update action, this column support the following value only:

• 3 for "AllCurrenciesInSystem" - The class is created in the passed currency and all other active currencies based on
the exchange rate.

All other values are ignored during an update.

To download the sample data file for the updated object, navigate to System > Manage Integrations > Integration
Studio > Configure, select Blended Offering option from the Object Name dropdown list, and click the Download
Sample button.

There is a need to support dynamic currency conversion for blended classes via data import.

Associate multiple currency prices for course and class through
data import

Saba Cloud supported the ability to associate a single currency price for course and class through data import. However,
there was no support to associate multiple currency prices.

Saba Cloud now supports the ability to associate multiple currency prices for course and class using data import and
also provides the option to recalculate other currency price based on the base currency for the following objects:

• Offering template (Course)
• ILT Offering
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• WBT Offering

Following new association columns are added to the data files of the affected objects:

• ADD_PRICE_CURRENCY - Name of the currency to associate with the course.
• ADD_PRICE - Price to associate with the course.
• RECAL_PRICE_FOR_OTHER_CURRENCY - Input values are 'true' or 'false'. If set to "true", then the price is

calculated in all available active currencies in the system based on the exchange rate.

To import multiple price associations, multiple prices for different currencies can be provided in a row of the data file.
For example, multiple fields data can be provided by adding multiple combinations of the association fields with
incrementing suffix in the header and by providing values for the respective fields as given below:

….|ADD_PRICE_CURRENCY1|ADD_PRICE1|RECAL_PRICE_FOR_OTHER_CURRENCY1|
ADD_PRICE_CURRENCY2|ADD_PRICE2|RECAL_PRICE_FOR_OTHER_CURRENCY2…. and so on

The associations fields can be extended up to as many as required.

To download the sample data files for the updated objects, navigate to System > Manage Integrations > Integration
Studio > Configure, select either Offering Template, ILT Offering, or WBT Offering option from the Object Name
dropdown list, and click the Download Sample button.

There is a need to support dynamic currency conversion for course and class via data import.

Advanced data import configuration in Integration Studio

System administrators did not have access to modify advanced data import configurations other than setting the Unique
ID for an import object from the Saba Cloud UI. Any changes to such configurations required users to send request to
Saba Cloud operations and support staff.

Saba Cloud now allows system administrators to modify advanced data import configurations directly from the Saba
Cloud Integration Studio UI.

To view the new import settings, navigate to System > Manage Integrations > Integration Studio > Configure. A
new Import Settings section is available.
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Figure 18: New import settings

The settings displayed in this section depend on the selected import object. Except for the Unique ID Column field, all
other setting fields are checkboxes. System administrators can select the required checkbox to enable the functionality
for a particular object. To disable the functionality for the object, clear the corresponding checkbox. Ensure that you
click the Save button to save the configuration changes.

Auditing Support for Advanced Data Import Configuration

Saba Cloud allows administrators the ability to track changes to advanced data import settings by providing Silent
Auditing support.

To view audit details, click the Audit Trail icon on the Configuration page. Saba Cloud displays the Audit Trail popup
page. This page displays only the latest 200 records, though.

The Audit Trail popup page displays the following details:

• Action - The advanced import setting (functionality) that was changed. The display format is Update Import
Settings: <Object Name>-<Functionality>.

• Timestamp - The date and time when the change was made.
• Previous Value - Displays the original value of the functionality and default value, if available. The display format

is <Functionality>:<Default Value>.
• New Value - Displays the current value of the functionality and default value, if available. The display format is

<Functionality>:<Default Value>.
• Author - The full name of the user who made the change.
• Reason - Currently, it only supports Silent Auditing.
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Figure 19: Audit trail for advanced import settings

There is a need to allow system administrators to configure advanced import settings so that the dependability of raising
requests to Saba operations and support staff is reduced.

Auditing support for data import job configuration

Prior to this update, there was no provision to track configuration changes for data import jobs.

Saba Cloud now provides the ability to track changes to data import job configuration by introducing auditing support.

To view audit details for a data import job:

1. Click System > Manage Integrations > Integration Studio,
2. Search for and edit the required job.
3. Click the Audit Details button.
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Figure 20: Audit Details button

The Audit Details popup page displays the following details:

• Property Changed - Indicates the name of the job property that changed.
• Previous value of property
• Current value of property
• Update by - User name of person who made the change.
• Updated on - Date when the change was made.

Figure 21: Audit details for an import job

Note: The audit changes for import jobs are not configurable.

Currently, any changes in the mapping configuration of jobs are captured; however, any internal changes in the mapping
configuration are not audited. Similarly, any SFTP changes for a job are captured; however, any change to SFTP internal
configuration are not audited.

Notes

For Previous value of property and Current value of property columns, the following details are captured:

• For connections, only the change in connection is audited but no details of a specific connection configuration are
captured.

• For objects, following is audited:

• Object deleted
• Object created
• Object prefix change
• Object sequence change
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• For Schedule, the entire schedule change is displayed as a string, which is a concatenation of Frequency, Every,
From Date, To Date, Time and TimeZone fields separated by a delimiter. If any of these fields are changed, then the
entire schedule is audited.

• For "WEEKLY" frequency, days are audited by a weekly mask of 7 bits, with the first bit representing Monday and
the last bit, Sunday.

Changes to data import job configuration can result into issues at times. Administrators need to know who made the
change and when. Auditing the job configuration changes can help capture these details. 

Skip omitted columns from data import file

Prior to this update, when the SKIP functionality for an import object was enabled and if columns were skipped in the
data import file for that object, then Saba Cloud updated all such columns with a "Null" value. This lead to loss of
changes made outside of data import.

With this update, Saba Cloud provides the ability to automatically SKIP all base columns that are omitted.

To view the new SKIP settings on UI, navigate to System > Manage Integrations > Integration Studio > Configure.
The following setting is available under the Import Settings section:

• Skip Omitted Columns

This setting determines whether base columns omitted from a data import file are skipped or not during import.

• If enabled, then non-association columns omitted from the data file are not affected.
• If disabled, then non-association columns omitted from the data file are updated with a "Null" value.

By default, this setting is disabled for all import objects.

Figure 22: Skip omitted columns

The Skip Omitted Columns setting works for:

• All UI imports, and
• Scheduled import jobs that do not use data mapping.
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Supported Objects

Currently, the Skip Omitted Columns setting is supported only for the following objects:

• Ad hoc Transcript
• Audience Type
• Certification
• Classroom
• Curriculum
• Equipment
• Facility
• ILT Offering
• JobType
• Location
• Offering Template
• Organization, External
• Organization, Internal
• Person Profile
• Person, External
• Person, Internal
• Role
• Skill
• SkillGroup
• Transcript
• WBT Offering

Users performing data import assume that when using the SKIP functionality, if a column is being omitted during import,
then its value in the system is not affected. However, if a column is omitted (and no Data Mapping is present), then the
import updates the existing values in the database to "Null". To prevent loss of existing data, there is a need to allow
administrators to control the Skip behavior for such columns.

New Organization Administrator association in data import

Prior to this update, the Organization Administrator role did not exist in Saba Cloud and so there was no corresponding
support to add the role in bulk to organizations using data import.

With this update, Saba Cloud provides the ability to add the Organization Administrator role to organizations in bulk
using data import.

New Object Association

To implement this, the following new association column is added to the organization data import objects:

• ORG_ADMIN

Indicates the Organization Administrators associated with the organization. This column accepts Username or Person
Number as input values.

You can add as many association columns as you want to the object, for example ORG_ADMIN1, ORG_ADMIN2,
... and so on.
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To view the sample data files for the updated objects, navigate to System > Manage Integrations > Integration Studio
> Configure, select Organization, External or Organization, Internaloption from the Object Name dropdown list,
and click the Download Sample button.

New Import Setting (Functionality)

Additionally, the following new advanced import setting is introduced for the supported objects:

• Drop Existing Organization Administrators

If enabled, then all existing Organization Administrators for each record are deleted before adding new ones. If
disabled, then existing Organization Administrators are not affected.

Figure 23: New import setting

Supported Objects

This feature is supported only for the following objects:

• Organization, External
• Organization, Internal

There is a need to support association of the new Organization Administrator role with internal or external organization
using data import.

New column in Person data import

Prior to this update, the Person, Internal and Person, External data import did not support the
ENABLE_TWO_FACTOR_AUTH column to support two factor authentication.

To support to support two factor authentication, this update introduces the ENABLE_TWO_FACTOR_AUTH in the
following data import objects:
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• Person, External
• Person, Internal

Accepted values: True or False

Default value: False

To view the updated sample data files for these objects, navigate to System > Manage Integrations > Integration
Studio > Configure, select Person, External or Person, Internal option from the Object Name dropdown list, and
click the Download Sample button.

The Person data import needs to provide support for two factor authentication.

Prescriptive Rule and Smart List

Assign job role to person via prescriptive rule

Prior to this update, the people administrator could assign the following requirements to people via prescriptive rule:

• Learning event
• Skill
• Shared and Individual goals
• Class
• Continuing Education Requirements
• Security Roles
• Checklists

With this update, the people administrator can now assign job roles (required and optional) to people via the prescriptive
rule.
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Figure 24: Add Job Roles

The people administrator must click Add Required Job Roles / Add Optional Job Roles, select the desired job roles,
and then click Add Roles to add these roles to the prescriptive rule requirement. Save the prescriptive rule and process
it. The newly added job roles will be assigned to people.

This would allow the use of criteria in Prescriptive Rule to identify people who need roles assigned directly to them.
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Prompt to save member selection details when using existing
criteria

When a people administrator is selecting a smart list by using the existing criteria option and moving forward to set the
requirements, the smart list selection is lost because the user did not save the data before leaving the page. This workflow
is inconsistent with the Define new criteria workflow as there the user is prompt to save the selection before moving to
next step.

The Use the existing criteria workflow is now in sync with the Define a new criteria flow as the people administrator
will be prompted to save the current details before moving to set requirements.

As soon as admin selects Use the existing criteria option, selects the criteria, and clicks Step 3: Set Requirements
button, a prompt appears to save the changes.

Figure 25: Prompt to save existing criteria

The use existing criteria workflow is now consistent with the defining new critera where the administrator is prompted
to save the changes before moving to next step.

REST API

Updated REST APIs

Certification and Curriculum APIs to return additional details
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The following REST APIs did not return details like recertifyDays, reassignTargetDays, locale, createdOn/by,
updatedOn/by, expiryType (expiresOnDay, expiresOnMonth  expiresOnFrequency  nextExpiryStartsOnDay,
nextExpiryStartsOnMonth):

• GET DETAILS OF A CERTIFICATION
• GET DETAILS OF A CURRICULUM
• FIND DETAILS OF CERTIFICATION/CURRICULUM
• FIND DETAILS OF CERTIFICATION/CURRICULUM (Using POST - Range based search)

The following REST APIs now return these additional details as part of the Response:

• GET DETAILS OF A CERTIFICATION
• GET DETAILS OF A CURRICULUM
• FIND DETAILS OF CERTIFICATION/CURRICULUM
• FIND DETAILS OF CERTIFICATION/CURRICULUM (Using POST - Range based search)

GET DETAILS OF A CERTIFICATION

Overview

Returns the details of a certification.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/certification/:certId

Calling Options

Table 27: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringcrt~
fy000000000004464

Certification's IDcertId

Return Values

{
  "updated_on": "2016-02-02T00:00:00.000-0500",
  "created_by": "superuser",
  "updated_by": "UONE",
  "created_on": "2014-10-27T05:06:41.000-0400",
  "keywords": [
    {
      "id": "kywrd000000000006265",
      "displayName": "skill"
    },
    {
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      "id": "kywrd000000000006263",
      "displayName": "course_keyword"
    },
    {
      "id": "kywrd000000000006264",
      "displayName": "k100"
    },
    {
      "id": "kywrd000000000006266",
      "displayName": "java"
    }
  ],
  "reAssignedTargetDays": 0,
  "deepLinkUrls": [

"https://<hostname>/Saba/Web_spf/ATHDB1/common/learningeventdetail/crtfy000000000004464"

  ],
  "past_credit_days": null,
  "history_lookup_policy": "CheckHistoryUptoExpiredRevoked",
  "parent": null,
  "description": "description updateddasdas",
  "name": "!000111cert_content",
  "paths": [
    {
      "learningModules": [
        {
          "is_reqd": true,
          "learningInterventions": [
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000017197",
                "displayName": "course_con1"
              },
              "is_waiver": false,
              "sequence": 1,
              "id": "edupl000000000006512"
            },
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000017198",
                "displayName": "course_con2"
              },
              "is_waiver": false,
              "sequence": 2,
              "id": "edupl000000000006513"
            },
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000037404",
                "displayName": "Test for eq"
              },
              "is_waiver": false,
              "sequence": 3,
              "id": "edupl000000000011680"
            }
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          ],
          "notes": null,
          "reqd_no_of_items": 2,
          "is_waiver": true,
          "track_id": null,
          "sequence": 1,
          "name": "!000111cert_content_p1_m1",
          "id": "cegrp000000000004930"
        }
      ],
      "isrecertification_track": false,
      "is_default_path": true,
      "is_path_recalculation_done": false,
      "name": "!000111cert_content_p123",
      "id": "track000000000004850"
    }
  ],
  "disp_learner": true,
  "disp_callcenter": true,
  "self_register": true,
  "featured": false,
  "valid_till": null,
  "notify_before": null,
  "vendor_id": null,
  "avl_from": "2014-10-27T00:00:00.000-0400",
  "disc_from": null,
  "createGroupPolicyVal": true,
  "target_days": 0,
  "learningevent_id": "00012706",
  "version": null,
  "group": {
    "id": "teams000000000010877",
    "displayName": "!000111cert_content"
  },
  "status": "INEFFECT",
  "customValues": {
    "custom9": null,
    "ExCustom4": null,
    "custom3": null,
    "custom4": null,
    "custom1": null,
    "custom2": null,
    "custom7": null,
    "custom8": null,
    "custom5": null,
    "custom6": null
  },
  "securityDomain": {
    "id": "domin000000000059758",
    "displayName": "Domain_IndiaQE"
  },
  "id": "crtfy000000000004464",
  "expiryType": "duration",
  "locale": {
    "id": "local000000000000001",
    "displayName": null
  },
  "recertifyDays": 0
}

Note: The following attributes are only available when the value of 'expiryType' is 'dayOfMonth'. This is only available for certification:

• expiresOnDay

 | System | 80



• expiresOnMonth
• expiresOnFrequency
• nextExpiryStartsOnDay
• nextExpiryStartsOnMonth

{
  "parent": null,
  "created_on": "2016-07-22T17:27:32.000+0530",
  "updated_by": "uone",
  "updated_on": "2016-07-22T17:27:49.000+0530",
  "created_by": "uone",
  "keywords": [],
  "validtill_type": 1,
  "reAssignedTargetDays": 12,
  "past_credit_days": 12,
  "history_lookup_policy": "CheckHistoryUptoExpiredRevoked",
  "deepLinkUrls": [

"http://dqathdb1.sabacloud.com/Saba/Web_spf/ATHDB1/Social/common/learningeventdetail/crtfy000000000200873"

  ],
  "name": "testCertification_U361",
  "description": "testCertification_U361",
  "paths": [
    {
      "name": "Test1_Path1",
      "learningModules": [
        {
          "name": "test_Module_test",
          "notes": "test_Module_test",
          "sequence": 1,
          "track_id": null,
          "is_waiver": true,
          "is_reqd": true,
          "reqd_no_of_items": 1,
          "learningInterventions": [
            {
              "sequence": 1,
              "is_waiver": false,
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000200486",
                "displayName": "111"
              },
              "id": "edupl000000000201247"
            },
            {
              "sequence": 2,
              "is_waiver": false,
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000200815",
                "displayName": "#12#12"
              },
              "id": "edupl000000000201248"
            }
          ],
          "id": "cegrp000000000201045"
        }
      ],
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      "is_default_path": true,
      "isrecertification_track": false,
      "is_path_recalculation_done": false,
      "id": "track000000000201045"
    },
    {
      "name": "Test1_PathU36",
      "learningModules": [
        {
          "name": "test_Module_test1",
          "notes": "test_Module_test1",
          "sequence": 1,
          "track_id": null,
          "is_waiver": true,
          "is_reqd": true,
          "reqd_no_of_items": 1,
          "learningInterventions": [
            {
              "sequence": 1,
              "is_waiver": false,
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000200340",
                "displayName": "aaa"
              },
              "id": "edupl000000000201249"
            },
            {
              "sequence": 2,
              "is_waiver": false,
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000202227",
                "displayName": "aaaaaa"
              },
              "id": "edupl000000000201250"
            },
            {
              "sequence": 3,
              "is_waiver": false,
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000200744",
                "displayName": "aaacou_for_package_with_no_price"
              },
              "id": "edupl000000000201251"
            }
          ],
          "id": "cegrp000000000201046"
        }
      ],
      "is_default_path": true,
      "isrecertification_track": true,
      "is_path_recalculation_done": false,
      "id": "track000000000201046"
    }
  ],
  "disp_learner": true,
  "disp_callcenter": true,

 | System | 82



  "self_register": true,
  "version": "1.2",
  "group": {
    "id": "teams000000000001323",
    "displayName": "testCertification_U361"
  },
  "status": "INEFFECT",
  "createGroupPolicyVal": true,
  "featured": true,
  "valid_till": null,
  "notify_before": 12,
  "vendor_id": null,
  "avl_from": "2016-07-22T00:00:00.000+0530",
  "disc_from": "2034-08-24T00:00:00.000+0530",
  "target_days": 12,
  "learningevent_id": "00201101",
  "customValues": {
    "custom9": null,
    "custom0": null,
    "custom3": null,
    "custom4": null,
    "custom1": null,
    "custom2": null,
    "custom7": null,
    "custom8": null,
    "custom5": null,
    "custom6": null
  },
  "securityDomain": {
    "id": "domin000000000000001",
    "displayName": "world"
  },
  "id": "crtfy000000000200873",
  "expiresOnMonth": "02",
  "nextExpiryStartsOnMonth": "02",
  "expiryType": "dayOfMonth",
  "expiresOnDay": "04",
  "locale": {
    "id": "local000000000000001",
    "displayName": null
  },
  "recertifyDays": 12,
  "nextExpiryStartsOnDay": "04",
  "expiresOnFrequency": 2
}

GET DETAILS OF A CURRICULUM

Overview

Returns the details of a curriculum.

Requires OAuth

No

Method

GET
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URL

https://<hostname-api.sabacloud.com>/v1/curriculum/:currId

Calling Options

Table 28: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringcurra000000000005646Curriculum's IDcurrId

Return Values

{
  "keywords": [],
  "deepLinkUrls": [

"https://<hostname>/Saba/Web_spf/ATHDB1/common/learningeventdetail/curra000000000005646"

  ],
  "description": "Test_Curriculum_123",
  "name": "Test_Curriculum_123",
  "paths": [
    {
      "learningModules": [
        {
          "is_reqd": true,
          "learningInterventions": [
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000040633",
                "displayName": "@$# $ 8-updated name_3_Testingw"
              },
              "is_waiver": false,
              "sequence": 1,
              "id": "edupl000000000015055"
            },
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000040636",
                "displayName": "@$# $ 8-updated name_3_Testingw1"
              },
              "is_waiver": false,
              "sequence": 2,
              "id": "edupl000000000015056"
            },
            {
              "is_reqd": false,
              "owner_id": null,
              "part_id": {
                "id": "cours000000000006559",
                "displayName": "!@#$%^*&()äáº°óñïéê\""
              },
              "is_waiver": false,
              "sequence": 3,
              "id": "edupl000000000015057"
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            }
          ],
          "notes": "Module_12",
          "reqd_no_of_items": 2,
          "is_waiver": true,
          "track_id": null,
          "sequence": 1,
          "name": "Module_12",
          "id": "cegrp000000000010789"
        }
      ],
      "isrecertification_track": false,
      "is_default_path": true,
      "is_path_recalculation_done": false,
      "name": "Test_Path_1",
      "id": "track000000000010510"
    }
  ],
  "disp_learner": false,
  "disp_callcenter": false,
  "self_register": true,
  "featured": false,
  "vendor_id": null,
  "avl_from": "2016-08-24T00:00:00.000-0400",
  "disc_from": null,
  "createGroupPolicyVal": false,
  "target_days": 12,
  "learningevent_id": "00046170",
  "version": null,
  "group": null,
  "status": "INEFFECT",
  "customValues": {
    "ExCustom6": null,
    "ExCustom5": null,
    "custom0": null,
    "ExCustom8": null,
    "ExCustom9": null,
    "custom9": null,
    "custom3": false,
    "custom4": null,
    "custom1": null,
    "custom2": null,
    "custom7": null,
    "ExCustom2": null,
    "custom8": null,
    "custom5": null,
    "custom6": null
  },
  "securityDomain": {
    "id": "domin000000000000001",
    "displayName": "world"
  },
  "id": "curra000000000005646",
  "updated_on": "2016-08-24T02:45:55.000-0400",
  "created_on": "2016-08-24T02:45:48.000-0400",
  "updated_by": "superuser",
  "locale": {
    "id": "local000000000000001",
    "displayName": null
  },
  "created_by": "superuser"
}
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FIND DETAILS OF CERTIFICATION/CURRICULUM

Overview

Returns the details of the Certification/Curriculum along with the ID, Name and the Deeplink URL based on the provided
search criteria.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/:componentName?q=(:criteria_field==:field_value)&count=:count&startPage=:startPage

Calling Options

Table 29: Calling Options

Required?Data TypeSample ValueDescriptionName

YesenumeratedcertificationThe name of the desired
component (certification or
curriculum).

componentName

YesstringnameThe search criteria i.e. the
field name.

You can use any field with
"isSearchFilter": true.

criteria_field

Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get the Meta
details" REST APIs.

YesstringabcThe search value for the
specified search criteria.

field_value

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Fields covered under search criteria (criteria_field)

ExamplePossible
values

Field descriptionField name

certi_name%3D%3DabcName of the certification.certi_name
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ExamplePossible
values

Field descriptionField name

certi_target_days%3D%3DTarget days of the certification.certi_target_days

certi_valid_till%3D%3d100Valid till value of the certification.certi_valid_till

certi_disc_fromDiscountinuation date of the certification.certi_disc_from

certi_avl_fromCertification available from date.certi_avl_from

certi_notify_before%3d%3d130Notify before of the certification.certi_notify_be~
fore

certi_custom0%3D%3D
This%20is%20custom0

Custom 0 field of the certification.certi_custom0

certi_custom1%3D%3D
This%20is%20custom1

Custom 1 field of the certification.certi_custom1

certi_custom2%3D%3D
This%20is%20custom2

Custom 2 field of the certification.certi_custom2

certi_custom3%3D%3D
This%20is%20custom3

Custom 3 field of the certification.certi_custom3

certi_custom4%3D%3D
This%20is%20custom4

Custom 4 field of the certification.certi_custom4

certi_created_by%3D%3DuoneCreated by field of the certification.certi_created_by

certi_created_on%3D%3D 5/8/2002Created on field of the certification.certi_created_on

certi_updated_by%3D%3DuoneUpdated by field of the certification.certi_updated_by

certi_updated_on%3D%3D
5/8/2002

Updated on field of the certification.certi_updated_on

certi_status%3D%3D100Status of the certification.certi_status

version%3D%3d1.0Version of the certification.version

certi_description%3D%3D
descr000000000103641

Description of the certification.certi_description

base_type%3D%3D00 - Certification

1 - Curriculum

Distinguishes whether its certification.base_type

audience_type_id%3D%3D
audie000000000001021

Associated Audience type id of the certific~
ation.

audience_type_id
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ExamplePossible
values

Field descriptionField name

certi_recert_window%3D%3D
certi_recert_window

Number of days before expiration after
which learner can start re-certification work
by pursuing a recertification path.

certi_recert_win~
dow

certi_past_credit_days%3D%3D1Number of days before certification assign~
ment, upto which, system would consider

certi_past_cred~
it_days

completed learning element while doing
certification completion check. If this field
is null then window is infinite i.e. learning
elements completed any time in the past is
valid for this certification. If this field is 0
then system would not look back i.e. any
learning element completed before certific~
ation assignment is not valid for this certi~
fication.

aud_type_outer_search%3D%3D
audie000000000001021

Returns all those certification which has
audience type as a given value or null.

aud_type_out~
er_search

gov_owner%3D%3Dem~
plo000000000200100

Owner id of component.gov_owner

learningevent_id%3D%3D 200056Id(not internal id) of certification.learningevent_id

Name%3D%3DabcName of the certification.name

student_id%3D%3D em~
plo000000000200020

Learner Id for whom the held certification
belongs  

student_id

hide_discontinued_event%3D%3D
5/8/2002

Returns all certification except those which
are discontinued.

hide_discontin~
ued_event

category_comppicker%3D%3D
ddcls000000000001480

Parent or own category id associated with
the certification

cat~
egory_comppick~
er

category_hierarchy%3D%3D cat~
egory_hierarchy

0 - No full hier~
archy

1 - Full hierarchy

Returns full hierarchy of category associ~
ated with the certification.

category_hier~
archy

Name of the certification.csvinput  

category_id%3D%3D
categ000000000001125

If this field is passed all those certification
will be returned which has category with
given category id.

category_id

category_id%3D%3D A10008If this field is passed all those certification
will be returned which has category with
given category name.

category_name
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ExamplePossible
values

Field descriptionField name

at_check%3D%3Dtruetrue or falseAdding this condition peforms an Audience
Type check and only the certifications /

at_check

curricula matching the Audience Type of
the learner will be returned.

Note:  Irrespective of the value of the
at_check query parameter, the Audi~
ence Type check will be done if it is
added in search query.

Return Values

{
  "facets": [],
  "startIndex": 1,
  "results": [
    {
      "updated_on": "2016-02-02T00:00:00.000-0500",
      "created_by": "superuser",
      "updated_by": "UONE",
      "created_on": "2014-10-27T05:06:41.000-0400",
      "keywords": [
        {
          "id": "kywrd000000000006265",
          "displayName": "skill"
        },
        {
          "id": "kywrd000000000006263",
          "displayName": "course_keyword"
        },
        {
          "id": "kywrd000000000006264",
          "displayName": "k100"
        },
        {
          "id": "kywrd000000000006266",
          "displayName": "java"
        }
      ],
      "reAssignedTargetDays": 0,
      "deepLinkUrls": [

"https://<hostname>/Saba/Web_spf/ATHDB1/common/learningeventdetail/crtfy000000000004464"

      ],
      "past_credit_days": null,
      "history_lookup_policy": "CheckHistoryUptoExpiredRevoked",
      "parent": null,
      "description": "description updateddasdas",
      "name": "!000111cert_content",
      "paths": [
        {
          "learningModules": [
            {
              "is_reqd": true,
              "learningInterventions": [
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                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000017197",
                    "displayName": "course_con1"
                  },
                  "is_waiver": false,
                  "sequence": 1,
                  "id": "edupl000000000006512"
                },
                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000017198",
                    "displayName": "course_con2"
                  },
                  "is_waiver": false,
                  "sequence": 2,
                  "id": "edupl000000000006513"
                },
                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000037404",
                    "displayName": "Test for eq"
                  },
                  "is_waiver": false,
                  "sequence": 3,
                  "id": "edupl000000000011680"
                }
              ],
              "notes": null,
              "reqd_no_of_items": 2,
              "is_waiver": true,
              "track_id": null,
              "sequence": 1,
              "name": "!000111cert_content_p1_m1",
              "id": "cegrp000000000004930"
            }
          ],
          "isrecertification_track": false,
          "is_default_path": true,
          "is_path_recalculation_done": false,
          "name": "!000111cert_content_p123",
          "id": "track000000000004850"
        }
      ],
      "disp_learner": true,
      "disp_callcenter": true,
      "self_register": true,
      "featured": false,
      "valid_till": null,
      "notify_before": null,
      "vendor_id": null,
      "avl_from": "2014-10-27T00:00:00.000-0400",
      "disc_from": null,
      "createGroupPolicyVal": true,
      "target_days": 0,
      "learningevent_id": "00012706",
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      "version": null,
      "group": {
        "id": "teams000000000010877",
        "displayName": "!000111cert_content"
      },
      "status": "INEFFECT",
      "customValues": {
        "custom9": null,
        "ExCustom4": null,
        "custom3": null,
        "custom4": null,
        "custom1": null,
        "custom2": null,
        "custom7": null,
        "custom8": null,
        "custom5": null,
        "custom6": null
      },
      "securityDomain": {
        "id": "domin000000000059758",
        "displayName": "Domain_IndiaQE"
      },
      "id": "crtfy000000000004464",
      "expiryType": "duration",
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "recertifyDays": 0
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 1,
  "totalResults": 1569
}

Note: The following attributes are only available when the value of 'expiryType' is 'dayOfMonth'. This is only
available for certification:

• expiresOnDay
• expiresOnMonth
• expiresOnFrequency
• nextExpiryStartsOnDay
• nextExpiryStartsOnMonth

FIND DETAILS OF CERTIFICATION/CURRICULUM (Using POST - Range based search)

Overview

Returns the details of the Certification/Curriculum along with the ID, Name and the Deeplink URL based on the provided
search criteria.

Requires OAuth

No

Method

POST
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URL

https://<hostname-api.sabacloud.com>/v1/:componentName/searchQuery?count=:count&startPage=:startPage&includeDetails=:includeDetails

Calling Options

Table 30: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstring[{"name":
"name","operator":

The search conditions.

You can use any field with
"isSearchFilter": true.

conditions

"==","value": "Blen~
dedcertveren_US"}]

Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get the Meta
details" REST APIs.

You can use search operators
such as:

• =gt=
• =ge=
• =lt=
• =le=
• =eq=
• =ne=

Yesenumerated

[ "certification", "cur~
riculum" ]

certificationThe name of the desired
component.

componentName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

NostringtrueReturns the details of the
Certification/Curriculum in
the search.

includeDetails

Request Body

{
"conditions": [
{ 
 "name": "category_name", 
 "operator": "==", 
 "value": "000001FeaturedCatenglish" 
}]}
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Return Values

{
  "facets": [],
  "startIndex": 1,
  "results": [
    {
      "updated_on": "2016-02-02T00:00:00.000-0500",
      "created_by": "superuser",
      "updated_by": "UONE",
      "created_on": "2014-10-27T05:06:41.000-0400",
      "keywords": [
        {
          "id": "kywrd000000000006265",
          "displayName": "skill"
        },
        {
          "id": "kywrd000000000006263",
          "displayName": "course_keyword"
        },
        {
          "id": "kywrd000000000006264",
          "displayName": "k100"
        },
        {
          "id": "kywrd000000000006266",
          "displayName": "java"
        }
      ],
      "reAssignedTargetDays": 0,
      "deepLinkUrls": [

"https://<hostname>/Saba/Web_spf/ATHDB1/common/learningeventdetail/crtfy000000000004464"

      ],
      "past_credit_days": null,
      "history_lookup_policy": "CheckHistoryUptoExpiredRevoked",
      "parent": null,
      "description": "description updateddasdas",
      "name": "!000111cert_content",
      "paths": [
        {
          "learningModules": [
            {
              "is_reqd": true,
              "learningInterventions": [
                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000017197",
                    "displayName": "course_con1"
                  },
                  "is_waiver": false,
                  "sequence": 1,
                  "id": "edupl000000000006512"
                },
                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000017198",
                    "displayName": "course_con2"
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                  },
                  "is_waiver": false,
                  "sequence": 2,
                  "id": "edupl000000000006513"
                },
                {
                  "is_reqd": false,
                  "owner_id": null,
                  "part_id": {
                    "id": "cours000000000037404",
                    "displayName": "Test for eq"
                  },
                  "is_waiver": false,
                  "sequence": 3,
                  "id": "edupl000000000011680"
                }
              ],
              "notes": null,
              "reqd_no_of_items": 2,
              "is_waiver": true,
              "track_id": null,
              "sequence": 1,
              "name": "!000111cert_content_p1_m1",
              "id": "cegrp000000000004930"
            }
          ],
          "isrecertification_track": false,
          "is_default_path": true,
          "is_path_recalculation_done": false,
          "name": "!000111cert_content_p123",
          "id": "track000000000004850"
        }
      ],
      "disp_learner": true,
      "disp_callcenter": true,
      "self_register": true,
      "featured": false,
      "valid_till": null,
      "notify_before": null,
      "vendor_id": null,
      "avl_from": "2014-10-27T00:00:00.000-0400",
      "disc_from": null,
      "createGroupPolicyVal": true,
      "target_days": 0,
      "learningevent_id": "00012706",
      "version": null,
      "group": {
        "id": "teams000000000010877",
        "displayName": "!000111cert_content"
      },
      "status": "INEFFECT",
      "customValues": {
        "custom9": null,
        "ExCustom4": null,
        "custom3": null,
        "custom4": null,
        "custom1": null,
        "custom2": null,
        "custom7": null,
        "custom8": null,
        "custom5": null,
        "custom6": null
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      },
      "securityDomain": {
        "id": "domin000000000059758",
        "displayName": "Domain_IndiaQE"
      },
      "id": "crtfy000000000004464",
      "expiryType": "duration",
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "recertifyDays": 0
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 1,
  "totalResults": 1569
}

Note: The following attributes are only available when the value of 'expiryType' is 'dayOfMonth'. This is only
available for certification:

• expiresOnDay
• expiresOnMonth
• expiresOnFrequency
• nextExpiryStartsOnDay
• nextExpiryStartsOnMonth

Note:  For more details on this see REST API Reference.

Additional fields make the APIs more usable.

Enrollment search APIs to support created_on field

The following REST APIs did not return the created_on field:

• SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA
• SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA (USING POST - RANGE BASED SEARCH)

The following REST APIs now return the created_on field:

• SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA
• SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA (USING POST - RANGE BASED SEARCH)

SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA

To search enrollments with details:

https://<hostname-api.sabacloud.com>/v1/learning/enroll/search

?q=(custom0%3D%3Dcustom0Val)&count=10&startPage=1&includeDetails=true

 | System | 95

https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068


Return Values:

{
    "facets": [],
    "hasMoreResults": false,
    "totalResults": 1,
    "itemsPerPage": 10,
    "startIndex": 1
    "results": [
        {
            "class_id": {
                "id": "class000000000200443",
                "displayName": "CE04ILT04"
            },
            "student_id": {
                "id": "emplo000000000200099",
                "displayName": "Ajay Tripathi"
            },
            "status": "100",
            "offering_action_id": {
                "id": "ofapr000000000001400",
                "displayName": "00001382"
            },
            "delivery_id": {
                "id": "eqcat000000000000004",
                "displayName": "Instructor-Led"
            },
            "offering_temp_id": {
                "id": "cours000000000200446",
                "displayName": "CE04"
            },

"created_on":"2016-06-22T08:45:24.000+0000",
            "elements_to_complete": 0,
            "reg_no": "00001385",
            "wlist_on": null,
            "wlist_priority": 5,
            "Max_Count": null,
            "Current_Count": null,
            "is_no_show": false,
            "is_walk_in": false,
            "customValues": {
                "custom9": null,
                "custom0": "custom0Val",
                "custom3": null,
                "custom4": null,
                "custom1": null,
                "custom2": null,
                "custom7": null,
                "custom8": null,
                "custom5": null,
                "custom6": null
            },
            "id": "regdw000000000001340"
        }
    ]
}

SEARCH ENROLLMENTS BASED ON GIVEN CRITERIA (USING POST - RANGE BASED SEARCH)

To search enrollments using the POST method:

https://<hostname-api.sabacloud.com>/v1/learning/enroll/search
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?count=10&startPage=1&includeDetails=false

Request Body:

{
    "conditions":[
        {
            "name":"updated_on",
            "operator":"=gt=",
            "value":"2015-08-27T16:18:35.000+0530"
        },
        {
            "name":"updated_on",
            "operator":"=le=",
            "value":"2015-09-03T17:45:46.000+0530"
        }
    ]
}

Return Values:

{
    "facets": [],
    "hasMoreResults": false,
    "totalResults": 1,
    "itemsPerPage": 10,
    "startIndex": 1
    "results": [
        {
            "class_id": {
                "id": "class000000000200443",
                "displayName": "CE04ILT04"
            },
            "student_id": {
                "id": "emplo000000000200099",
                "displayName": "Ajay Tripathi"
            },
            "status": "100",
            "offering_action_id": {
                "id": "ofapr000000000001400",
                "displayName": "00001382"
            },
            "delivery_id": {
                "id": "eqcat000000000000004",
                "displayName": "Instructor-Led"
            },
            "offering_temp_id": {
                "id": "cours000000000200446",
                "displayName": "CE04"
            },

"created_on":"2016-06-22T08:45:24.000+0000",
            "elements_to_complete": 0,
            "reg_no": "00001385",
            "wlist_on": null,
            "wlist_priority": 5,
            "Max_Count": null,
            "Current_Count": null,
            "is_no_show": false,
            "is_walk_in": false,
            "customValues": {
                "custom9": null,
                "custom0": "custom0Val",
                "custom3": null,
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                "custom4": null,
                "custom1": null,
                "custom2": null,
                "custom7": null,
                "custom8": null,
                "custom5": null,
                "custom6": null
            },
            "id": "regdw000000000001340"
        }
    ]
}

Note:  For more details on this see REST API Reference.

N/A

Held learning APIs to return additional details

The following REST APIs did not return details like person_no, username of the learner, createdBy, updatedBy, createdOn,
updatedOn, reassign, started_on, need_recert_cert:

• GET HELD CERTIFICATION/CURRICULUM DETAILS ALONG WITH ALL THE ACTIVITIES
• SEARCH CERTIFICATIONS/CURRICULA OF LOGGED IN USER
• SEARCH ALL THE CERTIFICATIONS/CURRICULA ASSIGNED TO A LEARNER BASED ON THE STATUS,

TIMESTAMP

The following REST APIs now return these additional details as part of the Response:

• GET HELD CERTIFICATION/CURRICULUM DETAILS ALONG WITH ALL THE ACTIVITIES
• SEARCH CERTIFICATIONS/CURRICULA OF LOGGED IN USER
• SEARCH ALL THE CERTIFICATIONS/CURRICULA ASSIGNED TO A LEARNER BASED ON THE STATUS,

TIMESTAMP

GET HELD CERTIFICATION/CURRICULUM DETAILS ALONG WITH ALL THE ACTIVITIES

Overview

Gets held Certification/Curriculum details along with all the activities

Requires OAuth

No

Method

GET

URL

http://<hostname-api.sabacloud.com>/v1/learning/heldlearningevent/:heldCertId
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Calling Options

Table 31: Calling Options

Required?Data TypeSample ValueDescriptionName

YesstringHeld Certification/Cur~
riculum's ID

heldCertId

Return Values

Certification:

{
  "percentcompleted": 0,
  "requirers": [
    {
      "required": true,
      "assignment": {
        "id": "stuce000000000392151",
        "displayName": null
      },
      "activityContext": null,
      "assignee": {
        "sourceType": "InternalPerson",
        "activitySourceType": {
          "sourceType": 0,
          "listId": "sysli000000000003037",
          "key": "0",
          "displayName": "Person"
        },
        "locale": {
          "id": "local000000000000001",
          "displayName": null
        },
        "id": "persn000000000233981",
        "displayName": "client 01"
      },
      "targetDate": 1473059249000,
      "learningEvent": {
        "id": "crtfy000000000010611",
        "displayName": "Test_Certification_123"
      },
      "jobTypeId": null,
      "listIds": null,
      "assignedOn": 1472022450000,
      "source": {
        "sourceType": "InternalPerson",
        "activitySourceType": {
          "sourceType": 0,
          "listId": "sysli000000000003037",
          "key": "0",
          "displayName": "Person"
        },
        "locale": {
          "id": "local000000000000001",
          "displayName": null
        },
        "id": "emplo000000000001000",
        "displayName": "Charles Foster"
      },
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      "actions": null,
      "id": "certh000000003030707"
    }
  ],
  "basicdetail": {
    "updatedOn": 1472022451000,
    "createdBy": "superuser",
    "updatedBy": "superuser",
    "createdOn": 1472022450000,
    "person": {
      "sourceType": "InternalPerson",
      "activitySourceType": {
        "sourceType": 0,
        "listId": "sysli000000000003037",
        "key": "0",
        "displayName": "Person"
      },
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "id": "persn000000000233981",
      "displayName": "client 01"
    },
    "certification_id": {
      "id": "crtfy000000000010611",
      "displayName": "Test_Certification_123"
    },
    "expired_on": null,
    "reassign": true,
    "inRecertification": false,
    "profileElementType": "InternalCert",
    "revoked_on": null,
    "need_recert_ot": false,
    "need_recert_eq": false,
    "recertificationType": [],
    "type": "CERTIFICATION",
    "path": {
      "id": "track000000000010508",
      "displayName": "Test_Path_1"
    },
    "status": {
      "intStatus": 400,
      "description": "Assigned",
      "key": "400",
      "displayName": "Assigned"
    },
    "id": "stuce000000000392151",
    "acquiredOn": null,
    "assignee": {
      "sourceType": "InternalPerson",
      "activitySourceType": {
        "sourceType": 0,
        "listId": "sysli000000000003037",
        "key": "0",
        "displayName": "Person"
      },
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "id": "persn000000000233981",
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      "displayName": "client 01"
    },
    "targetDate": 1473059249000,
    "need_recert": false,
    "startedOn": null,
    "assignedOnDate": 1472022450000,
    "recert_window_starts_on": null,
    "heldCertNo": "00448808  ",
    "owner": {
      "sourceType": "InternalPerson",
      "activitySourceType": {
        "sourceType": 0,
        "listId": "sysli000000000003037",
        "key": "0",
        "displayName": "Person"
      },
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "id": "persn000000000233981",
      "displayName": "client 01"
    },
    "assigneeAdditionalDetails": {
      "person_no": "00010831",
      "username": "CONE01"
    },
    "need_recert_cert": false
  },
  "isgranted": null
}

Curriculum:

{
  "percentcompleted": 0,
  "requirers": [
    {
      "required": true,
      "assignment": {
        "id": "stcur000000000043418",
        "displayName": null
      },
      "activityContext": null,
      "assignee": {
        "sourceType": "InternalPerson",
        "activitySourceType": {
          "sourceType": 0,
          "listId": "sysli000000000003037",
          "key": "0",
          "displayName": "Person"
        },
        "locale": {
          "id": "local000000000000001",
          "displayName": null
        },
        "id": "emplo000000000275911",
        "displayName": "Sean O'coner"
      },
      "targetDate": null,
      "learningEvent": {
        "id": "curra000000000001941",
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        "displayName": "25 Curricula"
      },
      "jobTypeId": null,
      "listIds": null,
      "assignedOn": 1412037159000,
      "source": {
        "componentName": "Prescription Rule",
        "activitySourceType": {
          "sourceType": 3,
          "listId": "sysli000000000003037",
          "key": "3",
          "displayName": "Prescriptive Rule"
        },
        "primaryKey": {
          "prefix": "prule",
          "id": "prule000000000004647"
        },
        "locale": {
          "id": "local000000000000001",
          "displayName": null
        },
        "id": "prule000000000004647",
        "displayName": "u27"
      },
      "actions": null,
      "id": "currh000000001416138"
    }
  ],
  "basicdetail": {
    "updatedOn": 1445816994000,
    "createdBy": "bwillis@saba.com",
    "updatedBy": "admin",
    "createdOn": 1412037159000,
    "need_recert": false,
    "curriculum": {
      "id": "curra000000000001941",
      "displayName": "25 Curricula"
    },
    "recert_window_starts_on": null,
    "revokedOn": null,
    "type": "CURRICULUM",
    "path": null,
    "status": {
      "intStatus": 400,
      "description": "Assigned",
      "displayName": "Assigned"
    },
    "acquiredOn": null,
    "assignee": {
      "sourceType": "InternalPerson",
      "activitySourceType": {
        "sourceType": 0,
        "listId": "sysli000000000003037",
        "key": "0",
        "displayName": "Person"
      },
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "id": "emplo000000000275911",
      "displayName": "Sean O'coner"
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    },
    "targetDate": null,
    "startedOn": null,
    "assignedOnDate": 1412037159000,
    "heldCertNo": "00262446  ",
    "owner": {
      "sourceType": "InternalPerson",
      "activitySourceType": {
        "sourceType": 0,
        "listId": "sysli000000000003037",
        "key": "0",
        "displayName": "Person"
      },
      "locale": {
        "id": "local000000000000001",
        "displayName": null
      },
      "id": "emplo000000000275911",
      "displayName": "Sean O'coner"
    },
    "id": "stcur000000000043418",
    "assigneeAdditionalDetails": {
      "person_no": "00006160",
      "username": "O'CONER@GMAIL.COM"
    }
  },
  "isgranted": null
}

SEARCH CERTIFICATIONS/CURRICULA OF LOGGED IN USER

Overview

Searches for Certifications/Curricula of the logged in user

Requires OAuth

No

Method

GET

URL

http://<hostname-api.sabacloud.com>/v1/learning/heldlearningevent?type=:type&includeDetails=true

Calling Options

Table 32: Calling Options

Required?Data TypeSample ValueDescriptionName

YesenumeratedcertificationThe desired component i.e.
Certification or Curriculum.

type
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Return Values

Certification:

{
  "facets": [],
  "startIndex": 1,
  "results": [
    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stuce000000000266681",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1442376060000,
          "learningEvent": {
            "id": "crtfy000000000002908",
            "displayName": "copy of cert print 321"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1441684901000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "certh000000001692593"
        }
      ],
      "basicdetail": {
        "updatedOn": 1444388162000,
        "createdBy": "admin",
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        "updatedBy": "admin",
        "createdOn": 1441684901000,
        "person": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "certification_id": {
          "id": "crtfy000000000002908",
          "displayName": "copy of cert print 321"
        },
        "expired_on": null,
        "reassign": true,
        "inRecertification": false,
        "profileElementType": "InternalCert",
        "revoked_on": null,
        "recertificationType": [],
        "need_recert_ot": false,
        "need_recert_eq": false,
        "type": "CERTIFICATION",
        "path": {
          "id": "track000000000003397",
          "displayName": "Path1"
        },
        "status": {
          "intStatus": 600,
          "description": "Overdue",
          "key": "600",
          "displayName": "Overdue"
        },
        "id": "stuce000000000266681",
        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1442376060000,
        "need_recert": false,
        "startedOn": null,
        "assignedOnDate": 1441684901000,
        "recert_window_starts_on": null,
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        "heldCertNo": "00289700  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        },
        "need_recert_cert": false
      },
      "isgranted": null
    },
    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stuce000000000390011",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1472045627000,
          "learningEvent": {
            "id": "crtfy000000000010331",
            "displayName": "amtest_certif_mandatoryflag"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1469453627000,
          "source": {
            "componentName": "Prescription Rule",
            "activitySourceType": {
              "sourceType": 3,
              "listId": "sysli000000000003037",
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              "key": "3",
              "displayName": "Prescriptive Rule"
            },
            "primaryKey": {
              "prefix": "prule",
              "id": "prule000000000011881"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "prule000000000011881",
            "displayName": "amtest_certif_mandatoryflag"
          },
          "actions": null,
          "id": "certh000000003020410"
        }
      ],
      "basicdetail": {
        "updatedOn": 1469453628000,
        "createdBy": "admin",
        "updatedBy": "admin",
        "createdOn": 1469453627000,
        "person": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "certification_id": {
          "id": "crtfy000000000010331",
          "displayName": "amtest_certif_mandatoryflag"
        },
        "expired_on": null,
        "reassign": true,
        "inRecertification": false,
        "profileElementType": "InternalCert",
        "revoked_on": null,
        "recertificationType": [],
        "need_recert_ot": false,
        "need_recert_eq": false,
        "type": "CERTIFICATION",
        "path": {
          "id": "track000000000010348",
          "displayName": "amtestpath1"
        },
        "status": {
          "intStatus": 400,
          "description": "Assigned",
          "key": "400",
          "displayName": "Assigned"
        },
        "id": "stuce000000000390011",
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        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          }
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1472045627000,
        "need_recert": false,
        "startedOn": null,
        "assignedOnDate": 1469453627000,
        "recert_window_starts_on": null,
        "heldCertNo": "00447468  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        },
        "need_recert_cert": false
      },
      "isgranted": null
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 2,
  "totalResults": 115
}

Curriculum:

{
  "facets": [],
  "startIndex": 1,
  "results": [
    {
      "percentcompleted": 100,
      "requirers": [
        {
          "required": true,
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          "assignment": {
            "id": "stcur000000000044164",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1413259200000,
          "learningEvent": {
            "id": "curra000000000002924",
            "displayName": "certemplateStory-Curriculum"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1413270631000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "currh000000001469537"
        }
      ],
      "basicdetail": {
        "updatedOn": 1413270631000,
        "createdBy": "superuser",
        "updatedBy": "superuser",
        "createdOn": 1413270631000,
        "need_recert": false,
        "curriculum": {
          "id": "curra000000000002924",
          "displayName": "certemplateStory-Curriculum"
        },
        "recert_window_starts_on": null,
        "revokedOn": null,
        "type": "CURRICULUM",
        "path": {
          "id": "track000000000004746",
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          "displayName": "1"
        },
        "status": {
          "intStatus": 100,
          "description": "Acquired",
          "displayName": "Acquired"
        },
        "acquiredOn": 1413259200000,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": null,
        "startedOn": 1413259200000,
        "assignedOnDate": 1413270631000,
        "heldCertNo": "00267097  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "id": "stcur000000000044164",
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        }
      },
      "isgranted": null
    },
    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stcur000000000028104",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
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            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1409284800000,
          "learningEvent": {
            "id": "curra000000000002620",
            "displayName": "\"Curriculum - 1\""
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1407999097000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "currh000000000855027"
        }
      ],
      "basicdetail": {
        "updatedOn": 1415694199000,
        "createdBy": "superuser",
        "updatedBy": "admin",
        "createdOn": 1407999097000,
        "need_recert": false,
        "curriculum": {
          "id": "curra000000000002620",
          "displayName": "\"Curriculum - 1\""
        },
        "recert_window_starts_on": null,
        "revokedOn": null,
        "type": "CURRICULUM",
        "path": {
          "id": "track000000000004289",
          "displayName": "1"
        },
        "status": {
          "intStatus": 600,
          "description": "Overdue",
          "displayName": "Overdue"
        },
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        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1409284800000,
        "startedOn": null,
        "assignedOnDate": 1407999097000,
        "heldCertNo": "00206679  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "id": "stcur000000000028104",
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        }
      },
      "isgranted": null
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 2,
  "totalResults": 36
}

SEARCH ALL THE CERTIFICATIONS/CURRICULA ASSIGNED TO A LEARNER BASED ON THE
STATUS, TIMESTAMP

Overview

Searches for all the certifications assigned to a learner based on the status or timestamps.

Requires OAuth

No
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Method

GET

URL

http://<hostname-api.sabacloud.com>/v1/learning/heldlearningevent?type=:type&q=(:criteria)&count=:count&startPage=:startPage

Calling Options

Table 33: Calling Options

Required?Data TypeSample ValueDescriptionName

YesenumeratedcertificationThe desired component i.e.
Certification or Curriculum.

type

Yesstringassignee%3D%3D
em~

The search criteria

For CURRICULA the fol~
lowing are the possible val~
ues for the status criteria:

criteria

plo000000000001600,
status%3D%3D600,
cre~

• ACQUIRED : 100 ated_on%3Dge%3D2002-
01-29 01:29:32 AM,• INPROGRESS : 200
up~• ASSIGNED : 400
dated_on%3Dge%3D2002-
01-29 01:29:32 AM

• DISCONTINUED: 500
• OVERDUE : 600
• CANCELLED :800

For CERTIFICATIONS the
following are the possible
values for the status criteria:

• ACQUIRED : 100
• INPROGRESS : 200
• ASSIGNED : 400
• DISCONTINUED: 500
• OVERDUE : 600
• CANCELLED :800
• EXPIRED : 300
• REVOKED : 700

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values
Certification:

{
  "facets": [],
  "startIndex": 1,
  "results": [
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    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stuce000000000266681",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1442376060000,
          "learningEvent": {
            "id": "crtfy000000000002908",
            "displayName": "copy of cert print 321"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1441684901000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "certh000000001692593"
        }
      ],
      "basicdetail": {
        "updatedOn": 1444388162000,
        "createdBy": "admin",
        "updatedBy": "admin",
        "createdOn": 1441684901000,
        "person": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
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            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "certification_id": {
          "id": "crtfy000000000002908",
          "displayName": "copy of cert print 321"
        },
        "expired_on": null,
        "reassign": true,
        "inRecertification": false,
        "profileElementType": "InternalCert",
        "revoked_on": null,
        "recertificationType": [],
        "need_recert_ot": false,
        "need_recert_eq": false,
        "type": "CERTIFICATION",
        "path": {
          "id": "track000000000003397",
          "displayName": "Path1"
        },
        "status": {
          "intStatus": 600,
          "description": "Overdue",
          "key": "600",
          "displayName": "Overdue"
        },
        "id": "stuce000000000266681",
        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1442376060000,
        "need_recert": false,
        "startedOn": null,
        "assignedOnDate": 1441684901000,
        "recert_window_starts_on": null,
        "heldCertNo": "00289700  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
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            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        },
        "need_recert_cert": false
      },
      "isgranted": null
    },
    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stuce000000000390011",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1472045627000,
          "learningEvent": {
            "id": "crtfy000000000010331",
            "displayName": "amtest_certif_mandatoryflag"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1469453627000,
          "source": {
            "componentName": "Prescription Rule",
            "activitySourceType": {
              "sourceType": 3,
              "listId": "sysli000000000003037",
              "key": "3",
              "displayName": "Prescriptive Rule"
            },
            "primaryKey": {
              "prefix": "prule",
              "id": "prule000000000011881"
            },
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            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "prule000000000011881",
            "displayName": "amtest_certif_mandatoryflag"
          },
          "actions": null,
          "id": "certh000000003020410"
        }
      ],
      "basicdetail": {
        "updatedOn": 1469453628000,
        "createdBy": "admin",
        "updatedBy": "admin",
        "createdOn": 1469453627000,
        "person": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "certification_id": {
          "id": "crtfy000000000010331",
          "displayName": "amtest_certif_mandatoryflag"
        },
        "expired_on": null,
        "reassign": true,
        "inRecertification": false,
        "profileElementType": "InternalCert",
        "revoked_on": null,
        "recertificationType": [],
        "need_recert_ot": false,
        "need_recert_eq": false,
        "type": "CERTIFICATION",
        "path": {
          "id": "track000000000010348",
          "displayName": "amtestpath1"
        },
        "status": {
          "intStatus": 400,
          "description": "Assigned",
          "key": "400",
          "displayName": "Assigned"
        },
        "id": "stuce000000000390011",
        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
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            "displayName": "Person"
          }
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1472045627000,
        "need_recert": false,
        "startedOn": null,
        "assignedOnDate": 1469453627000,
        "recert_window_starts_on": null,
        "heldCertNo": "00447468  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        },
        "need_recert_cert": false
      },
      "isgranted": null
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 2,
  "totalResults": 115
}

Curriculum:

{
  "facets": [],
  "startIndex": 1,
  "results": [
    {
      "percentcompleted": 100,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stcur000000000044164",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
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            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1413259200000,
          "learningEvent": {
            "id": "curra000000000002924",
            "displayName": "certemplateStory-Curriculum"
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1413270631000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "currh000000001469537"
        }
      ],
      "basicdetail": {
        "updatedOn": 1413270631000,
        "createdBy": "superuser",
        "updatedBy": "superuser",
        "createdOn": 1413270631000,
        "need_recert": false,
        "curriculum": {
          "id": "curra000000000002924",
          "displayName": "certemplateStory-Curriculum"
        },
        "recert_window_starts_on": null,
        "revokedOn": null,
        "type": "CURRICULUM",
        "path": {
          "id": "track000000000004746",
          "displayName": "1"
        },
        "status": {
          "intStatus": 100,
          "description": "Acquired",
          "displayName": "Acquired"
        },
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        "acquiredOn": 1413259200000,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": null,
        "startedOn": 1413259200000,
        "assignedOnDate": 1413270631000,
        "heldCertNo": "00267097  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "id": "stcur000000000044164",
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        }
      },
      "isgranted": null
    },
    {
      "percentcompleted": 0,
      "requirers": [
        {
          "required": true,
          "assignment": {
            "id": "stcur000000000028104",
            "displayName": null
          },
          "activityContext": null,
          "assignee": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
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              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "targetDate": 1409284800000,
          "learningEvent": {
            "id": "curra000000000002620",
            "displayName": "\"Curriculum - 1\""
          },
          "jobTypeId": null,
          "listIds": null,
          "assignedOn": 1407999097000,
          "source": {
            "sourceType": "InternalPerson",
            "activitySourceType": {
              "sourceType": 0,
              "listId": "sysli000000000003037",
              "key": "0",
              "displayName": "Person"
            },
            "locale": {
              "id": "local000000000000001",
              "displayName": null
            },
            "id": "emplo000000000001000",
            "displayName": "Charles Foster"
          },
          "actions": null,
          "id": "currh000000000855027"
        }
      ],
      "basicdetail": {
        "updatedOn": 1415694199000,
        "createdBy": "superuser",
        "updatedBy": "admin",
        "createdOn": 1407999097000,
        "need_recert": false,
        "curriculum": {
          "id": "curra000000000002620",
          "displayName": "\"Curriculum - 1\""
        },
        "recert_window_starts_on": null,
        "revokedOn": null,
        "type": "CURRICULUM",
        "path": {
          "id": "track000000000004289",
          "displayName": "1"
        },
        "status": {
          "intStatus": 600,
          "description": "Overdue",
          "displayName": "Overdue"
        },
        "acquiredOn": null,
        "assignee": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
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            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "targetDate": 1409284800000,
        "startedOn": null,
        "assignedOnDate": 1407999097000,
        "heldCertNo": "00206679  ",
        "owner": {
          "sourceType": "InternalPerson",
          "activitySourceType": {
            "sourceType": 0,
            "listId": "sysli000000000003037",
            "key": "0",
            "displayName": "Person"
          },
          "locale": {
            "id": "local000000000000001",
            "displayName": null
          },
          "id": "emplo000000000001000",
          "displayName": "Charles Foster"
        },
        "id": "stcur000000000028104",
        "assigneeAdditionalDetails": {
          "person_no": "00001000",
          "username": "SUPERUSER"
        }
      },
      "isgranted": null
    }
  ],
  "hasMoreResults": true,
  "itemsPerPage": 2,
  "totalResults": 36
}

Note:  For more details on this see REST API Reference.

Additional fields make the APIs more usable. This also helps depicting the completion details of certifications accurately
in external systems integrated with Saba.

New attribute added for the CREATE A NEW JOB REQUISITION API

The following REST API did not support capturing the regions where the job is supposed to be posted:

• CREATE A NEW JOB REQUISITION

The following REST API now supports capturing the regions where the job is supposed to be posted:
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• CREATE A NEW JOB REQUISITION

CREATE A NEW JOB REQUISITION

The following new attribute has been added to the API:

Calling Options

Table 34: Calling Options

Required?Data TypeDefault ValueDescriptionName

Nostring[{ "associate": {"id":
"re~

Regionsregions

gio000000000000001"},
"associateType": "RE~
GION"}]

Note:  For more details on this see REST API Reference.

N/A

User-friendly IDs and lookup support for REST APIs

A few REST APIs only accepted internal IDs and didn't support lookup.

The following REST APIs now provide support for user-friendly IDs and lookup.

Purchase Order

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET THE DETAILS OF A PARTICULAR PURCHASE ORDER
• UPDATE THE DETAILS OF A PURCHASE ORDER
• DELETE THE DETAILS OF A PARTICULAR PURCHASE ORDER

URL

https://<hostname-api.sabacloud.com>/v1/purchaseorder/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the po_no instead of the internal PurchaseOrder's ID.

https://<hostname-api.sabacloud.com>/v1/purchaseorder/po_no%3D<PurchaseOrderNo>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW PURCHASE ORDER
2. UPDATE THE DETAILS OF A PURCHASE ORDER

Component NameUI AttributeJSON Attribute
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Organization, ExternalOrganization number / Organization
name

organization

CurrencyISO code of currencycurrency_id

Person, ExternalUsername of Personcontact_id

DomainDomain namesecurityDomain

Categories

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET THE DETAILS OF A PARTICULAR CATEGORY
• REMOVE A CATEGORY

URL

https://<hostname-api.sabacloud.com>/v1/learning/category/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Category's ID.

https://<hostname-api.sabacloud.com>/v1/learning/category/name%3D<CategoryName>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW CATEGORY
2. UPDATE CATEGORY

Component NameUI AttributeJSON Attribute

LanguageLanguagelanguage

CategoryCategory NameparentCategory

Person, Internal/ Person, ExternalUsername of PersonOwner

DomainDomain namesplit

Audience TypeAudience Type NameatList

Person / TeamShare withroles

Note:

Lookup will be performed in fol~
lowing priority:

1. Person
2. Team

Certification

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A CERTIFICATION
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URL

https://<hostname-api.sabacloud.com>/v1/certification/:certId

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Certification's ID.

https://<hostname-api.sabacloud.com>/v1/certification/name%3D<CertificationName>

Note:  If there are multiple records for the name, the following error message will indicate the same:

(120592) More than 1 record found for provided value 'SomeCertificate'

The lookup support is now available for the following REST APIs:

1. CREATE A NEW CERTIFICATION
2. UPDATE THE DETAILS OF A CERTIFICATION

Component NameUI AttributeJSON Attribute

DomainDomain namesecurityDomain

Organization, ExternalVendorvendor_id

CertificationCertificationparent

Curriculum

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A CURRICULUM
• UPDATE DETAILS OF A CURRICULUM

URL

https://<hostname-api.sabacloud.com>/v1/curriculum/:currId

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Curriculum's ID.

https://<hostname-api.sabacloud.com>/v1/curriculum/name%3D<CurriculumName>

Note:  If there are multiple records for the name, the following error message will indicate the same:

(120592) More than 1 record found for provided value 'SomeCurriculum'

The lookup support is now available for the following REST APIs:

1. CREATE A NEW CURRICULUM
2. UPDATE DETAILS OF A CURRICULUM

Component NameUI AttributeJSON Attribute

DomainDomain namesecurityDomain

Organization, ExternalVendorvendor_id

CertificationCertificationparent

Course
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The lookup support is now available for the following REST APIs:

1. CREATE A NEW COURSE
2. UPDATE DETAILS OF A COURSE

Component NameUI AttributeJSON Attribute

DomainDomain namesecurityDomain

Organization, ExternalVendorvendor_id

FieldOfStudyField Of StudyField_of_study

CourseCatalog Prerequisitesrequired_prerequisites

Person, InternalCustomer Service RepresentativeCsr_id

CourseCatalog PrerequisitesRecommended_prerequisites

Audience TypeAudience Type / Audience Sub TypeaudienceType

CurrencyPriceallPrices

Class

The lookup support is now available for the following REST APIs:

1. CREATE A NEW BLENDED CLASS
2. CREATE A NEW ILT CLASS
3. CREATE A NEW VIRTUAL CLASS
4. CREATE A NEW WBT CLASS
5. UPDATE A BLENDED CLASS
6. UPDATE A ILT CLASS
7. UPDATE A WBTCLASS
8. UPDATE A VIRTUAL CLASS

Component NameUI AttributeJSON Attribute

DomainDomain namesecurityDomain

Organization, ExternalVendorvendor_id

Person, InternalCustomer Service RepresentativeCsr_id

Audience TypeAudience Type / Audience Sub TypeaudienceType

Category DefinitionDelivery TypeDelivery_id

LanguageLanguageLanguage_id / Language

LocationLocationLocation_id / Location

FacilityFacilityFacility_id / Facility
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Session TemplateSession TemplateSession_template

Organization, ExternalManufacturerManufacturer_id

Currency Exchange Rate

The lookup support is now available for the following REST APIs:

1. CREATE A NEW EXCHANGE RATE
2. UPDATE DETAILS OF A EXCHANGE RATE

Component NameUI AttributeJSON Attribute

CurrencyFromSrc_id

CurrencyToDest_id

Delivery mode

The lookup support is now available for the following REST APIs:

1. CREATE A NEW DELIVERY MODE
2. UPDATE DETAILS OF A DELIVERY MODE
3. GET DETAILS OF A PARTICULAR DELIVERY MODE

URL

https://<hostname-api.sabacloud.com>/v1/deliverymode/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the acronym instead of the internal Delivery Mode's ID.

https://<hostname-api.sabacloud.com>/v1/deliverymode/acronym%3D<Acronym>

RequiredData TypeComponent NameUI AttributeJSON Attribute

YesObjectDomainDomain namesecurityDomain

NoObjectOrganization, ExternalVendorvendor_id

NoObjectPerson, InternalCustomer Service
Representative

Csr_id

YesObjectCategory DefinitionDelivery TypeDelivery_id

YesObjectCourseCourseoffer_temp_id

Session Template

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR TRAINING UNIT AGREEMENT

URL

https://<hostname-api.sabacloud.com>/v1/sessiontemplate/:id
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URL (User-friendly)
You can use a user-friendly URL which accepts the agreement_no instead of the internal TrainingUnitAgreement's ID.

https://<hostname-api.sabacloud.com>/v1/sessiontemplate/name=<SessionTemplateName>

Note: The SessionTemplate API does not contain a body attribute which can hold the ID and hence lookup is not
required in the Request body.

Training Unit

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR TRAINING UNIT
• UPDATE DETAILS OF A TRAINING UNIT
• DELETE A PARTICULAR TRAINING UNIT

URL

https://<hostname-api.sabacloud.com>/v1/trainingunit/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Training Unit's ID.

https://<hostname-api.sabacloud.com>/v1/trainingunit/name%3D<TrainingUnitsName>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW TRAINING UNIT
2. UPDATE DETAILS OF A TRAINING UNIT

Component NameUI AttributeJSON Attribute

CurrencyCurrencypriceList.curr_id

DomainSercurity DomainsecurityDomain

Training Unit Agreement

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR TRAINING UNIT AGREEMENT
• UPDATE DETAILS OF A TRAINING UNIT AGREEMENT

URL

https://<hostname-api.sabacloud.com>/v1/tuagreement/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the agreement_no instead of the internal TrainingUnitAgreement's ID.

https://<hostname-api.sabacloud.com>/v1/tuagreement/agreement_no%3D<TrainingUnitAgreementsNo>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW TRAINING UNIT AGREEMENT
2. UPDATE DETAILS OF A TRAINING UNIT AGREEMENT

Component NameUI AttributeJSON Attribute

Organization, ExternalOrganisationowner_Id
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PersonOrder_contactorder_contact

Training UnitTraining Unittrainingunit_id

CurrencyCurrencycurrency

Currency

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR CURRENCY

URL

https://<hostname-api.sabacloud.com>/v1/currency/:id:(:searchFields)

URL (User-friendly)
You can use a user-friendly URL which accepts the iso_code instead of the internal Currency's ID.

https://<hostname-api.sabacloud.com>/v1/currency/iso_code%3D<ISOCode>

Timezone

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR TIMEZONE

URL

https://<hostname-api.sabacloud.com>/v1/timezone/:id:(:searchFields)

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Timezone's ID.

https://<hostname-api.sabacloud.com>/v1/tuagreement/name%3D<TimeZoneName>

Example: https://<hostname-api.sabacloud.com>/v1/timezone/name=(GMT-12:00)%20Eniwektok,%20Kwajalein

Audience Type

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR AUDIENCE TYPE
• UPDATE DETAILS OF AN AUDIENCE TYPE

URL

https://<hostname-api.sabacloud.com>/v1/audiencetype/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Audience Type's ID.

https://<hostname-api.sabacloud.com>/v1/audiencetype/name%3D<AudienceTypesName>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW AUDIENCE TYPE
2. UPDATE DETAILS OF AN AUDIENCE TYPE

Component NameUI AttributeJSON Attribute
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DomainDomain namesecurityDomain

Security Domain

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF A PARTICULAR SECURITY DOMAIN

URL

https://<hostname-api.sabacloud.com>/v1/domain/:id:(:searchFields)

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Domain's ID.

https://<hostname-api.sabacloud.com>/v1/domain/name%3D<DomainsName>

Transcripts

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF TRANSCRIPT
• UPDATE CUSTOM FIELDS OF A TRANSCRIPT
• DELETE A TRANSCRIPT

URL

https://<hostname-api.sabacloud.com>/v1/transcripts/:transcriptId

URL (User-friendly)
You can use a user-friendly URL which accepts the action_no instead of the internal Transcript's ID.

https://<hostname-api.sabacloud.com>/v1/transcripts/action_no%3D<TranscriptsActionNo>

The lookup support is now available for the following REST APIs:

1. CREATE A NEW TRANSCRIPT
2. UPDATE A TRANSCRIPT

Component NameUI AttributeJSON Attribute

TranscriptAction NotranscriptId

Person ,ExternalLearnerlearners

LocationLocationLocation

CompetencyProfileCompetenciesCompetencies

Field Of StudyField Of StudyFos

Category DefinitionDelivery TypedeliveryType

Enrollment

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• GET DETAILS OF AN ENROLLMENT
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URL

https://<hostname-api.sabacloud.com>/v1/enrollments/:id/sections:regdetail,classdetail,actions,sessionsdetail,learningAssignments,lessonDetail

URL (User-friendly)
You can use a user-friendly URL which accepts the reg_no instead of the internal Registration's ID.

https://<hostname-api.sabacloud.com>/v1/enrollments/reg_no%3D<RegistrationNo>

/sections:regdetail,classdetail,actions,sessionsdetail,learningAssignments,lessonDetail

The lookup support is now available for the following REST APIs:

1. CREATE A NEW ENROLLMENT (Self registration)
2. ENROLL FOR OTHER USERS/SELF
3. ENROLL FOR OTHER USERS/SELF WITH PAYMENT
4. MARK AN ENROLLMENT COMPLETE

Component NameUI AttributeJSON Attribute

PersonLearnerlearnerId

Category DefinitionDelivery TypedeliveryId

OfferingOfferingofferingId

CurrencyCurrencycurrencyId

PersonOrder ContactorderContact

Registration ItemRegistration NoregId

Attachment

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.

• FIND ALL PUBLIC/PRIVATE ATTACHMENTS
• FIND ALL ATTACHMENTS

URL

https://<hostname-api.sabacloud.com>/v1/attachments?ownerId=:ownerId

URL (User-friendly)
You can use a user-friendly URL which accepts the location instead of the internal Owner's ID.

https://<hostname-api.sabacloud.com>/v1/attachments/?ownerName=location&ownerId=:ownerId

The lookup support is now available for the following REST APIs:

1. CREATE A NEW ATTACHMENT (FILE)
2. CREATE A NEW ATTACHMENT (URL)
3. UPDATE AN ATTACHMENT

Lookup is supported for following type of owners:

• location

• facility

• room
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• equipment

• inventory

• purchaseOrder

• package

• deliveryMode

Note: When using a lookup value in a URL, any special characters must be URL-encoded.

Multiple records for the same lookup will result in an error.

Note:  For more details on this see REST API Reference.

Many attributes are identified by internal IDs. The developer first needs to GET the internal ID before using it as an
attribute. This enhancement makes the REST APIs more user friendly by now accepting user-friendly IDs in addition
to the internal IDs.

New attribute added for the CREATE A NEW VIRTUAL CLASS API

The following REST API did not return the VLE information:

• CREATE A NEW VIRTUAL CLASS

The following REST API now returns the VLE information as part of the Return Values in a new attribute called
vleInfoDetail:

• CREATE A NEW VIRTUAL CLASS

CREATE A NEW VIRTUAL CLASS

Overview

Creates a new Virtual Class Class.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/offering
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Return Values

{
    "@type": "com.saba.learning.services.offering.OfferingDetail",
    "abstract": "",
    "endDate": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "timeInLocale": "5:00 AM",
        "dateInUserTimeZone": "11/15/13",
        "timeInUserTimeZone": "3:30 PM",
        "date": 1384509600000,
        "locale": "11/15/13"
    },
    "startDate": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "timeInLocale": "5:00 AM",
        "dateInUserTimeZone": "11/15/13",
        "timeInUserTimeZone": "3:30 PM",
        "date": 1384509600000,
        "locale": "11/15/13"
    },
    "customValues": [
        "list",
        []
    ],
    "securityDomain": {
        "@type": "ServiceObjectReference",
        "id": "domin000000000000001",
        "displayName": "world"
    },
    "price": {
        "@type": "com.saba.learning.services.common.Money",
        "amount": [
            "java.math.BigDecimal",
            0
        ],
        "isocode": "USD",
        "amountString": "0 USD",
        "currency": {
            "@type": "ServiceObjectReference",
            "id": "crncy000000000000167",
            "displayName": null
        }
    },
    "baseDeliveryType": 100,
    "deliveryType": {
        "@type": "ServiceObjectReference",
        "id": "eqcat000000000000008",
        "displayName": "Virtual Classroom"
    },
    "offeringTemplate": {
        "@type": "ServiceObjectReference",
        "id": "cours000000000006618",
        "displayName": "testCouse"
    },
    "availableSeats": -1,
    "offeringNumber": "VVVVVVVV",
    "sessionTemplate": "ses_222",
    "trainingUnits": 25,
    "locationDetail": {
        "@type": "com.saba.learning.services.resource.LocationDetail",
        "addressInfo": {
            "@type": "com.saba.learning.services.common.AddressDetail",
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            "addressLine2": "abc",
            "addressLine3": null,
            "addressLine1": "",
            "city": "",
            "zipCode": "",
            "state": "",
            "country": "India"
        },
        "locationContact": null,
        "timezone": {
            "@type": "ServiceObjectReference",
            "id": "tzone000000000000012",
            "displayName": "(GMT-05:00) Eastern Time (US & Canada)"
        },
        "attachments": [
            "list",
            []
        ],
        "contactInfo": {
            "@type": "com.saba.learning.services.common.ContactDetail",
            "primaryPhone": "",
            "secondaryPhone": "",
            "email": "",
            "fax": ""
        },
        "locationId": "LOCANUMBER",
        "locationName": "Locationname",
        "organization": null
    },
    "dif": false,
    "availabilityDetails": {
        "@type": 
"com.saba.learning.services.offering.OfferingDetail$OfferingRegistrationAvailabilityDetailsSection",

        "offeringPrice": {
            "@type": "com.saba.learning.services.common.Money",
            "amount": [
                "java.math.BigDecimal",
                0
            ],
            "isocode": "USD",
            "amountString": "0 USD",
            "currency": {
                "@type": "ServiceObjectReference",
                "id": "crncy000000000000167",
                "displayName": null
            }
        },
        "offeringPriceDisplay": "0 USD",
        "availableSeats": -1
    },
    "offeringlocked": false,
    "delivery_id": {
        "@type": "ServiceObjectReference",
        "id": "eqcat000000000000008",
        "displayName": "Virtual Classroom"
    },
    "location_id": {
        "@type": "ServiceObjectReference",
        "id": "locat000000000001202",
        "displayName": "Locationname"
    },
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    "max_ct": 20,
    "max_book": 20,
    "min_ct": 5,
    "csr_id": null,
    "session_template": "ses_222",
    "language_id": {
        "@type": "ServiceObjectReference",
        "id": "lange000000000000001",
        "displayName": "English"
    },
    "disp_for_web": true,
    "disp_for_call_center": false,
    "facility_id": null,
    "vendor_id": null,
    "open_enroll": null,
    "open_enroll_for_all": null,
    "enroll_close": null,
    "post_order": null,
    "post_completion": null,
    "stop_auto_promotion": null,
    "vleInfo": null,
    "vleInfoDetail": {
        "@type": "map",
        "vleProvider": {
         "@type": "map",
         "displayname": "Saba Classroom",
         "id": "vlesp000000000001000"
        },
       "audioOptions":"voipAndTelephone",
       "teleconfCallNumber":"1800100200",
       "isLiveVideo":true,
       "isRecordVideo":true,
       "alternateTeleConfCallNumber":"1800100201",
       "teleConfHostCode":"123456",
       "teleconfAccessCode":"8324567",
       "welcomeUrl":"www.sabacloud.com",
       "logoutUrl":"www.saba.com"
       "meetingTemplate":"test adobe template",
       "additionalSeats":0,
       "guestAttendUrl":"www.google.com"
 },
    "do_not_drop_post": null,
    "start_date": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "timeInLocale": "5:00 AM",
        "dateInUserTimeZone": "11/15/13",
        "timeInUserTimeZone": "3:30 PM",
        "date": 1384509600000,
        "locale": "11/15/13"
    },
    "avail_from": null,
    "disc_from": null,
    "skip_days_map": "0000000",
    "learningAssignments": null,
    "offering_temp_id": {
        "@type": "ServiceObjectReference",
        "id": "cours000000000006618",
        "displayName": "testCouse"
    },
    "wbt_no": "VVVVVVVV",
    "class_no": "VVVVVVVV",
    "diffHours": 0,
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    "endDateI18n": "11/15/13",
    "startDateI18n": "11/15/13",
    "priceDisplayString": "0 USD",
    "dropPolicyInfo": {
        "@type": "com.saba.learning.services.catalog.DropPolicyInfo",
        "trainingUnitDropPolicyInfo": null,
        "allEffectivePolicies": [
            "list",
            [
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 22,
                    "daysFrom": 18,
                    "charge": 25,
                    "displayString": "Cancellation charge of 25.0 % if dropped
 between 10/24/13 and 10/28/13.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 17,
                    "daysFrom": 13,
                    "charge": 20,
                    "displayString": "Cancellation charge of 20.0 % if dropped
 between 10/29/13 and 11/02/13.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 12,
                    "daysFrom": 8,
                    "charge": 15,
                    "displayString": "Cancellation charge of 15.0 % if dropped
 between 11/03/13 and 11/07/13.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 7,
                    "daysFrom": 3,
                    "charge": 10,
                    "displayString": "Cancellation charge of 10.0 % if dropped
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 between 11/08/13 and 11/12/13.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 2,
                    "daysFrom": 0,
                    "charge": 5,
                    "displayString": "Cancellation charge of 5.0 % if dropped
 between 11/13/13 and 11/15/13.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "chargeType": 1,
                    "daysTo": 99999,
                    "daysFrom": -99999,
                    "charge": 45.5,
                    "displayString": "Cancellation charge of 45.5 % for all 
other days.",
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                }
            ]
        ],
        "lastDateToDropWithoutCharge": null
    },
    "courseVersion": null,
    "customFields": {
        "@type": "map"
    },
    "durationString": "00:00",
    "offering_temp_no": null,
    "publishStartDate": null,
    "publishEndDate": null,
    "publishStatus": null,
    "publishStatusMessage": null,
    "name": "testCouse",
    "language": {
        "@type": "ServiceObjectReference",
        "id": "lange000000000000001",
        "displayName": "English"
    },
    "location": {
        "@type": "ServiceObjectReference",
        "id": "locat000000000001202",
        "displayName": "Locationname"
    },
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    "resources": [
        "list",
        []
    ],
    "id": "virtc000000000002908",
    "description": "desc",
    "duration": 0
}

Note:  For more details on this see REST API Reference.

N/A

New attribute added for the Subscription APIs

The following REST API did not support capturing the group creation flag:

• CREATE A NEW SUBSCRIPTION

The following REST API now supports capturing the group creation flag:

• CREATE A NEW SUBSCRIPTION

CREATE A NEW SUBSCRIPTION

The following new attribute has been added to the API:

Calling Options

Table 35: Calling Options

Required?Data TypeSample ValueDescriptionName

NostringWhether to create a group.
Accepts: true/false

create_group

The GET DETAILS OF A PARTICULAR SUBSCRIPTION API now returns this new attribute as part of the Return
Values.

GET DETAILS OF A PARTICULAR SUBSCRIPTION

Return Values

{  
   description:null,
   avail_from:"2014-12-26T00:00:00.000+0530",
   disc_from:null,
   title:"Subscription 8",
   avail_web:true,
   allPrices:[  
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      {  
         amount:10,
         curr_id:{  
            id:"crncy000000000000001",
            displayName:"US Dollars"
         },
         displayValue:null,
         id:"plent000000000203956"
      },
      {  
         amount:12.3,
         curr_id:{  
            id:"crncy000000000001005",
            displayName:"Currency1"
         },
         displayValue:null,
         id:"plent000000000203957"
      },
      {  
         amount:8.2,
         curr_id:{  
            id:"crncy000000000001006",
            displayName:"Currency2"
         },
         displayValue:null,
         id:"plent000000000203958"
      },
      {  
         amount:20,
         curr_id:{  
            id:"crncy000000000200968",
            displayName:"Rupees"
         },
         displayValue:null,
         id:"plent000000000203959"
      }
   ],
   training_units:0,
   updated_by:"uone",
   updated_on:"2014-12-26T17:10:28.000+0530",
   created_by:"uone",
   avail_call_center:true,
   grace_period:null,
   cost_limit:0,
   before_expiry:0,
   is_featured:true,
   allAudienceTypes:[  

   ],
   reg_limit:null,
   subscription_no:"00001025",
   entire_catalog:false,
   allSubscriptionItems:[  
      {  
         type:{  
            value:300
         },
         subscription:{  
            id:"sbscr000000000001045",
            displayName:"Subscription 8"
         },
         criteria:false,
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         componentName:"SubscriptionItemChoice",
         subscriptionItem:{  
            id:"dowbt000000000001591",
            displayName:"#12"
         }
      },
      {  
         type:{  
            value:300
         },
         subscription:{  
            id:"sbscr000000000001045",
            displayName:"Subscription 8"
         },
         criteria:false,
         componentName:"SubscriptionItemChoice",
         subscriptionItem:{  
            id:"dowbt000000000001592",
            displayName:"#12#12"
         }
      }
   ],
   allCostLimits:[  

   ],
   days_limit:0,
   create_group:false,
   id:"sbscr000000000001045",
   customValues:{  
      custom9:null,
      custom0:null,
      custom3:null,
      custom4:null,
      custom1:null,
      custom2:null,
      custom7:null,
      custom8:null,
      custom5:null,
      custom6:null
   },
   securityDomain:{  
      id:"domin000000000000001",
      displayName:"world"
   }
}

Note:  For more details on this see REST API Reference.

N/A

New REST APIs

API to retrieve completion detail of the learning event
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Using REST API there was no way to determine whether elements of a certification were completed directly or by
completing an equivalent.

The following new REST API will now allow retrieving completion details of the learning event:

GET COMPLETION DETAILS OF THE LEARNING EVENT

Overview

Gets completion details of the learning event.

Note: This API is applicable for both certification as well as curriculum.

Requires OAuth

No

Method

GET

URL

http://<hostname-api.sabacloud.com>/v1/learning/heldlearningevent/:heldCertId/:pathId/sections:(:searchFields)

Calling Options

Table 36: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringstuce000000000202608Held Certification/Cur~
riculum activity ID

heldCertId

Yesstringtrack000000000201083Path IDpathId

YesstringcompletiondetailCompletion Detail of the
learning event

searchFields

Return Values

{
  "owner": {
    "id": "emplo000000000201487",
    "displayName": "smu 11"
  },
  "percentCompleted": 100,
  "acquiredOn": "2016/07/31T18:30:00UTC",
  "revoked_on": null,
  "assignedOnDate": "2016/08/01T08:17:05UTC",
  "type": "CERTIFICATION",
  "certification": {
    "id": "crtfy000000000200920",
    "displayName": "Certification_U36_1"
  },
  "path": {
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    "percentCompleted": 100,
    "learningModules": [
      {
        "is_reqd": true,
        "sequence": 1,
        "learningInterventions": [
          {
            "sequence": 1,
            "id": "edupl000000000201332",
            "part_id": {
              "id": "cours000000000200810",
              "displayName": "1ab"
            },
            "type": "COURSE",
            "is_completion_by_equivalent": true,
            "is_completed": true
          },
          {
            "sequence": 2,
            "id": "edupl000000000201333",
            "part_id": {
              "id": "cours000000000200811",
              "displayName": "21ab"
            },
            "type": "COURSE",
            "is_completion_by_equivalent": false,
            "is_completed": false
          },
          {
            "sequence": 3,
            "id": "edupl000000000201334",
            "part_id": {
              "id": "cours000000000202186",
              "displayName": "a2"
            },
            "type": "COURSE",
            "is_completion_by_equivalent": false,
            "is_completed": false
          },
          {
            "sequence": 4,
            "id": "edupl000000000201335",
            "part_id": {
              "id": "crtfy000000000200492",
              "displayName": "bd33"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": 100,
              "description": "Acquired"
            }
          },
          {
            "sequence": 5,
            "id": "edupl000000000201336",
            "part_id": {
              "id": "crtfy000000000200494",
              "displayName": "bd35"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": null,
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              "description": "Not Assigned"
            }
          },
          {
            "sequence": 6,
            "id": "edupl000000000201337",
            "part_id": {
              "id": "crtfy000000000200465",
              "displayName": "bd6"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": null,
              "description": "Not Assigned"
            }
          }
        ],
        "displayName": "module_u36_1",
        "no_of_total_items": 6,
        "no_of_reqd_items": 2,
        "no_of_total_items_completed": 2,
        "id": "cegrp000000000201086"
      },
      {
        "is_reqd": false,
        "sequence": 2,
        "learningInterventions": [
          {
            "sequence": 1,
            "id": "edupl000000000201338",
            "part_id": {
              "id": "cours000000000200704",
              "displayName": "¿¿¿"
            },
            "type": "COURSE",
            "is_completion_by_equivalent": false,
            "is_completed": false
          },
          {
            "sequence": 2,
            "id": "edupl000000000201339",
            "part_id": {
              "id": "cours000000000201386",
              "displayName": "¿¿¿¿¿¿"
            },
            "type": "COURSE",
            "is_completion_by_equivalent": false,
            "is_completed": false
          }
        ],
        "displayName": "module_u36_2",
        "no_of_total_items": 2,
        "no_of_reqd_items": 1,
        "no_of_total_items_completed": 0,
        "id": "cegrp000000000201087"
      },
      {
        "is_reqd": false,
        "sequence": 3,
        "learningInterventions": [
          {
            "sequence": 1,
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            "id": "edupl000000000201340",
            "part_id": {
              "id": "crtfy000000000200492",
              "displayName": "bd33"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": 100,
              "description": "Acquired"
            }
          },
          {
            "sequence": 2,
            "id": "edupl000000000201341",
            "part_id": {
              "id": "crtfy000000000200494",
              "displayName": "bd35"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": null,
              "description": "Not Assigned"
            }
          },
          {
            "sequence": 3,
            "id": "edupl000000000201342",
            "part_id": {
              "id": "crtfy000000000200465",
              "displayName": "bd6"
            },
            "type": "CERTIFICATION",
            "status": {
              "intStatus": null,
              "description": "Not Assigned"
            }
          }
        ],
        "displayName": "module_u36_3",
        "no_of_total_items": 3,
        "no_of_reqd_items": 2,
        "no_of_total_items_completed": 1,
        "id": "cegrp000000000201088"
      }
    ],
    "is_default_path": true,
    "is_acquisition_path": true,
    "no_of_reqd_modules": 1,
    "displayName": "path_u36_1",
    "no_of_total_modules": 3,
    "id": "track000000000201083",
    "is_recert_path": false
  },
  "inRecertification": true,
  "recert_window_starts_on": "2018/05/21T18:30:00UTC",
  "id": "stuce000000000202608",
  "expired_on": "2018/06/13T18:30:00UTC",
  "status": {
    "description": "Acquired",
    "status": "100"
  }
}
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Note:  For more details on this see REST API Reference.

This enhancement provides a REST API that represents the UI behavior for when a user clicks on View Certification
History > Main tab for a Student-certification.

APIs to retrieve or update details of job requisitions

There were no REST APIs that would allow retrieving or updating the details of job requisitions.

The following new REST APIs will now allow retrieving and updating the details of job requisitions:

1. GET DETAILS OF A PARTICULAR JOB REQUISITIONS
2. GET DETAILS OF ALL JOB REQUISITIONS
3. FIND THE DETAILS OF THE JOB REQUISITION
4. FIND THE DETAILS OF THE JOB REQUISITION (Using POST - Range based search)
5. UPDATE JOB REQUISITION

GET DETAILS OF A PARTICULAR JOB REQUISITION

Overview

Returns the details of a particular job requisition.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/job-requisition/:id:(:searchFields)

Calling Options

Table 37: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringjobrq000000000001020The ID of the desired job re~
quisition

id

NostringIndicate what additional de~
tails need to be returned in

searchFields

the output. Acceptable val~
ues are (case-sensitive)
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Required?Data TypeDefault ValueDescriptionName

You can use any field with
"isSearchFilter": true.

Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get Meta
details" REST APIs.

Return Values

{
  "location": {
    "id": "locat000000000001000",
    "displayName": "Location1"
  },
  "description": "<p>recruting test 01 job</p>",
  "source": null,
  "requisitionTemplate": {
    "id": "reqtp000000000000001",
    "displayName": "System Default Template"
  },
  "employmentType": "Permanent",
  "requisitionStage": [],
  "requiresTravel": false,
  "requiresResume": true,
  "requiresCoverLetter": false,
  "companyDescription": "<p>Company Description for the Requisition 
Template</p>",
  "requiresPreAssessment": false,
  "organization": {
    "id": "bisut000000000001000",
    "displayName": "BusinessUnit1"
  },
  "status": "DRAFT",
  "sourceType": null,
  "jobFamily": {
    "id": "jfmly000000000001000",
    "displayName": "Position job family"
  },
  "title": "HPEngineer3",
  "approvedOn": null,
  "targetDate": null,
  "googleMapWidget": null,
  "publishedOn": null,
  "jobType": null,
  "notes": "<p>Perfect</p>",
  "submittedOn": null,
  "minExperience": 2,
  "maxExperience": 5,
  "interviewers": [],
  "recruiter": [
    {
      "stakeholderType": "RECRUITER",
      "requisition": {
        "id": "jobrq000000000001045",
        "displayName": "HPEngineer3"
      },
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      "stakeholder": {
        "id": "persn000000000201414",
        "displayName": "fname lname"
      },
      "id": "rsthd000000000001059"
    }
  ],
  "industry": "Computer Software",
  "applicantType": "INTERNAL-ONLY",
  "closedDate": null,
  "hrPartner": {
    "id": "emplo000000000001043",
    "displayName": "User3 Four3"
  },
  "hiringManager": {
    "id": "emplo000000000001000",
    "displayName": "User One"
  },
  "minimumSalary": 20000,
  "maximumSalary": 500000,
  "requisitionNo": "1043",
  "qualification": "<p>everything</p>",
  "salaryType": "YEARLY",
  "jobAdStyle": "Cool",
  "noOfOpenings": 1,
  "isEEOCReq": true,
  "unpublishType": "NONE",
  "unpublishDays": 30,
  "endOfMonth": false,
  "marketAverage": null,
  "referralBonus": null,
  "unpublishDate": null,
  "plainTextSM": null,
  "pieChartSM": null,
  "barChartSM": {
    "type": "BAR-CHART",
    "owner": {
      "id": "jobrq000000000001045",
      "displayName": "HPEngineer3"
    },
    "identifier": "barChartSM",
    "smartWidgetValues": [
      {
        "name": "Developer",
        "value": "2",
        "parent": {
          "id": "smtwd000000000001042",
          "displayName": "Experience"
        },
        "id": "smtvl000000000001089"
      }
    ],
    "smartWidget_visibility": "ANYONE",
    "title": "Experience",
    "id": "smtwd000000000001042"
  },
  "progressBarSM": null,
  "midSalary": 260000,
  "midBudget": 260000,
  "maxBudget": 500000,
  "salaryCurrency": null,
  "category": "Professionals",
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  "compensation": "Nothing",
  "costCenter": "Everything",
  "isFeaturedJobExternal": false,
  "referralBonusCurr": null,
  "educationQualification": null,
  "id": "jobrq000000000001045",
  "customValues": {
    "custom9": null,
    "custom0": null,
    "custom3": null,
    "custom4": null,
    "custom1": null,
    "custom2": null,
    "custom7": null,
    "custom8": null,
    "custom5": null,
    "custom6": null
  },
  "securityDomain": {
    "id": "domin000000000000001",
    "displayName": "world"
  },
  "jobboards": [],
  "regions": [
    {
      "associateType": "REGION",
      "requisition": {
        "id": "jobrq000000000001045",
        "displayName": "HPEngineer3"
      },
      "associate": {
        "id": "regio000000000002000",
        "displayName": "New1"
      },
      "id": "jrass000000000001023"
    }
  ]
}

GET ALL JOB REQUISITIONS

Overview

Returns all job requisitions.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/job-requisition?count=:count&startPage=:startPage
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Calling Options

Table 38: Calling Options

Required?Data TypeDefault ValueDescriptionName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
  "facets": [],
  "startIndex": 1,
  "hasMoreResults": true,
  "totalResults": 84,
  "itemsPerPage": 10,
  "results": [
    {
      "id": "jobrq000000000001040",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001040"
    },
    {
      "id": "jobrq000000000001044",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001044"
    },
    {
      "id": "jobrq000000000001045",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001045"
    },
    {
      "id": "jobrq000000000001046",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001046"
    },
    {
      "id": "jobrq000000000001047",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001047"
    },
    {
      "id": "jobrq000000000001050",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001050"
    },
    {
      "id": "jobrq000000000001060",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001060"
    },
    {
      "id": "jobrq000000000001080",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001080"
    },
    {
      "id": "jobrq000000000001081",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001081"
    },
    {
      "id": "jobrq000000000001082",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001082"
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    }
  ]
}

FIND DETAILS OF JOB REQUISITION

Overview

Finds the details of the job requisitions.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/job-requisition?q=(:criteria)&count=:count&startPage=:startPage

Calling Options

Table 39: Calling Options

Required?Data
Type

Sample ValueDescriptionName

YesstringThe search criteria i.e. the
criteria field name with
search value.

You can use the following
fields:

criteria
• JobRequisitionStatus%3D%3DDRAFT
• Location%3D%3Dlocat 000000000001000
• requisitionNo%3D%3D1001
• category%3D%3DNot Specified
• employmentType%3D%3DTemporary

• JobRequisitionStatus • costCenter%3D%3DSaba
• Location • Domain%3D%3Ddomin 000000000000001
• requisitionNo • Id%3D%3Djobrq 000000000001001
• category
• employmentType
• costCenter
• Domain
• Id

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

start~
Page
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Return Values

{
    "facets": [],
    "startIndex": 1,
    "results": [
        {
            "id": "jobrq000000000001017",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001017"

        },
        {
            "id": "jobrq000000000001020",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001020"

        },
        {
            "id": "jobrq000000000001182",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001182"

        },
        {
            "id": "jobrq000000000001189",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001189"

        },
        {
            "id": "jobrq000000000001251",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001251"

        },
        {
            "id": "jobrq000000000001387",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001387"

        },
        {
            "id": "jobrq000000000001380",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001380"

        },
        {
            "id": "jobrq000000000001383",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001383"

        },
        {
            "id": "jobrq000000000001430",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001430"

        },
        {
            "id": "jobrq000000000001542",
            "href": "http://<host_name>/v1/job-requisition/jobrq000000000001542"

        }
    ],
    "hasMoreResults": true,
    "itemsPerPage": 10,
    "totalResults": 0
}
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FIND DETAILS OF JOB REQUISITION (Using POST - Range based search)

Overview

Returns the details of the job requisitions along with the ID, Name and the Deeplink URL based on the provided range
based search criteria.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/job-requisition/searchQuery?count=:count&startPage=:startPage

Calling Options

Table 40: Calling Options

Required?Data
Type

Sample ValueDescriptionName

YesstringThe search conditions.

You can use the follow~
ing fields:

conditions
• { [{"name": "JobRequisitionStatus","operator":

"==","value": "DRAFT"}] }
• { [{"name": "Location","operator": "==","value":

"locat 000000000001000"}] }• JobRequisitionStatus
• { [{"name": "requisitionNo","operator":

"==","value": "1001"}] }
• Location
• requisitionNo

• { [{"name": "category","operator": "==","value":
"Not Specified"}] }

• category
• employmentType

• { [{"name": "employmentType","operator":
"==","value": "Temporary"}] }• costCenter

• Domain • { [{"name": "costCenter","operator": "==","value":
"Saba"}] }• Id

You can use search oper~
ators such as:

• { [{"name": "Domain","operator": "==","value":
"domin 000000000000001"}] }

• { [{"name": "Id","operator": "==","value": "jobrq
000000000001001"}] }

• =gt=
• =ge=
• =lt=
• =le=
• =eq=
• =ne=

Nostring10The number of records
per page.

count

Nostring1The start page number
for the list of records.

startPage
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Request Body

{
    [{"name": "title","operator": "==","value": "job 1"}]
}

Return Values

{
  "facets": [],
  "startIndex": 1,
  "hasMoreResults": true,
  "totalResults": 84,
  "itemsPerPage": 10,
  "results": [
    {
      "id": "jobrq000000000001040",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001040"
    },
    {
      "id": "jobrq000000000001044",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001044"
    },
    {
      "id": "jobrq000000000001045",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001045"
    },
    {
      "id": "jobrq000000000001046",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001046"
    },
    {
      "id": "jobrq000000000001047",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001047"
    },
    {
      "id": "jobrq000000000001050",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001050"
    },
    {
      "id": "jobrq000000000001060",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001060"
    },
    {
      "id": "jobrq000000000001080",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001080"
    },
    {
      "id": "jobrq000000000001081",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001081"
    },
    {
      "id": "jobrq000000000001082",
      "href": "http://<host_name>/v1/job-requisition/jobrq000000000001082"
    }
  ]
}
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UPDATE JOB REQUISITION

Overview

Updates job requisition based on the job requisition's ID that is passed as the parameter.

Requires OAuth

No

Method

PUT

URL

http://<hostname-api.sabacloud.com>/v1/job-requisition/:id

Calling Options

Table 41: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringjobrq000000000001020The id of job requisition to
be updated

id

Nostring{ "id":
"locat000000000001000",

Locationlocation

"displayName": "Loca~
tion1" }

Nostring<p>recruting test 01
job</p>

Job Descriptiondescription

Nostring{"id":"bisut000000000001000",
"displayName":"Busi~
nessUnit1"}

Organizationorganization

Nostring{"id":"re~
qtp000000000000001",
"displayName":null}

Job Requisition TemplaterequisitionTemplate

NostringContractorType of EmploymentemploymentType

Nostring[{"isRequired": false,
"assessment": {"id":

Requisition StagerequisitionStage

"cninv000000000057714",
"displayName": "Job
0129-0131-
034520631472023431041"},
"stageName": "Pre as~
sessment", "se~
quence": 1, "type":
"PRE-ASSESS~
MENT"}]
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Required?Data TypeDefault ValueDescriptionName

NostringfalseRequires TravelrequiresTravel

NostringfalseRequires ResumerequiresResume

NostringfalseAllow Cover LetterrequiresCoverLetter

NostringCompany Description
for the Requisition
Template

Company DescriptioncompanyDescription

NostringBusiness justificationBusiness JustificationbusinessJustification

NostringfalseRequires Pre-AssessmentrequiresPreAssess~
ment

NostringDRAFTStatusstatus

Nostring30Unpublish DaysunpublishDays

NostringfalseEnd Of MonthendOfMonth

Nostring2016-08-
16T00:00:00.000+0530

Unpublish DateunpublishDate

Nostring{"type": "PIE-
CHART", "identifier":

Pie Chart Type Smart Wid~
gets

pieChartSM

"pieChartSM",
"smartWidgetValues":
[{"name": "java",
"value": "kI18nSWIn~
termediate", "parent":
{"id": "smt~
wd000000000001000",
"displayName":
"Skills"}}, {"name":
"Js", "value":
"kI18nSWExpert",
"parent": {"id": "smt~
wd000000000001000",
"displayName":
"Skills"}}],
"smartWidget_visibil~
ity": "ANYONE",
"title": "Skills"}

Nostring{"type": "BAR-
CHART", "identifier":

Bar Chart Type Smart Wid~
gets

barChartSM

"barChartSM",
"smartWidgetValues":
[{"name": "java1",
"value": "2", "parent":
{"id": "smt~
wd000000000002034",
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Required?Data TypeDefault ValueDescriptionName

"displayName": "Ex~
perience"}}, {"name":
"Advanced Java1",
"value": "1", "parent":
{"id": "smt~
wd000000000002034",
"displayName": "Ex~
perience"}}],
"smartWidget_visibil~
ity": "ANYONE",
"title": "Experience"}

Nostring1Minimum ExperienceminExperience

Nostring3Maximum ExperiencemaxExperience

Nostring[{"stakeholder": {"id":
"em~

Interviewersinterviewers

plo000000000201187",
"displayName": "cus~
tome_menu uone"},
"stakeholderType":
"INTERVIEWER"}]

Nostring[{"stakeholder": {"id":
"em~

Recruiterrecruiter

plo000000000201187",
"displayName": "cus~
tome_menu uone"},
"stakeholderType":
"RECRUITER"}]

NostringSoftwareIndustryindustry

NostringINTERNAL-ONLYPublish toapplicantType

Nostring2016-08-
16T15:20:48.000+0530

Close dateclosedDate

Nostring{"id": "em~
plo000000000001043",

HR PartnerhrPartner

"displayName":
"User3 Four3"}

Nostring{"id": "em~
plo000000000001000",

Hiring ManagerhiringManager

"displayName": "User
One"}

Nostring20000Minimum SalaryminimumSalary

Nostring50000Maximum SalarymaximumSalary
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Required?Data TypeDefault ValueDescriptionName

Nostring<p>BE</p>Qualificationsqualification

NostringYEARLYSalary TypesalaryType

NostringCoolJob Advertisement StylejobAdStyle

Nostrig2Number of HiresnoOfOpenings

NoenumeratedNEW-HIREHire TypehireType

NoenumeratedNOT-MENTIONEDEmployment ClassificationemploymentClassifica~
tion

NostringfalseIs EEOC RequiredisEEOCReq

NostringUNPUBLISH-DATEAuto-UnpublishunpublishType

NostringNot SpecifiedEEO Job Categorycategory

Nostring50000Compensation Displayed to
Candidates (Public)

compensation

Nostringcenter1Cost CentercostCenter

Nostring{"id":"crncy000000000000167",
"displayName":"US
Dollars"}

Salary CurrencysalaryCurrency

Nostring2016-08-
16T04:00:32.000+0530

Published OnpublishedOn

Nostring{"id": "job~
tp00000000200200"}

JobjobType

NostringNotesNotesnotes

NostringHPEngineer3Job Titletitle

Nostring2016-08-
15T15:00:32.000+0530

Submitted OnsubmittedOn

Nostring2016-08-
16T15:00:32.000+0530

Approved OnapprovedOn

NostringQualification detailsEducation QualificationeducationQualification

NostringtrueMark the external job post~
ing featured

isFeaturedJobExternal

Nostring{"custom9": "1", "cus~
tom0": "2", "cus~

Custom ValuescustomValues

tom3": "3", "cus~
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Required?Data TypeDefault ValueDescriptionName

tom4": "4", "cus~
tom1": "5", "cus~
tom2": "6", "cus~
tom7": "7", "cus~
tom8": "8", "cus~
tom5": "9", "cus~
tom6":"10"}

Nostring{"id": "dom~
in000000000000001",

DomainsecurityDomain

"displayName":
"world"}

Nostring[{ "associate": {"id":
"re~

Regionsregions

gio000000000000001"},
"associateType": "RE~
GION"}]

Request Body

{
   "location": {
      "id": "locat000000000001000",
      "displayName": "Location1"
   },
   "description": "<p>recruting test 01 job<\/p>",
   "organization": {
      "id": "bisut000000000001000",
      "displayName": "BusinessUnit1"
   },
   "requisitionTemplate": {
      "id": "reqtp000000000000001",
      "displayName": null
   },
   "employmentType": "Contractor",
   "requisitionStage": [
      {
         "isRequired": false,
         "assessment": {
            "id": "cninv000000000057714",
            "displayName": "Job 0129-0131-034520631472023431041"
         },
         "stageName": "Pre assessment",
         "sequence": 1,
         "type": "PRE-ASSESSMENT"
      }
   ],
   "requiresTravel": false,
   "requiresResume": false,
   "requiresCoverLetter": false,
   "companyDescription": "Company Description for the Requisition Template",
   "businessJustification": "Business justification",
   "requiresPreAssessment": false,
   "status": "DRAFT",
   "unpublishDays": 30,
   "endOfMonth": false,
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   "unpublishDate": "2016-08-16T00:00:00.000+0530",
   "pieChartSM": {
      "type": "PIE-CHART",
      "identifier": "pieChartSM",
      "smartWidgetValues": [
         {
            "name": "java",
            "value": "kI18nSWIntermediate",
            "parent": {
               "id": "smtwd000000000001000",
               "displayName": "Skills"
            }
         },
         {
            "name": "Js",
            "value": "kI18nSWExpert",
            "parent": {
               "id": "smtwd000000000001000",
               "displayName": "Skills"
            }
         }
      ],
      "smartWidget_visibility": "ANYONE",
      "title": "Skills"
   },
   "barChartSM": {
      "type": "BAR-CHART",
      "identifier": "barChartSM",
      "smartWidgetValues": [
         {
            "name": "java1",
            "value": "2",
            "parent": {
               "id": "smtwd000000000002034",
               "displayName": "Experience"
            }
         },
         {
            "name": "Advanced Java1",
            "value": "1",
            "parent": {
               "id": "smtwd000000000002034",
               "displayName": "Experience"
            }
         }
      ],
      "smartWidget_visibility": "ANYONE",
      "title": "Experience"
   },
   "minExperience": 1,
   "maxExperience": 3,
   "interviewers": [
      {
         "stakeholder": {
            "id": "emplo000000000201187",
            "displayName": "custome_menu uone"
         },
         "stakeholderType": "INTERVIEWER"
      }
   ],
   "recruiter": [
      {
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         "stakeholder": {
            "id": "emplo000000000201187",
            "displayName": "custome_menu uone"
         },
         "stakeholderType": "RECRUITER"
      }
   ],
   "industry": "Software",
   "applicantType": "INTERNAL-ONLY",
   "closedDate": "2016-08-16T15:20:48.000+0530",
   "hrPartner": {
      "id": "emplo000000000001043",
      "displayName": "User3 Four3"
   },
   "hiringManager": {
      "id": "emplo000000000001000",
      "displayName": "User One"
   },
   "minimumSalary": 20000,
   "maximumSalary": 50000,
   "qualification": "<p>BE<\/p>",
   "salaryType": "YEARLY",
   "jobAdStyle": "Cool",
   "noOfOpenings": 2,
   "hireType": "NEW-HIRE",
   "employmentClassification": "NOT-MENTIONED",
   "isEEOCReq": false,
   "unpublishType": "UNPUBLISH-DATE",
   "category": "Not Specified",
   "compensation": 50000,
   "costCenter": "center1",
   "salaryCurrency": {
      "id": "crncy000000000000167",
      "displayName": "US Dollars"
   },
   "publishedOn": "2016-08-16T04:00:32.000+0530",
   "jobType": {
      "id": "jobtp00000000200200"
   },
   "notes": "Notes",
   "title": "HPEngineer3",
   "submittedOn": "2016-08-15T15:00:32.000+0530",
   "approvedOn": "2016-08-16T15:00:32.000+0530",
   "educationQualification": "Qualification details",
   "isFeaturedJobExternal": true,
   "customValues": {
      "custom9": "1",
      "custom0": "2",
      "custom3": "3",
      "custom4": "4",
      "custom1": "5",
      "custom2": "6",
      "custom7": "7",
      "custom8": "8",
      "custom5": "9",
      "custom6": "10"
   },
   "securityDomain": {
      "id": "domin000000000000001",
      "displayName": "world"
   }
}
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Note:  For more details on this see REST API Reference.

This enhancement provides a REST API that allows retrieving as well as updating the job details that were created in
the Saba application for integration with downstream systems.

API to retrieve public/private attachments

There were no REST APIs that would allow retrieving public/private attachments.

The following new REST API will now allow retrieving public/private attachments:

FIND ALL PUBLIC/PRIVATE ATTACHMENTS

Overview

Returns all public/private attachments for a given owner ID.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/attachments?ownerId=:ownerId&isPrivate=:isPrivate

Calling Options

Table 42: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringlocat000000000200040Owner's ID of the attach~
ment

ownerId

NoenumeratedfalseFlag to get public/private at~
tachments.

"EnumeratedList": [ "true",
"false" ]

isPrivate

If a value is not provided for
this parameter, the API will
fetch all (public and private)
the attachments for the given
owner ID.

 | System | 161

https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068


Return Values

[
  "list",
  [
    {
      "@type": "com.saba.rest.dto.AttachmentDTO",
      "id": "notdc000000000224745",
      "file-name": "Penguins",
      "locale": {
        "@type": "com.saba.rest.dto.LocaleDTO",
        "name": "English",
        "id": "local000000000000001"
      },
      "createdBy": "emplo000000000001000",
      "createdId": "uone",
      "owner-id": "locat000000000200040",
      "mime-type": "image/jpeg",
      "attachment-name": "Publicattachment",
      "fileExtension": ".jpg",
      "url": "http://<hostname>/Saba/Web/Main?ssp=pageIsIgnored
            &doIt=showAttachment&showbinary=true&attachId
            =.-.CB7D9D9C6E847507EE9693C641297AD88E23482C4B65A40527E479
            56338840ED-.-&mimeType=image/jpeg&deepLinkCertificate=3135363
            6386337653832345E235E756F6E655E235E53616261536974655E235E656E
            5F55535E235E536162615E235E24414240302C02146974AD81F8144FBEDD9
            905420AE3DD07BB2FECBE02145670EEA450861BB6C9AE67AB3FB6C56E9B4A163B

            &isAttachment=true",
      "category": "Map",
      "is-url": false,
      "audit-reason": null,
      "is-private": false
    }
  ]
]

Note:  For more details on this see REST API Reference.

This enhancement provides a REST API that allows retrieving attachments from the job object that can be shown on
the Profile page and under Career Planning.

APIs to retrieve social interactions of a user

There were no REST APIs that would allow retrieving social interactions of a user.

The following new REST APIs will now allow retrieving social interactions of a user:

1. GET SOCIAL INTERACTIONS OF A USER
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GET SOCIAL INTERACTIONS OF A USER

Overview

Retrieves the social interactions such as clicks, likes, comments and shares of a user.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/social/metrics/:personId?resource=(:resources)&from_date=:from_date&to_date=:to_date

URL (using lookup)

https://<hostname-api.sabacloud.com>/v1/social/metrics/username=<username>?resource=(:resources)&from_date=:from_date&to_date=:to_date

Calling Options

Table 43: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringID of the userpersonId

YesstringList of resources:resources

• idea
• file
• url
• blog
• contributions
• discussions
• feedback
• workspace
• connections
• views
• videos

YesstringFrom datefrom_date

Note: The supported
date format: YYYY-
MM-DD.

YesstringTo dateto_date

Note: The supported
date format: YYYY-
MM-DD.
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Detail of metrics fields for each resource type in output
The following are the fields for each resource type in output:

1. Connections

a. Total followers
b. Total followed
c. Grand total of followers (regardless of date range)
d. Grand total of followed (regardless of date range)

2. Contributions

a. Total ideas contributed
b. Total bookmarks contributed
c. Total discussion initiated
d. Total file contributed
e. Total url contributed
f. Total blog contributed
g. Total video contributed

3. Discussions

a. Total votes for discussion
b. Total number of replies on discussion
c. Total number of tags on discussion

4. Ideas

a. Total number of tags on ideas
b. Total number of Votes for idea

Note:  If a user gives two positive votes and two negative votes, then this value appears as 0. It is also 0, if
the user does not have any votes.

c. Total number of Views for idea
d. Total number of comments for idea

5. File

a. Number of tags on file
b. Count of Ratings for File
c. Total comments for File

6. URL

a. Number of tags on URL
b. Count of Ratings for URL
c. Total comments for URL

7. Blogs

a. Number of tags on Blogs
b. Number of Ratings for Blog
c. Total comments for Blog

8. Video

a. Number of Tags on Video
b. Count of Ratings for Video
c. Total comments for Video
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9. Workspace

a. Number of Tags on Workspaces
b. Count of Ratings for Workspaces

10. Feedback

a. Positive votes by person
b. Negative votes by person

11. Views

a. Number of Views by person for videos, page and blogpost.

Return Values

{  
   "followers":10,
   "followed":5,
   "total_followers":20,
   "total_followed":15,
   "total_ideas_contributed":2,
   "total_bookmarks_contributed":5,
   "total_discussion_initiated":2,
   "total_files_contributed":2,
   "total_urls_contributed":2,
   "total_blogs_contributed":3,
   "total_videos_contributed":5,
   "total_issues_contributed":7,
   "total_votes_for_discussion":7,
   "total_replies_on_discussion":9,
   "count_tags_on_discussion":5,
   "total_votes_for_idea":5,
   "total_comment_for_idea":4,
   "total_tags_for_idea":8,
   "total_views_on_idea":10,
   "number_of_tags_on_file":0,
   "count_of_ratings_for_file":0,
   "file_comment_count":0,
   "number_of_tags_on_url":0,
   "count_of_ratings_for_url":0,
   "url_comment_count":0,
   "number_of_tags_on_blogs":0,
   "count_of_blog_ratings":0,
   "blog_count_of_comments":0,
   "number_of_tags_on_videos":0,
   "count_of_video_ratings":0,
   "video_count_of_comments":0,
   "count_tags_on_workspaces":0,
   "count_of_workspace_ratings":0,
   "count_positivevotes_by_psn":30,
   "count_negativevotes_by_psn":10,
   "total_views":25
}

Note:  For more details on this see REST API Reference.

Customers can now measure how closely their learners are interacting with Saba Cloud and possibly give them badges
and other rewards.
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APIs to retrieve, create and manage resources on the Saba Activity Stream

There were no REST APIs that would allow retrieving, creating and managing the resources on the Saba Activity Stream.

The following new REST APIs will now allow retrieving, creating and managing the resources on the Saba Activity
Stream:

1. POST IDEA TO SABA ACTIVITY STREAM
2. POST ISSUE TO SABA ACTIVITY STREAM
3. POST LINK TO SABA ACTIVITY STREAM
4. POST FILE TO SABA ACTIVITY STREAM
5. UPDATE IDEA POSTED ON SABA ACTIVITY STREAM
6. UPDATE ISSUE POSTED ON SABA ACTIVITY STREAM
7. UPDATE LINK POSTED ON SABA ACTIVITY STREAM
8. UPDATE FILE POSTED ON SABA ACTIVITY STREAM
9. DELETE IDEA POSTED ON SABA ACTIVITY STREAM
10. DELETE ISSUE POSTED ON SABA ACTIVITY STREAM
11. DELETE LINK POSTED ON SABA ACTIVITY STREAM
12. DELETE FILE POSTED ON SABA ACTIVITY STREAM

POST IDEA TO SABA ACTIVITY STREAM

Overview

Posts an idea to the Saba Activity Stream.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/social/resource

Calling Options

Table 44: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringIdea titlename

NostringOwner of the Idea.owner

YesstringDescription of the Idea.description
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Required?Data TypeDefault ValueDescriptionName

NoBooleanfalseDisable users to share this
idea.

disableSharing

NostringList of entity with whom
idea is to be shared. It could
be person and/or group.

shareWith

NostringLanguage of the idea.language

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringTags on the idea.tag

YesstringresourceType is mandatory
for idea, issue and link re~

resourceType

source. This is not required
for file.

Request Body

{
 "resourceType": "idea”,
 "name":"Idea_test_07_29_005",
 "description":"Idea_test_07_29_005",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "disableSharing":true,
 "shareWith":[   
   {  
    "id":"persn000000000001000",
    "displayName":"CSINDHAV1",
    "type":"person",
    "role":"viewer"
   }
 ],
 "notify":"people",
 "tag":[  
   "mytag3",
   "mytag4"
 ]
}

Return Values

{
  "id": "idear000000000001170",
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  "displayName": "Idea_test_08_01_010"
}

POST ISSUE TO SABA ACTIVITY STREAM

Overview

Posts an issue to the Saba Activity Stream.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/social/resource

Calling Options

Table 45: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringIssue titlename

NostringOwner of the Issue.owner

YesstringDescription of the Issue.description

NoBooleanfalseDisable users to share this
issue.

disableSharing

NostringList of entity with whom is~
sue is to be shared. It could
be person and/or group.

shareWith

NostringLanguage of the issue.language

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringTags on the issue.tag

YesstringresourceType is mandatory
for idea, issue and link re~

resourceType

source. This is not required
for file.
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Request Body

{  
 "resourceType": "issue”,
 "name":"Issue_test_07_29_005",
 "description":"Issue_test_07_29_005",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "disableSharing":true,
 "shareWith":[   
   {  
    "id":"persn000000000001000",
    "displayName":"CSINDHAV1",
    "type":"person",
    "role":"viewer"
   }
 ],
 "notify":"people",
 "tag":[  
   "mytag3",
   "mytag4"
 ]
}

Return Values

{
  "id": "issue000000000001044",
  "displayName": "Issue_test_07_29_005"
}

POST LINK TO SABA ACTIVITY STREAM

Overview

Posts a link to the Saba Activity Stream.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/social/resource
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Calling Options

Table 46: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringLink titlename

YesstringURL of the link.url

NostringOwner of the link.owner

YesstringDescription of the Link.description

NoBooleanfalseDisable users to share this
link.

disableSharing

NostringLanguage of the link.language

NostringList of entity with whom
link is to be shared. It could
be person and/or group.

shareWith

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringTags on the link.tag

YesstringresourceType is mandatory
for idea, issue and link re~

resourceType

source. This is not required
for file.

Request Body

{  
 "resourceType": "link”,
 "name":"link_test_07_29_005",
 "description":"link_test_07_29_005",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "disableSharing":true,
 "shareWith":[   
   {  
    "id":"persn000000000001000",
    "displayName":"CSINDHAV1",
    "type":"person",
    "role":"viewer"
   }
 ],
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 "notify":"people",
 "tag":[  
   "mytag3",
   "mytag4"
 ]
}

Return Values

{
  "id": "simrs000000000001042",
  "displayName": "link_test_07_29_005"
}

POST FILE TO SABA ACTIVITY STREAM

Posts a file to the Saba Activity Stream.

Note:  For the file resource, the file must be added as form data of type file. Only one file as attachment will be
accepted. In case more than one file is passed in the input then only the first file will be considered, remaining files
will be ignored.

Text details for the file should not have any new line character or any special character in between two different
attributes.

Though there is no limit set for the size of the file that you post, a file exceeding 3 MB may get timed out.

Requires OAuth

No

Content Type

Consumes: Multipart-form-data, Produces: application/json

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/social/file

Calling Options

Table 47: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringLink titlename

NostringOwner of the file.owner

YesstringDescription of the file.description

NoBooleanfalseDisable users to share this
file.

disableSharing
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Required?Data TypeDefault ValueDescriptionName

NostringList of entity with whom file
is to be shared. It could be
person and/or group.

shareWith

NostringLanguage of the file.language

NostringWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringTags on the file.tag

Request Body

{  
 "name":"file_test_07_29_005",
 "description":"file_test_07_29_005",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "disableSharing":true,
 "shareWith":[   
   {  
    "id":"persn000000000001000",
    "displayName":"CSINDHAV1",
    "type":"person",
    "role":"viewer"
   }
 ],
 "notify":"people",
 "tag":[  
   "mytag3",
   "mytag4"
 ]
}

Return Values

{
  "id": "simrs000000000001042",
  "displayName": "link_test_07_29_005"
}

UPDATE IDEA POSTED ON SABA ACTIVITY STREAM

Overview

Updates an issue posted on the Saba Activity Stream.
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Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 48: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringIdea titlename

NostringOwner of the Idea.owner

NostringDescription of the Idea.description

NostringImplementation Leader of
the Idea.

implementationLead

NoenumeratedNewState of idea.

Possible status:

state

Descrip~
tion

ValueState

New1New

Being
Re~
viewed

101Open

Re~
viewed

102

Accep~
ted

103

In Pro~
gress

104

Par~
tially

105

Imple~
mented

On
Hold

201Onhold
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Required?Data TypeDefault ValueDescriptionName

Fully
Imple~
mented

301closed

Closed302

Rejec~
ted

303

Noenumerated1Status of idea. Though its
validity depends on the
status selected for the idea.

status

NoBooleanfalseDisable users to share this
idea.

disableSharing

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringLanguage of the idea.language

YesstringresourceId is the ID of idea
id

resourceId

Request Body

{  
 "name":"Idea_test_08_01_010",
 "description":"Idea_test_08_01_010 updated4",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "shareWith":[  
  {  
   "id":"",
   "displayName":"cone",
   "type":"person",
   "role":"co-owner"
  }
 ],
 "state":"open",
 "status":"201",
 "implementationLead":{  
  "id":"persn000000000001005",
  "displayName":"csindhav6"
 },
 "disableSharing":false,
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 "notify":"people"
}

UPDATE ISSUE POSTED ON SABA ACTIVITY STREAM

Overview

Updates an issue posted on Saba Activity Stream.

Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 49: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringIssue titlename

NostringOwner of the Issue.owner

NostringDescription of the Issue.description

NostringImplementation Leader of
the Issue.

implementationLead

NoenumeratedNewState of issue.

Possible status:

state

Descrip~
tion

ValueState

New1New

Being
Re~
viewed

101Open

Re~
viewed

102

Accep~
ted

103
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Required?Data TypeDefault ValueDescriptionName

In Pro~
gress

104

Par~
tially

105

Imple~
mented

On
Hold

201Onhold

Fully
Imple~
mented

301closed

Closed302

Rejec~
ted

303

Noenumerated1Status of issue. Though its
validity depends on the

status

status selected for the issue
.

NoBooleanfalseDisable users to share this
issue.

disableSharing

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringLanguage of the issue.language

YesstringresourceId is the ID of issue
id

resourceId

Request Body

{  
 "name":"Issue_test_08_01_010",
 "description":"Issue_test_08_01_010 updated4",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "shareWith":[  
  {  
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   "id":"",
   "displayName":"cone",
   "type":"person",
   "role":"co-owner"
  }
 ],
 "state":"open",
 "status":"201",
 "implementationLead":{  
  "id":"persn000000000001005",
  "displayName":"csindhav6"
 },
 "disableSharing":false,
 "notify":"people"
}

UPDATE LINK POSTED ON SABA ACTIVITY STREAM

Overview

Updates a link posted on the Saba Activity Stream.

Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 50: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringLink titlename

NostringURL of the link.url

NostringOwner of the link.owner

NostringDescription of the link.description

NostringList of entity with whom
link is to be shared. It could
be person and/or group.

shareWith

NoBooleanfalseDisable users to share this
link.

disableSharing
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Required?Data TypeDefault ValueDescriptionName

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringLanguage of the link.language

NostringTags on the link.tag

YesstringresourceId is the ID of link
id

resourceId

Request Body

{  
 "name":"link_test_08_01_010",
 "description":"link_test_08_01_010 updated4",
 "url":"https://dqlearning.sabacloud.com",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
  "displayName":"English"
 },
 "shareWith":[  
  {  
   "id":"",
   "displayName":"cone",
   "type":"person",
   "role":"co-owner"
  }
 ],
 "disableSharing":false,
 "notify":"people",                                                          

                                      "tag":[  
   "mytag3",
   "mytag4"
 ]
}

UPDATE FILE POSTED ON SABA ACTIVITY STREAM

Overview

Updates a file posted on the Saba Activity Stream.

Note:  For the file resource, the file must be added as form data of type file. Only one file as attachment will be
accepted. In case more than one file is passed in the input then only the first file will be considered, remaining files
will be ignored.

Text details for the file should not have any new line character or any special character in between two different
attributes.

Though there is no limit set for the size of the file that you post, a file exceeding 3 MB may get timed out.

 | System | 178



Requires OAuth

No

Content Type

Consumes: Multipart-form-data, Produces: application/json

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/social/file/:fileId

Calling Options

Table 51: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringFile IdfileId

NostringFile titlename

NostringOwner of the file.owner

NostringDescription of the file.description

NostringList of entity with whom file
is to be shared. It could be
person and/or group.

shareWith

NoBooleanfalseDisable users to share this
file.

disableSharing

NoenumeratedWhom to notify, it's value
could be person, group or
peopleandgroup.

notify

NostringLanguage of the file.language

NostringTags on the file.tag

Request Body

{  
 "name":"file_test_08_01_010",
 "description":"file_test_08_01_010 updated4",
 "owner":{  
  "id":"emplo000000000001000",
  "displayName":"Uone"
 },
 "language":{  
  "id":"lange000000000000001",
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  "displayName":"English"
 },
 "shareWith":[  
  {  
   "id":"",
   "displayName":"cone",
   "type":"person",
   "role":"co-owner"
  }
 ],
 "disableSharing":false,
 "notify":"people",                                                          
                                            "tag":[  
   "mytag3",
   "mytag4"
 ]
}

DELETE IDEA POSTED ON SABA ACTIVITY STREAM

Overview

Deletes an issue posted on the Saba Activity Stream.

Requires OAuth

No

Method

DELETE

URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 52: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringidear000000000001107resourceId is the ID of the
idea

resourceId

DELETE ISSUE POSTED ON SABA ACTIVITY STREAM

Overview

Deletes an issue posted on Saba Activity Stream.

Requires OAuth

No

Method

DELETE
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URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 53: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringis~
sue000000000001046

resourceId is the ID of the
issue

resourceId

DELETE LINK POSTED ON SABA ACTIVITY STREAM

Overview

Deletes a link posted on the Saba Activity Stream.

Requires OAuth

No

Method

DELETE

URL

https://<hostname-api.sabacloud.com>/v1/social/resource/:resourceId

Calling Options

Table 54: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringresourceId is the ID of the
link

resourceId

DELETE FILE POSTED ON SABA ACTIVITY STREAM

Overview

Deletes a file posted on the Saba Activity Stream.

Requires OAuth

No

Method

DELETE

URL

https://<hostname-api.sabacloud.com>/v1/social/file/:fileId
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Calling Options

Table 55: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringFile IdfileId

Note:  For more details on this see REST API Reference.

This enhancement provides a REST API that allows creating and managing the resources that were created in the Saba
application.

APIs to create, update and delete Smartlists

There were no REST APIs that would allow creating, updating and deleting Smartlists.

The following new REST APIs will now allow creating, updating and deleting Smartlists:

1. CREATE A NEW SMARTLIST
2. UPDATE DETAILS OF A SMARTLIST
3. DELETE A SMARTLIST

Note:  Only users with the People admin privilege will be able to create, update or delete Smarlists using these
APIs.

CREATE A NEW SMARTLIST

Overview

Allows creating a new smart list.

Method

POST

Requires OAuth

No

URL

https://<hostname-api.sabacloud.com>/v1/smartlists
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Calling Options

Table 56: Calling Options

Required?Data TypeSample ValueDescriptionName

YesstringTest SmartlistThe name of the Smartlistname

NostringThe short description about
the Smartlist

description

Yesstring
{
"id": "dom~

The domain for the Smartlist

Supports lookup (Domain).

split

in000000000000001",
"name": 
"world"
}

NostringCriteria of Smartlistcriteria

Request Body

{
 "name": "test SL",
 "description": "Test smartlist creation using API",
 "split": {
  "id": "domin000000000000001",
  “displayName”:”world”
 },
 "criteria": {
  "segments": [{
   "entity": "Group 1",
   "segments": [{
    "excluded": false,
    "key": "language",
    "operator": {
     "key": "in"
    },
    "value": ["lange000000000000001"]
   }, {
    "key": "OR"
   }, {
    "excluded": false,
    "key": "curricula_id",
    "operator": {
     "key": "in"
    },
    "value": ["curra000000000001141"]
   }]
  }, {
   "key": "AND"
  }, {
   "entity": "Group 2",
   "segments": [{
    "excluded": false,
    "key": "Location_custom2",
    "operator": {
     "key": "eq"
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    },
    "value": "test"
   }]
  }]
 }
}

UI representation of the Request Body

Figure 26: UI representation of the Request Body

Supported Operator Key

The following table lists the operator keys that this API supports.

Description (UI Label)Key

ANDAND

OROR

NOTNOT

MATCHESeq

NOT_MATCHESneq

ALL_OFall

ANY_OFin
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Description (UI Label)Key

NOT_ANY_OFnin

BEFOREbef

ON_OR_BEFOREonbefore

AFTERaft

ON_OR_AFTERonafter

LESS_THANlt

LESS_THAN_EQUALSlte

GREATER_THANgt

GREATER_THAN_EQUALSgte

WITHIN_NEXTbetnext

WITHIN_LASTbetlast

STARTS_WITHstartswith

BEFORE_DAYSbefdays

AFTER_DAYSaftdays

Supported Segment Key

The following table lists the segment keys that this API supports.

Description (UI Label)KeyComponent

Personper_idProfile                                        

Domainperson_domain_id

Managerperson_manager_id

Start Dateperson_start_date

Statusprsn_status

Genderprsn_gender

Date of Birthprsn_dob

Ethnicityprsn_ethnicity

Religionprsn_religion

 | System | 185



Description (UI Label)KeyComponent

PQ Scoreprsn_pq

Percent Profile Completedprsn_prof_compl

Alternate Managerprsn_alt_mgr

Employee Typeperson_emp_type

Localeperson_locale

Person Typeperson_type

Manager Accessperson_mgr

Cityper_city

Stateper_state

Countryper_country

Zip / Postal codeper_zip_code

Custom 0
Person, Internal_custom0

LanguagelanguageLanguage

Nameext_cert_nameExternal Certification      

Accrediting Institutionext_cert_inst

Acquired on Dateext_cert_acqon

Expired on Dateext_cert_expon

Certificationint_cert_idInternal Certification

Current Jobtypejob_current_idJob / Career                

Next Jobtypejob_desired_id

Job Familyjob_family_id

Potential Jobjob_potential_id

Internal Work Historyint_wrkhis_job_id

Previous Internal Organizationint_wrkhis_org_id

Previous work locationint_wrkhis_loc
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Description (UI Label)KeyComponent

External work historyext_wrkhis_employer

Custom 0
JobType_custom0

Custom 0
Role_custom0

Role  

RoleJob_role_id

Skillskill_idSkill / Experties  

Custom 0
Competency_custom0

Potential ratingpot_ratingPerformance    

Retirement Riskret_risk

Flight Riskflt_risk

Organizationorg_idOrganization        

Zip / Postal Codeorg_zip_code

Internal Organization Numberorg_number

Organization Typeorg_type

Custom 0
Organization, Internal_cus~
tom0

Courseinp_cours_idInprogress learning

Audience Typeaud_typGroup / Audience  

Custom 0
Audience Type_custom0

DegreedegreeEducation          

Majormajor

Institutionedu_institute

Institute Typeedu_institute_type
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Description (UI Label)KeyComponent

Completion Dateedu_comp_date

Percent Completededu_pc_completion

Curriculamcurricula_idCurriculam

Coursecmpl_cours_idCompeted Learning  

Custom 0
Offering Action Pro~
file_custom0

Locationlocation_idAddress / Location    

Will Relocaterelocate

Custom 0
Location_custom0

Custom 0CustomSection1_custom0  CustomSection1 to CustomSection20

Candidate Statustp_candidate_statusTalentPool            

Candidate Readinessreadiness_id

Pool Ownerpool_owner

Pool Domainpool_domain

Candidate percent matchpercent_match

Candidate Rankcandidate_rank

Pool Nametalent_pool_name

Return Values

{
 "id": "stlst000000000001410",
 "displayName": "test SL 7",
    "href": 
"https://<hostname-api.sabacloud.com>/v1/smartlists/stlst000000000001080"
}

UPDATE DETAILS OF A SMARTLIST

Overview

Allows updating an existing smartlist based on the Smartlist ID.
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Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/smartlists/:id

Table 57: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringstlst000000000001000Smartlist's IDid

NostringTest SmartlistThe name of the Smartlistname

NostringThe short description about
the Smartlist

description

Yesstring
{
"id": "dom~

The domain for the Smartlist

Supports lookup (Domain).

split

in000000000000001",
"name": 
"world"
}

NostringCriteria of Smartlistcriteria

Request Body

{
 "name": "test SL",
 "description": "Test smartlist creation using API",
 "split": {
  "id": "domin000000000000001",
  “displayName”:”world”
 },
 "criteria": {
  "segments": [{
   "entity": "Group 1",
   "segments": [{
    "excluded": false,
    "key": "language",
    "operator": {
     "key": "in"
    },
    "value": ["lange000000000000001"]
   }, {
    "key": "OR"
   }, {
    "excluded": false,
    "key": "curricula_id",
    "operator": {
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     "key": "in"
    },
    "value": ["curra000000000001141"]
   }]
  }, {
   "key": "AND"
  }, {
   "entity": "Group 2",
   "segments": [{
    "excluded": false,
    "key": "Location_custom2",
    "operator": {
     "key": "eq"
    },
    "value": "test"
   }]
  }]
 }
}

UI representation of the Request Body

Figure 27: UI representation of the Request Body

Supported Operator Key

The following table lists the operator keys that this API supports.

Description (UI Label)Key

ANDAND
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Description (UI Label)Key

OROR

NOTNOT

MATCHESeq

NOT_MATCHESneq

ALL_OFall

ANY_OFin

NOT_ANY_OFnin

BEFOREbef

ON_OR_BEFOREonbefore

AFTERaft

ON_OR_AFTERonafter

LESS_THANlt

LESS_THAN_EQUALSlte

GREATER_THANgt

GREATER_THAN_EQUALSgte

WITHIN_NEXTbetnext

WITHIN_LASTbetlast

STARTS_WITHstartswith

BEFORE_DAYSbefdays

AFTER_DAYSaftdays

Supported Segment Key

The following table lists the segment keys that this API supports.

Description (UI Label)KeyComponent

Personper_idProfile                                        

Domainperson_domain_id

Managerperson_manager_id
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Description (UI Label)KeyComponent

Start Dateperson_start_date

Statusprsn_status

Genderprsn_gender

Date of Birthprsn_dob

Ethnicityprsn_ethnicity

Religionprsn_religion

PQ Scoreprsn_pq

Percent Profile Completedprsn_prof_compl

Alternate Managerprsn_alt_mgr

Employee Typeperson_emp_type

Localeperson_locale

Person Typeperson_type

Manager Accessperson_mgr

Cityper_city

Stateper_state

Countryper_country

Zip / Postal codeper_zip_code

Custom 0
Person, Internal_custom0

LanguagelanguageLanguage

Nameext_cert_nameExternal Certification      

Accrediting Institutionext_cert_inst

Acquired on Dateext_cert_acqon

Expired on Dateext_cert_expon

Certificationint_cert_idInternal Certification

Current Jobtypejob_current_idJob / Career                
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Description (UI Label)KeyComponent

Next Jobtypejob_desired_id

Job Familyjob_family_id

Potential Jobjob_potential_id

Internal Work Historyint_wrkhis_job_id

Previous Internal Organizationint_wrkhis_org_id

Previous work locationint_wrkhis_loc

External work historyext_wrkhis_employer

Custom 0
JobType_custom0

Custom 0
Role_custom0

Role  

RoleJob_role_id

Skillskill_idSkill / Experties  

Custom 0
Competency_custom0

Potential ratingpot_ratingPerformance    

Retirement Riskret_risk

Flight Riskflt_risk

Organizationorg_idOrganization        

Zip / Postal Codeorg_zip_code

Internal Organization Numberorg_number

Organization Typeorg_type

Custom 0
Organization, Internal_cus~
tom0

Courseinp_cours_idInprogress learning

Audience Typeaud_typGroup / Audience  

 | System | 193



Description (UI Label)KeyComponent

Custom 0
Audience Type_custom0

DegreedegreeEducation          

Majormajor

Institutionedu_institute

Institute Typeedu_institute_type

Completion Dateedu_comp_date

Percent Completededu_pc_completion

Curriculamcurricula_idCurriculam

Coursecmpl_cours_idCompeted Learning  

Custom 0
Offering Action Pro~
file_custom0

Locationlocation_idAddress / Location    

Will Relocaterelocate

Custom 0
Location_custom0

Custom 0CustomSection1_custom0  CustomSection1 to CustomSection20

Candidate Statustp_candidate_statusTalentPool            

Candidate Readinessreadiness_id

Pool Ownerpool_owner

Pool Domainpool_domain

Candidate percent matchpercent_match

Candidate Rankcandidate_rank

Pool Nametalent_pool_name
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Return Values

{
 "id": "stlst000000000001410",
 "displayName": "test SL 7",
    "href": 
"https://<hostname-api.sabacloud.com>/v1/smartlists/stlst000000000001080"
}

DELETE A SMARTLIST

Overview

Allows deleting an existing smartlist that is not associated to other objects based on the Smartlist ID.

Requires OAuth

No

Method

DELETE

URL

https://<hostname-api.sabacloud.com>/v1/smartlists/:id

Table 58: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringstlst000000000001000Smartlist's IDid

Note:  For more details on this see REST API Reference.

Criteria based security roles could be assigned using APIs, but only if you had manually created the smart list. This API
removes the manual step.

APIs to create, update and find Sub audience types

There were no REST APIs that would allow creating, updating and finding sub audience types.

The following new REST APIs will now allow creating, updating and finding sub audience types:

1. FIND DETAILS OF SUB AUDIENCE TYPES
2. FIND META DETAILS OF SUB AUDIENCE TYPES
3. GET ALL SUB AUDIENCE TYPES
4. GET DETAILS OF A PARTICULAR SUB AUDIENCE TYPE
5. CREATE A NEW SUB AUDIENCE TYPE
6. FIND THE DETAILS OF SUB AUDIENCE TYPE (USING POST - RANGE BASED SEARCH)
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7. UPDATE DETAILS OF A SUB AUDIENCE TYPE

FIND DETAILS OF SUB AUDIENCE TYPES

Overview

Returns the details of the Sub Audience Types based on the provided search criteria.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype?q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage

Calling Options

Table 59: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringnameThe search criteria i.e. the
field name.

criteria_field

YesstringabcThe search value for the
specified search criteria.

field_value

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
 "startIndex": 1,
 "totalResults": 1,
 "hasMoreResults": false,
 "itemsPerPage": 10,
 "facets": [],
 "results": [{
  "id": "seatc000000000001020","name":"child AT 1",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001020"

 }]
}
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FIND META DETAILS OF SUB AUDIENCE TYPES

Overview

Returns the meta details of the sub audience type.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype/meta:(:searchFields)

Calling Options

Table 60: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringIndicate what additional de~
tails needs to be returned.

searchFields

Acceptable values are (case-
sensitive)

Return Values

{
 "sampleData": {
  "parent_id": null,
  "flags": "0100000000",
  "name": "",
  "description": "",
  "customValues": {
   "custom9": null,
   "custom0": null,
   "custom3": null,
   "custom4": null,
   "custom1": null,
   "custom2": null,
   "custom7": null,
   "custom8": null,
   "custom5": null,
   "custom6": null
  },
  "securityDomain": {
   "id": "domin000000000000001",
   "displayName": null
  },
  "id": null,
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000000001"

 },
 "name": "Audience Sub Type",
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 "displayName": "Audience Sub Type",
 "attributes": [{
  "name": "created_by",
  "displayName": "created_by",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "created_on",
  "displayName": "created_on",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "date",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "isSearchFilter": true
 }, {
  "name": "description",
  "displayName": "Description",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "flags",
  "displayName": "Flags",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 10,
  "maximumLength": 10,
  "isSearchFilter": false
 }, {
  "name": "id",
  "displayName": "id",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "isSearchFilter": false
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 }, {
  "name": "isretained",
  "displayName": "Available to Others",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "boolean",
  "isReference": false,
  "isProtected": false,
  "display": false,
  "isSearchFilter": false
 }, {
  "name": "name",
  "displayName": "Name",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 80,
  "maximumLength": 80,
  "isSearchFilter": true
 }, {
  "name": "owner",
  "displayName": "Owner",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": false,
  "isSearchFilter": false
 }, {
  "name": "parent_id",
  "displayName": "Parent",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "object",
  "isReference": true,
  "isProtected": false,
  "display": true,
  "isSearchFilter": true
 }, {
  "name": "securityDomain",
  "displayName": "Domain",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "isSearchFilter": false
 }, {
  "name": "updated_by",
  "displayName": "updated_by",
  "description": null,
  "isRequired": false,
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  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "updated_on",
  "displayName": "updated_on",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "date",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "isSearchFilter": true
 }, {
  "name": "custom0",
  "displayName": "Custom0",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom1",
  "displayName": "Custom1",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom2",
  "displayName": "Custom2",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom3",
  "displayName": "Custom3",
  "description": null,
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  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom4",
  "displayName": "Custom4",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom5",
  "displayName": "Custom5",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom6",
  "displayName": "Custom6",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom7",
  "displayName": "Custom7",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
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  "name": "custom8",
  "displayName": "Custom8",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }, {
  "name": "custom9",
  "displayName": "Custom9",
  "description": null,
  "isRequired": false,
  "isAutoGenerated": false,
  "type": "string",
  "isReference": false,
  "isProtected": false,
  "display": true,
  "length": 255,
  "maximumLength": 255,
  "isSearchFilter": true
 }]
}

GET ALL SUB AUDIENCE TYPES

Overview

Returns all Sub Audience Types for which the user has access.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype?count=:count&startPage=:startPage

Calling Options

Table 61: Calling Options

Required?Data TypeDefault ValueDescriptionName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage
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Return Values

{
 "facets": [],
 "results": [{
  "name": "aud_11",
  "id": "seatc000000000001020",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001020"

 }, {
  "name": "child AT 1",
  "id": "seatc000000000001100",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001100"

 }, {
  "name": "child AT 12",
  "id": "seatc000000000001120",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001120"

 }, {
  "name": "child AT 2",
  "id": "seatc000000000001101",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001101"

 }, {
  "name": "child AT 21",
  "id": "seatc000000000001124",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001124"

 }, {
  "name": "Child AT21",
  "id": "seatc000000000001121",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001121"

 }, {
  "name": "Child AT211",
  "id": "seatc000000000001122",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001122"

 }, {
  "name": "Child AT212",
  "id": "seatc000000000001123",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001123"

 }, {
  "name": "child AT 22",
  "id": "seatc000000000001125",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001125"

 }, {
  "name": "child AT 221",
  "id": "seatc000000000001126",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001126"
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 }],
 "totalResults": 29,
 "hasMoreResults": true,
 "itemsPerPage": 10,
 "startIndex": 1
}

GET DETAILS OF A PARTICULAR SUB AUDIENCE TYPE

Overview

Returns complete information about a sub audience type based on the sub audience type's ID that is passed as a parameter
value.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype/:id:(:searchFields)

Calling Options

Table 62: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringSub audience type's IDid

NostringIndicate what additional de~
tails needs to be returned.

searchFields

Acceptable values are (case-
sensitive)

Return Values

{
 "parent_id": {
  "id": "audie000000000001021",
  "displayName": "aud_1"
 },
 "flags": "00000     ",
 "name": "aud_11",
 "description": "",
 "customValues": {
  "custom9": null,
  "custom0": null,
  "custom3": null,
  "custom4": null,
  "custom1": null,
  "custom2": null,
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  "custom7": null,
  "custom8": null,
  "custom5": null,
  "custom6": null
 },
 "securityDomain": {
  "id": "domin000000000000001",
  "displayName": "world"
 },
 "id": "seatc000000000001020"
}

CREATE A NEW SUB AUDIENCE TYPE

Overview

Allows creating a new sub audience type.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype

Calling Options

Table 63: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringsub audience type
Create

The name of the sub audi~
ence type

name

NostringdescThe short description about
the sub audience type

description

Yesstring{"id":
"audie000000000001021",
"name": "AT1"}

Parent of sub audience typeparent_id

NostringCustom ValuescustomValues

Request Body

{
 "name": "sbu aud_1",
 "description": "test sub AT",
  "parent_id": {
  "id": "audie000000000001021",
  "displayName": "aud_1"
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 },
 "customValues": {
  "custom9": null,
  "custom0": null,
  "custom3": null,
  "custom4": null,
  "custom1": null,
  "custom2": null,
  "custom7": null,
  "custom8": null,
  "custom5": null,
  "custom6": null
 }
}

Return Values

{
  "id": "seatc000000000001000",
  "displayName": "sub aud_1",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001000"

 }

FIND THE DETAILS OF SUB AUDIENCE TYPE (USING POST - RANGE BASED SEARCH)

Overview

Returns the details of the sub audience type.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype/searchQuery?count=:count&startPage=:startPage

Calling Options

Table 64: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstring[{"name":"name",
"operator":"==",
"value":"sub at1"}]

Conditionsconditions

Nostring10count

Nostring1startPage
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Request Body

{
"conditions" :[{
"name": "name",
"operator": "==",
"value": "aud_11"}]
}

Return Values

{
 "startIndex": 1,
 "totalResults": 1,
 "hasMoreResults": false,
 "itemsPerPage": 10,
 "facets": [],
 "results": [{
  "id": "seatc000000000001020","name":"aud_11",
  "href": 
"https://<hostname-api.sabacloud.com>/v1/subaudiencetype/seatc000000000001020"

 }]
}

UPDATE DETAILS OF A SUB AUDIENCE TYPE

Overview

Allows updating an existing sub audience type based on the Sub audience type's ID.

Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/subaudiencetype/:id

Calling Options

Table 65: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringSub audience type's IDid

Yesstringsub audience type
Create

The name of the sub audi~
ence type

name

NostringdescThe short description about
the sub audience type

description
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Required?Data TypeDefault ValueDescriptionName

NostringCustom ValuescustomValues

Request Body

{
 "id": "seatc000000000001000",
 "name": "sbu aud_1",
 "description": "test sub AT",
   "customValues": {
  "custom9": null,
  "custom0": null,
  "custom3": null,
  "custom4": null,
  "custom1": null,
  "custom2": null,
  "custom7": null,
  "custom8": null,
  "custom5": null,
  "custom6": null
 }
}

Note:  parent_id update is not supported. In case a different parent_id is passed in input then that will be ignored
by the API.

Domain cannot be set for Audience subtype. It is always the same as the parent's domain.

Note:  For more details on this see REST API Reference.

N/A

APIs to retrieve, create, update and delete countries and states

There were no REST APIs that would allow retrieving, creating, updating and deleting countries and states.

The following new REST APIs will now allow retrieving, creating, updating and deleting countries and states:

1. FIND DETAILS OF COUNTRY
2. GET ALL COUNTRIES
3. GET DETAILS OF A PARTICULAR COUNTRY
4. GET META DETAILS OF COUNTRY
5. CREATE A NEW COUNTRY
6. UPDATE DETAILS OF A COUNTRY
7. DELETE COUNTRY
8. FIND DETAILS OF STATE
9. GET ALL STATES
10. GET DETAILS OF A PARTICULAR STATE
11. GET META DETAILS OF STATE
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12. CREATE A NEW STATE
13. UPDATE DETAILS OF A STATE
14. DELETE STATE

FIND DETAILS OF COUNTRY

Overview

Returns the details of the Country along with the ID, Name and the Deeplink URL based on the provided search criteria.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/country?q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage

Calling Options

Table 66: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringnameThe search criteria i.e. the
field name.

criteria_field

YesstringabcThe search value for the
specified search criteria.

field_value

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
    "facets": [],
    "totalResults": 1,
    "hasMoreResults": false,
    "itemsPerPage": 10,
    "results": [
        {
            "id": "cntry000000000001000",
            "href": "http://<host_name>/v1/country/cntry000000000001000"
        }
    ],
    "startIndex": 1
}
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GET ALL COUNTRIES

Overview

Returns all Countries for which the user has access.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/country?count=:count&startPage=:startPage

Calling Options

Table 67: Calling Options

Required?Data TypeDefault ValueDescriptionName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
    "facets": [],
    "totalResults": 239,
    "hasMoreResults": true,
    "itemsPerPage": 10,
    "results": [
        {
            "id": "cntry000000000001000",
            "href": "http://<host_name>/v1/country/cntry000000000001000"
        },
        {
            "id": "cntry000000000001010",
            "href": "http://<host_name>/v1/country/cntry000000000001010"
        },
        {
            "id": "cntry000000000001100",
            "href": "http://<host_name>/v1/country/cntry000000000001100"
        },
        {
            "id": "cntry000000000001110",
            "href": "http://<host_name>/v1/country/cntry000000000001110"
        },
        {
            "id": "cntry000000000001120",
            "href": "http://<host_name>/v1/country/cntry000000000001120"
        },
        {
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            "id": "cntry000000000001130",
            "href": "http://<host_name>/v1/country/cntry000000000001130"
        },
        {
            "id": "cntry000000000001140",
            "href": "http://<host_name>/v1/country/cntry000000000001140"
        },
        {
            "id": "cntry000000000001150",
            "href": "http://<host_name>/v1/country/cntry000000000001150"
        },
        {
            "id": "cntry000000000001160",
            "href": "http://<host_name>/v1/country/cntry000000000001160"
        },
        {
            "id": "cntry000000000001170",
            "href": "http://<host_name>/v1/country/cntry000000000001170"
        }
    ],
    "startIndex": 1
}

GET DETAILS OF A PARTICULAR COUNTRY

Overview

Returns complete information about a country based on the Country's ID that is passed as a parameter value.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/country/:id

Calling Options

Table 68: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringCountry's Idid

Return Values

{
    "name": "new23",
    "shortName": "USA",
    "isoCode": "NM",
    "active": false,
    "id": "cntry000000000001000"
}
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GET META DETAILS OF COUNTRY

Overview

Returns the meta details of the country

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/country/meta:(:searchFields)

Calling Options

Table 69: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringIndicate what additional de~
tails needs to be returned.

searchFields

Acceptable values are (case-
sensitive)

Return Values

{
  "sampleData": {
    "name": null,
    "shortName": null,
    "active": false,
    "isoCode": null,
    "id": null,
    "href": "http://<host_name>/v1/country/cntry000000000000001"
  },
  "name": "Country",
  "displayName": "Country",
  "attributes": [
    {
      "name": "active",
      "displayName": "Active",
      "description": "Status of the country",
      "isRequired": false,
      "isAutoGenerated": false,
      "type": "boolean",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "isSearchFilter": true
    },
    {
      "name": "id",
      "displayName": "kI18nALCountry_id(Missing resource)",
      "description": "Saba internal id",
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      "isRequired": true,
      "isAutoGenerated": true,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "isSearchFilter": false
    },
    {
      "name": "isoCode",
      "displayName": "ISO Code",
      "description": "ISO code of the country",
      "isRequired": true,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "length": 2,
      "maximumLength": 2,
      "isSearchFilter": true
    },
    {
      "name": "name",
      "displayName": "Name",
      "description": "Name of the country",
      "isRequired": true,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "length": 255,
      "maximumLength": 255,
      "isI18n": true,
      "isSearchFilter": true
    },
    {
      "name": "shortName",
      "displayName": "Short name",
      "description": "Short name of the country",
      "isRequired": false,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "maximumLength": 10,
      "isSearchFilter": true
    }
  ]
}

CREATE A NEW COUNTRY

Overview

Allows creating a new Country.
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Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/country

Calling Options

Table 70: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringCountry1The name of the Countryname

YesstringISThe ISO code for the countryisoCode

NostringThe short name for the
country

shortName

NostringfalseIs activeactive

Request Body

{
 "name": "India",
 "isoCode":"IN",
 "shortName":"IND",
 "active":true
}

Return Values

{
    "id": "cntry000000000004630",
    "displayName": null,
    "href": "http://<host_name>/v1/country/cntry000000000004630"
}

UPDATE DETAILS OF A COUNTRY

Overview

Allows updating an existing country based on the Role ID.

Requires OAuth

No
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Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/country/:id

Calling Options

Table 71: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringCountry's Idid

Nostringnew23The name of the countryname

NostringnmThe ISO code of countryisoCode

NostringshortNameshortName

NostringfalseIs activeactive

Request Body

{
 "active":true
}

DELETE COUNTRY

Overview

Deletes Country

Requires OAuth

No

URL

https://<hostname-api.sabacloud.com>/v1/country/:id

Calling Options

Table 72: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringcntry000000000003520Country's IDid
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FIND DETAILS OF STATE

Overview

Returns the details of the State along with the ID, Name and the Deeplink URL based on the provided search criteria.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/state?q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage

Calling Options

Table 73: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringnameThe search criteria i.e. the
field name.

criteria_field

YesstringabcThe search value for the
specified search criteria.

field_value

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
    "facets": [],
    "totalResults": 1,
    "hasMoreResults": false,
    "itemsPerPage": 10,
    "results": [
        {
            "id": "state000000000001670",
            "href": "http://<host_name>/v1/state/state000000000001670"
        }
    ],
    "startIndex": 1
}

GET ALL STATES

Overview

Returns all States for which the user has access.
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Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/state?count=:count&startPage=:startPage

Calling Options

Table 74: Calling Options

Required?Data TypeDefault ValueDescriptionName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

Return Values

{
    "facets": [],
    "totalResults": 158,
    "hasMoreResults": true,
    "itemsPerPage": 10,
    "results": [
        {
            "id": "state000000000001640",
            "href": "http://<host_name>/v1/state/state000000000001640"
        },
        {
            "id": "state000000000001650",
            "href": "http://<host_name>/v1/state/state000000000001650"
        },
        {
            "id": "state000000000001670",
            "href": "http://<host_name>/v1/state/state000000000001670"
        },
        {
            "id": "state000000000002410",
            "href": "http://<host_name>/v1/state/state000000000002410"
        },
        {
            "id": "state000000000002420",
            "href": "http://<host_name>/v1/state/state000000000002420"
        },
        {
            "id": "state000000000002430",
            "href": "http://<host_name>/v1/state/state000000000002430"
        },
        {
            "id": "state000000000002930",
            "href": "http://<host_name>/v1/state/state000000000002930"
        },
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        {
            "id": "state000000000002140",
            "href": "http://<host_name>/v1/state/state000000000002140"
        },
        {
            "id": "state000000000002110",
            "href": "http://<host_name>/v1/state/state000000000002110"
        },
        {
            "id": "state000000000002120",
            "href": "http://<host_name>/v1/state/state000000000002120"
        }
    ],
    "startIndex": 1
}

GET DETAILS OF A PARTICULAR STATE

Overview

Returns complete information about a state based on the State's ID that is passed as a parameter value.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/state/:id

Calling Options

Table 75: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringState's Idid

Return Values

{
    "name": "Maharastra",
    "country": {
        "id": "cntry000000000001000",
        "displayName": "new23"
    },
    "shortName": "Mah",
    "isoCode": "MH",
    "id": "state000000000001650"
}
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GET META DETAILS OF STATE

Overview

Returns the meta details of the state

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/state/meta:(:searchFields)

Calling Options

Table 76: Calling Options

Required?Data TypeDefault ValueDescriptionName

NostringIndicate what additional de~
tails needs to be returned.

searchFields

Acceptable values are (case-
sensitive)

Return Values

{
  "sampleData": {
    "name": null,
    "country": null,
    "shortName": null,
    "isoCode": null,
    "id": null,
    "href": "http://<host_name>/v1/state/state000000000000001"
  },
  "name": "CountryState",
  "displayName": "State",
  "attributes": [
    {
      "name": "country",
      "displayName": "Country",
      "description": "Country of the state",
      "isRequired": true,
      "isAutoGenerated": false,
      "type": "object",
      "isReference": true,
      "isProtected": false,
      "display": true,
      "isSearchFilter": true
    },
    {
      "name": "id",
      "displayName": "kI18nALCountryState_id(Missing resource)",
      "description": "Saba internal id",
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      "isRequired": true,
      "isAutoGenerated": true,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "isSearchFilter": false
    },
    {
      "name": "isoCode",
      "displayName": "ISO Code",
      "description": "ISO code of the state",
      "isRequired": true,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "length": 2,
      "maximumLength": 2,
      "isSearchFilter": true
    },
    {
      "name": "name",
      "displayName": "Name",
      "description": "Name of the state",
      "isRequired": true,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "length": 255,
      "maximumLength": 255,
      "isI18n": true,
      "isSearchFilter": true
    },
    {
      "name": "shortName",
      "displayName": "Short name",
      "description": "Short name of the state",
      "isRequired": false,
      "isAutoGenerated": false,
      "type": "string",
      "isReference": false,
      "isProtected": false,
      "display": true,
      "maximumLength": 10,
      "isSearchFilter": true
    }
  ]
}

CREATE A NEW STATE

Overview

Allows creating a new State.
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Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/state

Calling Options

Table 77: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringState1The name of the Statename

YesstringISThe ISO code for the stateisoCode

NostringThe short name for the stateshortName

Yesstring{\"id\":
\"cntry000000000001000\",

The country for the statecountry

\"display~
Name\":\"new1\"}

Request Body

{
 "name": "Maha",
 "shortName":"mah",
 "isoCode":"mh",
 "country":{"id":"cntry000000000001000"}
}

Return Values

{
    "id": "state000000000003490",
    "displayName": null,
    "href": "http://<host_name>/v1/state/state000000000003490"
}

UPDATE DETAILS OF A STATE

Overview

Allows updating an existing state based on the Role ID.

Requires OAuth

No
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Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/state/:id

Calling Options

Table 78: Calling Options

Required?Data TypeDefault ValueDescriptionName

YesstringCountry's Idid

Nostringnew23The name of the countryname

NostringnmThe ISO code of countryisoCode

NostringshortNameshortName

Nostring{\"id\":
\"cntry000000000001000\",

Countrycountry

\"display~
Name\":\"new1\"}

Request Body

{
 "isoCode":"mh"
}

DELETE STATE

Overview

Deletes State

Requires OAuth

No

URL

https://<hostname-api.sabacloud.com>/v1/state/:id

Calling Options

Table 79: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstringstate000000000001000State's IDid
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Note:  For more details on this see REST API Reference.

This enhancement provides customers more control of security role assignments and also reduces the load on Support,
Operations and Services in meeting ad hoc requests.

APIs to retrieve details of the recurring course completions

Using REST API there was no way to retrieve details of the recurring course completions.

The following new REST APIs will now allow retrieving the details of the recurring course completions:

1. FIND DETAILS OF RECURRING COURSE COMPLETIONS
2. FIND DETAILS OF RECURRING COURSE COMPLETIONS (Using POST - Range based search)

FIND DETAILS OF RECURRING COURSE COMPLETIONS

Overview

Returns the details of the recurring course completions along with the ID, Name and the Deeplink URL based on the
provided search criteria.

Note: When a recurring course is assigned to a user, the corresponding enrollment entry is not created. Only when
the course is completed, the transcript entry is created, due to this the API will not return detail URL as href for
in-complete course in output JSON.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/recurringcompletions
?q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage&f=(:csvAttributesValue)&includeDetails=:includeDetails

Calling Options

Table 80: Calling Options

Required?Data TypeSample ValueDescriptionName

Noperson_idThe search criteria e.g. per~
son Id.

criteria_field

YesstringThe search value for the
specified search criteria.

field_value
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Required?Data TypeSample ValueDescriptionName

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

NostringIndicate the field(s) that you
intend to extract.

csvAttributesValue

NostringfalseReturns the details of the re~
curring course completions
in the search

includeDetails

The following are the supported search criteria and display attributes:

ExampleField descriptionField name

Person_id%3D%3Demplo000000000001000  Will return all recurring course completions of a
specified person.

person_id

person_no%3D%3D001000This search criteria will return all recurring course
completions of given person.

Person_no

Person_username%3D%3DuoneThis search criteria will return all recurring course
completions of given person.

Person_user~
name

status%3D%3D400  This will return all recurring course completions of
a specified status.

Below are the possible status values:

status

For Recurring Completions (Completed):

• 100 - Not evaluated
• 200 - Successful
• 300 - Suspended
• 400 - Unsuccessful
• 600 - Pending Registration
• 700 - Pending Approval

For Recurring Completions (Not Completed):

• 100 - Completed
• 200 - In progress
• 300 - Expired
• 400 - Assigned
• 600 - Pending Registration
• 700 - Pending Approval

updated_on%3Dge%3D2010-01-29 01:29:32This will return result based on updated date of a
recurring course completion.

updated_on
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assigned_on%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its assigned date value.

assigned_on

course_no%3D%3d00201084This search criteria will return recurring course
completion of a given course.

course_no

Course_id%3D%3D cours000000000203226This search criteria will return recurring course
completion of a given course.

Course_id

completed_on%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its comepleted date value.

com~
pleted_on

due_date%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its due date value.

due_date

expiration_date%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its expiration date value.

expira~
tion_date

This search criteria will return all recurring course
completions based on its assigned status.

assigned~
Status

The JSON ouput structure for not-yet-completed items is quite different from completed items. This is because the
not-yet-completed recurring courses are treated similar to held certifications and completed recurring courses are treated
as Transcripts. This is in line with how these are interpreted on the UI.

Return Values (Completed recurring courses using includeDetails=false)

{  
   "status_description":"Not Evaluated",
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "course":{  
      "id":"cours000000000036549",
      "course_no":"00016460",
      "title":"test-recurring1",
      "version":null
   },
   "id":"ofapr000000000121389",
   "status":"100",

"href":"https://dqlearning-api.sabacloud.com/v1/transcripts/ofapr000000000121389"
}

Return Values (Not-yet-completed recurring courses using includeDetails=false)

{  
   "assignedStatusDescription":"Assigned",
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "course":{  
      "id":"cours000000000013889",
      "course_no":"00010274",
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      "title":"RecurCoursePR",
      "version":"12345"
   },
   "assignedStatus":"400"
}

Note:  assignedStatus / assignedStatusDescription either of these fields in the output JSON indicate a
Not-yet-completed recurring course.

Return Values (Completed recurring courses using includeDetails=true)

{  
   "updated_by":"uone",
   "updated_on":"2016-07-29T04:14:14.000+0000",
   "created_on":"2016-07-29T04:14:14.000+0000",
   "created_by":"uone",
   "end_date":null,
   "start_date":"2016-07-29T04:14:13.000+0000",
   "time_interval":0,
   "offering_temp_id":{  
      "id":"cours000000000036549",
      "displayName":"test-recurring1"
   },
   "delivery":null,
   "delivery_type":"eqcat000000000000005",
   "action_no":"00105488",
   "completion_date":null,
   "action_status":"100",
   "grade":"",
   "delivered_by":null,
   "target_date":"2016-07-29T06:14:13.000+0000",
   "flags":2,
   "registration":null,
   "added_to_profile_on":"2016-07-29T04:14:13.000+0000",
   "offrng_start_date":null,
   "archived":0,
   "completionMode":0,
   "learner_id":null,
   "credits":null,
   "location":null,
   "party_id":{  
      "id":"emplo000000000019079",
      "displayName":"One User"
   },
   "start_time":null,
   "end_time":null,
   "status":100,
   "score":0,
   "id":"ofapr000000000121389",
   "customValues":{  
      "custom0":null,
      "custom1":null,
      "custom2":null
   }
}

Return Values (Not-yet-completed recurring courses using includeDetails=true)

{  
   "assignedBy":"One User",
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   "assigned_on":"2016-09-02T05:51:19UTC",
   "assignedStatusDescription":"Assigned",
   "completed_on":null,
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "due_date":"2016-09-02T00:00:00UTC",
   "course":{  
      "id":"cours000000000013889",
      "course_no":"00010274",
      "title":"RecurCoursePR",
      "version":"12345"
   },
   "expiration_date":null,
   "assignedStatus":"400"
}

FIND DETAILS OF RECURRING COURSE COMPLETIONS (Using POST - Range based search)

Overview

Returns the details of the recurring course completions along with the ID, Name and the Deeplink URL based on the
provided range based search criteria.

Note: When a recurring course is assigned to a user, the corresponding enrollment entry is not created. Only when
the course is completed, the transcript entry is created, due to this the API will not return detail URL as href for
in-complete course in output JSON.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/recurringcompletions/searchQuery?count=:count&startPage=:startPage
&f=(:csvAttributesValue)&includeDetails=:includeDetails

Calling Options

Table 81: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstring[{"name": "per~
son_id", "operator":

The search conditions.

You can use search operators
such as:

conditions > name

"==", "value": "em~
plo000000000001000"}]

• =gt= - Greater than
• =ge= - Greater or Equal
• =lt= - Less than
• =le= - Less or Equal
• == - Equal
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Required?Data TypeSample ValueDescriptionName

• != - Not Equal
• ; - AND
• , - OR

Nostring10The number of records per
page.

count

Nostring1The start page number for
the list of records.

startPage

NostringIndicate the field(s) that you
intend to extract.

csvAttributesValue

NostringfalseReturns the details of the re~
curring course completions
in the search

includeDetails

The following are the supported search criteria and display attributes:

ExampleField descriptionField name

Person_id%3D%3Demplo000000000001000  Will return all recurring course completions of a
specified person.

person_id

person_no%3D%3D001000This search criteria will return all recurring course
completions of given person.

Person_no

Person_username%3D%3DuoneThis search criteria will return all recurring course
completions of given person.

Person_user~
name

status%3D%3D400  This will return all recurring course completions of
a specified status.

Below are the possible status values:

status

For Recurring Completions (Completed):

• 100 - Not evaluated
• 200 - Successful
• 300 - Suspended
• 400 - Unsuccessful
• 600 - Pending Registration
• 700 - Pending Approval

For Recurring Completions (Not Completed):

• 100 - Completed
• 200 - In progress
• 300 - Expired
• 400 - Assigned
• 600 - Pending Registration
• 700 - Pending Approval
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updated_on%3Dge%3D2010-01-29 01:29:32This will return result based on updated date of a
recurring course completion.

updated_on

assigned_on%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its assigned date value.

assigned_on

course_no%3D%3d00201084This search criteria will return recurring course
completion of a given course.

course_no

Course_id%3D%3D cours000000000203226This search criteria will return recurring course
completion of a given course.

Course_id

completed_on%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its comepleted date value.

com~
pleted_on

due_date%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its due date value.

due_date

expiration_date%3Dge%3D2010-01-29 01:29:32This search criteria will return all recurring course
completions based on its expiration date value.

expira~
tion_date

This search criteria will return all recurring course
completions based on its assigned status.

assigned~
Status

Request Body

{
 "conditions" :[
    {
     "name": "person_id",
     "operator": "==",
     "value": "emplo000000000001000"
    }
 ]     
}

The output for not-yet-completed recurring courses will be very different from the output of completed recurring courses. 

Return Values (Completed recurring courses using includeDetails=false)

{  
   "status_description":"Not Evaluated",
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "course":{  
      "id":"cours000000000036549",
      "course_no":"00016460",
      "title":"test-recurring1",
      "version":null
   },
   "id":"ofapr000000000121389",
   "status":"100",
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"href":"https://dqlearning-api.sabacloud.com/v1/transcripts/ofapr000000000121389"
}

Return Values (Not-yet-completed recurring courses using includeDetails=false)

{  
   "assignedStatusDescription":"Assigned",
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "course":{  
      "id":"cours000000000013889",
      "course_no":"00010274",
      "title":"RecurCoursePR",
      "version":"12345"
   },
   "assignedStatus":"400"
}

Note:  assignedStatus / assignedStatusDescription either of these fields in the output JSON indicate a
Not-yet-completed recurring course.

Return Values (Completed recurring courses using includeDetails=true)

{  
   "updated_by":"uone",
   "updated_on":"2016-07-29T04:14:14.000+0000",
   "created_on":"2016-07-29T04:14:14.000+0000",
   "created_by":"uone",
   "end_date":null,
   "start_date":"2016-07-29T04:14:13.000+0000",
   "time_interval":0,
   "offering_temp_id":{  
      "id":"cours000000000036549",
      "displayName":"test-recurring1"
   },
   "delivery":null,
   "delivery_type":"eqcat000000000000005",
   "action_no":"00105488",
   "completion_date":null,
   "action_status":"100",
   "grade":"",
   "delivered_by":null,
   "target_date":"2016-07-29T06:14:13.000+0000",
   "flags":2,
   "registration":null,
   "added_to_profile_on":"2016-07-29T04:14:13.000+0000",
   "offrng_start_date":null,
   "archived":0,
   "completionMode":0,
   "learner_id":null,
   "credits":null,
   "location":null,
   "party_id":{  
      "id":"emplo000000000019079",
      "displayName":"One User"
   },
   "start_time":null,
   "end_time":null,
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   "status":100,
   "score":0,
   "id":"ofapr000000000121389",
   "customValues":{  
      "custom0":null,
      "custom1":null,
      "custom2":null
   }
}

Return Values (Not-yet-completed recurring courses using includeDetails=true)

{  
   "assignedBy":"One User",
   "assigned_on":"2016-09-02T05:51:19UTC",
   "assignedStatusDescription":"Assigned",
   "completed_on":null,
   "person":{  
      "id":"emplo000000000019079",
      "username":"UONE"
   },
   "due_date":"2016-09-02T00:00:00UTC",
   "course":{  
      "id":"cours000000000013889",
      "course_no":"00010274",
      "title":"RecurCoursePR",
      "version":"12345"
   },
   "expiration_date":null,
   "assignedStatus":"400"
}

Note:  assignedStatus / assignedStatusDescription either of these fields in the output JSON indicate a
Not-yet-completed recurring course.

Note:  For more details on this see REST API Reference.

The Transcript API did not return completions based on recurring courses which provided an incomplete view of the
Transcript. A separate endpoint has been created for retrieving recurring course completions.

API to retrieve existing registration details or auto enroll user and get
registration details

It was not possible to retrieve the existing registration details or auto enroll the user and then get the registration details
using a single API.

The following new REST API will now allow retrieving the existing registration details or auto enroll the user and then
get the registration details:

GET EXISTING REGISTRATION DETAILS OR AUTO ENROLL USER AND GET REGISTRATION
DETAILS
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Overview

Returns the existing details of the registration. If the enrollment does not exist, then the learner will be enrolled to the
class. If the enrollment already exists or the learner has already completed the class then the enrollment record ID will
be returned.

Note: When custom fields on the 'Order' component are marked as required then the auto enroll API will not work
i.e. the learner will not be auto enrolled to the class.

The Base learner (i.e. the Order contact) will be the logged in learner, Bill to depends on the BR settings "Billing
Party" (Bill to learner itself instead of learners organization). In case of Non-zero price and payment is required
for the learner, the order will be created in "Payment Initiated" state.

This API also returns context_id and subscription_id for any associated content, enabling external systems to form a
launch URL without any additional API calls.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/learning/enroll/:learner/:offering/autoenroll

Examples

https://<hostname-api.sabacloud.com>/v1/learning/enroll/emplo000000000001000/dowbt000000000038912/autoenroll

https://<hostname-api.sabacloud.com>/v1/learning/enroll/uone/wbtclass001/autoenroll

Calling Options

Table 82: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringem~
plo000000000001000

Person's ID or Username or
Person_No

learner

Yesstringdowbt000000000002644Offering's ID or the unique
offering number

offering

Request Body

{"deliveryType":"web-based"}

Return Values

[  
   {  
      "registrationStatus":100,
      "orderNo":"00160364",
      "completionStatusDesciption":"Not Evaluated",
      "orderId":"intor000000003517540",

 | System | 232



      "registrationStatusDesciption":"Registered",
      "orderStatus":100,
      "regId":"regdw000000000127324",
      "completionDate":null,
      "completionStatus":100,
      "orderStatusDesciption":"Confirmed",
      "createdOn":"2016/09/23T04:49:56UTC",
      "learningAssignments":[  
         {  
            "regModuleId":"regmd000000000092880",
            "subscriptionId":null,
            "contentContextId":"ctctx000000000157910"
         },
         {  
            "regModuleId":"regmd000000000092880",
            "subscriptionId":null,
            "contentContextId":"ctctx000000000157910"
         }
      ]
   }
]

Note:  For more details on this see REST API Reference.

This enhancement provides a single REST API and thus helps reduce the number of API calls to Saba.

API to retrieve the Audience Type / Audience Sub Types assigned to a
Person

The existing REST API (GET AUDIENCE TYPE / AUDIENCE SUB TYPES ASSIGNED TO A PERSON) didn't
retrieve accurate data. There was a mismatch between the records that it retrieved and the records shown on the product
UI.

The existing REST API is now deprecated and will be discontinued in the next few updates.

The following new REST API will now allow retrieving the Audience Type / Audience Sub Types assigned to a Person:

GET AUDIENCE TYPE / AUDIENCE SUB TYPES ASSIGNED TO A PERSON

Overview

Gets the Audience Type / Audience Sub Types assigned to a Person

Requires OAuth

No

Method

GET
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URL

https://<hostname-api.sabacloud.com>/v1/common/profile/:personId/audiencetype

Note: The following is a deprecated URL for this REST Web service and will be discontinued in the next few
updates:

https://<hostname-api.sabacloud.com>/v1/people/:personId/audiencetypes/search

Calling Options

Table 83: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringper~
sn000000000001000

Person / Employee ID /
username

personid

Return Values

{
    "facets": [],
    "startIndex": 1,
    "results": [
        {
            "name": "internal",
            "id": "audie000000000000001",
            "href": 
"https://<hostname-api.sabacloud.com>/v1/audiencetypes/audie000000000000001"
        }
    ],
    "itemsPerPage": 10,
    "totalResults": 1,
    "hasMoreResults": false
}

Note:  For more details on this see REST API Reference.

This enhancement provides a REST API that represents the UI behavior for when a user clicks on View Certification
History > Main tab for a Student-certification.

API to report the content result back to Saba

There was no API that would report the content result back to Saba.

The following new REST API will now allow reporting the content result back to Saba:

REPORT RESULT

Overview

Report the content result back to Saba.
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Note: This API only supports the COIN and LAB content formats.

Requires OAuth

No

Method

POST

URL

http://<hostname-api.sabacloud.com>/v1/partner/reportResult

Calling Options

Table 84: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstring.-.68FEC7ECB9C3B84E405E890B138
43E27D1D8F3D8E60CF90C75A9877F

This will be sent by Saba dur~
ing content launch/entitle~

track~
ingKey

19865DFAABFB886758529CD796DC
8A295D33C81E-.-

ment(250 characters key lim~
it).

YesstringincompletePossible values: incomplete,
completed, passed, failed.

completion~
Status

NostringOptional, if Completion Status
is Incomplete/Completed.

score

Mandatory, if completion
status is passed/failed.

NostringMinimum scoreminScore

NostringMaximum scoremaxScore

NostringTime spent on the content.
Specify the value in the follow~

timeSpent

ing format: hh:mm:ss For ex~
ample: 00:10:00

NostringOptional date when the learner
completed the content item.

complete~
dOn

The date should be in yyyy-
MM-dd HH:mm:ss or
dd/MM/yyyy or dd/MM/yyyy
HH:mm:ss.

Request Body

{  
   "trackingKey":".-.A4207E711067D0FC61B3FA5F6029D0FB8E8A12748EF930B
        CC47D4638131197DDEEC6548C949747CDE1E4C1AAA94245F0-.-",
   "completionStatus":"completed",
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   "score":"24",
   "minScore":"35",
   "maxScore":"100",
   "timeSpent":"00:24:10",
   "completedOn":"27/09/2016"
}

Return Values

{
    "trackingKey": ".-.A4207E711067D0FC61B3FA5F6029D0FB8E8A12748EF930B
        CC47D4638131197DDEEC6548C949747CDE1E4C1AAA94245F0-.-",
    "errorMessage": "",
    "status": "Success"
}

Note:  For more details on this see REST API Reference.

N/A

Get completion and lesson details of the learning event

The following REST API did not return the details for each registration ID that are currently returned by the
/v1/enrollments/:id/sections API:

• GET COMPLETION DETAILS OF THE LEARNING EVENT

The following REST APIs now return these additional details as part of the Response:

• GET COMPLETION AND LESSON DETAILS OF THE LEARNING EVENT

GET COMPLETION AND LESSON DETAILS OF THE LEARNING EVENT

Overview

Gets completion and lesson details of the learning event. This API helps determine whether the elements of a certification
were completed directly or by completing an equivalent.

It can also return the lesson details (sections:(completiondetail,lessondetail)) i.e. the HeldCertification/HeldCurriculum
details along with the path, learning modules and learning interventions and the lesson details with the information
regarding the courses that are completed and whether they are completed by equivalence.

Note:  If the learner has not registered for a course or if the learner has registered but never launched it, the lesson
information will not be returned.

Requires OAuth

No

Method

GET
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URL

http://<hostname-api.sabacloud.com>/v1/learning/heldlearningevent/:heldCertId/:pathId/sections:(:searchFields)

Calling Options

Table 85: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringstuce000000000202608Held Certification/Cur~
riculum activity ID

heldCertId

Yesstringtrack000000000201083Path IDpathId

Yesstringcompletiondetail

lessondetail

Completion Detail / Lesson
Details of the learning event

searchFields

Example (Get Completion Details and Lesson Details for a specific path within a specific held
certification/curriculum)

To get the completion details and lesson details for a specific path within a specific held certification:

https://<hosname-api.sabacloud.com
>/v1/learning/heldlearningevent/stuce000000000389597/track000000000010049/sections:(completiondetail,lessondetail)

Return Values:

{  
   "id":"stuce000000000389597",
   "type":"CERTIFICATION",
   "certification":{  
      "id":"crtfy000000000009911",
      "displayName":"Test_Certification_001"
   },
   "owner":{  
      "id":"emplo000000000285703",
      "displayName":"uone17 uone17"
   },
   "acquiredOn":"2008-03-11T00:00:00.000+0530",
   "assignedOnDate":"2008-03-11T11:07:07.000+0530",
   "expired_on":"2008-03-13T00:00:00.000+0530",
   "recert_window_starts_on":"2008-03-15T00:00:00.000+0530",
   "revoked_on":null,
   "inRecertification":false,
   "status":{  
      "intStatus":100,
      "description":"Acquired"
   },
   "path":{  
      "id":"track000000000010049",
      "displayName":"Recertification Path",
      "is_default_path":false,
      "is_acquisition_path":false,
      "percentcompleted":100,
      "is_recert_path":true,
      "no_of_total_modules":1,
      "no_of_reqd_modules":1,
      "learningModules":[  
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         {  
            "sequence":1,
            "name":"Java",
            "id":"cegrp000000000200201",
            "is_reqd":true,
            "no_of_total_items":2,
            "no_of_reqd_items":2,
            "no_of_total_items_completed":2,
            "learningInterventions":[  
               {  
                  "sequence":1,
                  "type":"COURSE",
                  "part_id":{  
                     "id":"cours000000000200706",
                     "course_no":"00004149",
                     "displayName":"nc0508-1"
                  },
                  "is_completed":true,
                  "is_completion_by_equivalent":false,
                  "id":"edupl000000000200340",
                  "lessonDetails":{  
                     "class_id":"dowbt000000000039112",
                     "registration_id":"regdw000000000310120",
                     "class_no":"00016147",
                     "contentDetails":[  
                        {  
                           "lessonStatus":"N",
                           "lessonLocation":"",
                           "contextId":"ctctx000000001258979",
                           "contentTitle":"A001",
                           "subscriptionId":"ctnsr000000000751124"
                        },
                        {  
                           "lessonStatus":"N",
                           "lessonLocation":"",
                           "contextId":"ctctx000000001258979",
                           "contentTitle":"A001",
                           "subscriptionId":"ctnsr000000000751125"
                        },
                        {  
                           "lessonStatus":"f",
                           "lessonLocation":"a001_end.html",
                           "contextId":"ctctx000000001258979",
                           "contentTitle":"Assessment",
                           "subscriptionId":"ctnsr000000000751126"
                        },
                        {  
                           "lessonStatus":"f",
                           "lessonLocation":"a001_end.html",
                           "contextId":"ctctx000000001258979",
                           "contentTitle":"Assessment",
                           "subscriptionId":"ctnsr000000000751127"
                        }
                     ]
                  },
                  "completionStatus":{  
                     "key":100,
                     "desc":"Not Evaluated"
                  }
               }
            ]
         },
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         {  
            "sequence":2,
            "type":"CERTIFICATION",
            "part_id":{  
               "id":"crtfy000000000006671",
               "displayName":"Test_Certification1"
            },
            "status":{  
               "intStatus":100,
               "description":"Acquired"
            },
            "id":"edupl000000000200150"
         }
      ]
   }
}

To get the completion details and lesson details for a specific path within a specific held curriculum:

https://<
hostname-api.sabacloud.com>/v1/learning/heldlearningevent/stcur000000000001744/track000000000201068/sections:(completiondetail,lessondetail)

Return Values:

{  
   "id":"stcur000000000001744",
   "type":"CURRICULUM",
   "curriculum":{  
      "id":"curra000000000001028",
      "displayName":"Curriculum1"
   },
   "owner":{  
      "id":"emplo000000000285703",
      "displayName":"uone17 uone17"
   },
   "acquiredOn":"2008-03-11T00:00:00.000+0530",
   "assignedOnDate":"2008-03-11T11:07:07.000+0530",
   "expired_on":"2008-03-13T00:00:00.000+0530",
   "status":{  
      "intStatus":400,
      "description":"Assigned"
   },
   "path":{  
      "id":"track000000000010049",
      "displayName":"Recertification Path",
      "is_default_path":false,
      "is_acquisition_path":false,
      "percentcompleted":100,
      "is_recert_path":false,
      "no_of_total_modules":1,
      "no_of_reqd_modules":1,
      "learningModules":[  
         {  
            "sequence":1,
            "name":"Java",
            "id":"cegrp000000000200201",
            "is_reqd":true,
            "no_of_total_items":1,
            "no_of_reqd_items":1,
            "no_of_total_items_completed":1,
            "learningInterventions":[  
               {  
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                  "sequence":1,
                  "type":"COURSE",
                  "part_id":{  
                     "id":"cours000000000200709",
                     "course_no":"00005678",
                     "displayName":"Course_for_Curriculum"
                  },
                  "is_completed":true,
                  "is_completion_by_equivalent":false,
                  "id":"edupl000000000200342",
                  "lessonDetails":{  
                     "class_id":"dowbt000000000039122",
                     "registration_id":"regdw000000000311120",
                     "class_no":"00016148",
                     "contentDetails":[  
                        {  
                           "lessonStatus":"N",
                           "lessonLocation":"",
                           "contextId":"ctctx000000011258979",
                           "contentTitle":"A001",
                           "subscriptionId":"ctnsr000000001751124"
                        },
                        {  
                           "lessonStatus":"N",
                           "lessonLocation":"",
                           "contextId":"ctctx000000011258979",
                           "contentTitle":"A001",
                           "subscriptionId":"ctnsr000000001751125"
                        },
                        {  
                           "lessonStatus":"f",
                           "lessonLocation":"a001_end.html",
                           "contextId":"ctctx000000011258979",
                           "contentTitle":"Assessment",
                           "subscriptionId":"ctnsr000000001751126"
                        },
                        {  
                           "lessonStatus":"f",
                           "lessonLocation":"a001_end.html",
                           "contextId":"ctctx000000011258979",
                           "contentTitle":"Assessment",
                           "subscriptionId":"ctnsr000000001751127"
                        }
                     ]
                  },
                  "completionStatus":{  
                     "key":100,
                     "desc":"Not Evaluated"
                  }
               }
            ]
         }
      ]
   }
}

Note:  For more details on this see REST API Reference.
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Customers often use the Enrollment API (/v1/people/:id/enrollments or /v1/enrollment). These high-level Enrollment
APIs do provide good amount of detail when using includeDetails=true, but certain things are still missing. To get these,
they have to call the Enrollment Detail API for each enrollment i.e. /v1/enrollments/:id/sections:regdetail.

This enhancement helps reduce the number of API calls, which return all the details returned by the current Enrollment
Detail API for each Registration ID.
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Chapter

2

Analytics

Topics:

• Framework enhancements
• New Reports
• New Attributes
• Updated Attributes



Framework enhancements

Add exceptions to reports

"Converse" or "Exception" reporting was not supported.

This update now allows "Converse" or "Exception" reporting where you have the ability to report on data facts that are
NOT EXISTING in the recorded storage.

Note:  By default, this feature will be disabled. To enable this feature, submit a support request. For assistance,
contact Saba support.

To enable this feature, the Saba "admin" user must enable the following property under Analytics Site >
Configuration > Functionality:

• Exceptions

Figure 28: Exceptions property

While creating a new report, you will now be able to add exceptions to that report.

Figure 29: Configure exceptions

Clicking Configure exceptions brings up the Configure exceptions page.
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Figure 30: Configure exceptions page

To add an exception group from the Available Exceptions section click +.

Note: Available Exceptions section holds the pre-defined exceptions which can be added to a report.

To remove an already added exception group click Remove Exception. Click Save after making the required changes.

Note:

• You can only add one exception group per report.
• An exception group is not allowed when a report is created with "ALL" grouping.
• An exception group will be added to a report using the AND logical operator

only.
• Exception grouping and Filter grouping are not allowed together.
• Exception filters are not counted as part of the main filter.

Figure 31: Exceptions added

The exceptions that you add to a report can be seen at the time of executing that report by hovering your mouse over
the filters.

Resolve button assists the admin to remove incompatible dimensions that may have been added along with.
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Figure 32: Resolving incompatibilities

The message bar recommends certain attributes that are taken out of the added dimension/metric/filters to ensure the
exception report produces the relevant results for the featured exceptions. On hovering over the yellow bar, a larger
“Important” message box shows up. The Resolve button removes the dimensions, metrics and filters that are identified
as  incompatible for this report.

Note:  Saba only recommends and the user is free to retain them ignoring the recommendation.

Figure 33: View the added exceptions

The following OOB exception reports have also been introduced:

• Exception Report – Pending Course Completion
• Exception Report – Unassigned Certification
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Businesses require easy access to data that are NOT directly recorded facts (like unassigned courses, certifications,
goals) in the application. This enhancement makes it possible to report on data facts that are NOT EXISTING in the
recorded storage, for example:

• There are 10,000 users in the system. 7348 have been assigned the "Health and Safety Guidelines" certification. You
want to report on those who are out of the assignment bracket.

Embed an Analytics Dashboard, Report or Chart in an external
portal

It was not possible to embed Analytics Dashboards, Reports or Charts in an external portal. This is a new functionality.

This update now allows embedding Analytics Dashboards, Reports or Charts in an external portal. This will allow
enterprises to display dashboard reports, charts or even reporting data in their in house portal space.

While viewing reports, you now have Embed as an action for a dashboard or a report.

Figure 34: Embed option

Clicking Embed brings up the Embed pop up.
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Figure 35: Embed pop up for dashboards

Figure 36: Embed pop up for reports

For reports, you can choose to embed the entire report or just the chart using the following options:

• Report
• Chart

You also need to select the context type (such as Admin, Manager or Employee) for that particular embed. The Manager
or Employee contexts will be available based on whether that particular report or dashboard is shared with managers or
employees.

After you select the embed type and the context, click Save to generate the embed code.
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Figure 37: Embed code

You can now use this code in any external portals as a part of the HTML code.

Note:

This feature honors the security process and associated privileges. Features like Terms and Conditions, Customer
Onboarding are not honored in the embed feature. The Analytics admin is forewarned about this at the time of
embed code generation.

The report presentation follows execution context as set for the report.

You can practically embed in any location that allows html code

Such embedding allows the dashboard to be presented even within the system canvas of Saba Cloud.

Support Data Is Protected individually for Person and Organization
fix custom dimensions

Before the update, when any custom attribute such as Person Custom 0 was used in a report, and if this attribute is
flagged as Data Is Protected in any one of the component such as External (which is a component of Person custom),
then the application used to return an error indicating: ‘You do not have access to attribute ‘Person Custom 0’’ even
though the user was trying to view the data of the Internal component.

After this update, if the user wants to see the data of the Internal component, then the user can simply use the Person
Type filter and select the operator as Equals/In and the value as Internal. Now since the user has access to the Internal
component's data, the report will run successfully. If the user selects External as the filter value, the report will return
an error indicating: ‘You do not have access to attribute ‘Person Custom 0’’.
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Note:  If the user does not select a filter, then the report will continue to work like before. That is it will consider
both the components, and if the user does not have access on any one component, the report execution will fail
with an error.

The same is applicable for the Organization fix custom dimensions.

N/A

Line charts to now support sorting on dimension attributes

For (single dimension) line chart types, data was chronologically sorted on the basis of the date column, if it was available
and if a date column was not available then data was sorted on the basis of metric count.

For (single dimension) line chart types, this update now allows defining sorting (ASCENDING or DESCENDING) on
dimension values instead of the date column or metric count.

Figure 38: Sorting for dimension attributes

Note:  If you set the sorting to None, data is chronologically sorted on the basis of the date column, if it is available
and if a date column is not available then data is sorted on the basis of metric count.

This enhancement makes it possible for the Performance admin to create and share dashboards to managers on performance
rating distribution.
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New Reports

Exception Report - Unassigned Certification

This is a new report.

This report provides a list of people who have not been assigned the selected certification.

This report needs the following services:

• Certification

Figure 39: Exception Report - Unassigned Certification Example

Report Details

This section provides high-level details of the Exception Report - Unassigned Certification report.

Filters

This report uses the following mandatory filters:

1. Is Terminated (Equal "No")
2. Certification Name (Equal)
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3. Student Certification Status (In "Acquired, In Progress, Assigned, Overdue")

This report uses the following optional filters:

1. Manager Full Name (Equal)
2. Person Location Name (Equal)
3. Person Organization Name (Equal)

Exception Groups

This report uses the following exception groups:

1. Unassigned Certification

Dimensions

This report uses the following dimensions:

1. Person Organization Name
2. Person Full Name
3. Person Username
4. Person Job Type Name
5. Manager Full Name
6. Person E-Mail
7. Person Location Name

Metrics

This report uses the following metrics:

1. Head Count

N/A

Exception Report - Pending Course Completion

This is a new report.

This report provides the combined list of people who have not completed the course successfully post registration and
those who have not been enrolled in the same course.

This report needs the following services:

• Courses
• Learning
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Figure 40: Exception Report - Pending Course Completion Example

Report Details

This section provides high-level details of the Exception Report - Pending Course Completion report.

Filters

This report uses the following mandatory filters:

1. Is Terminated (Equal "No")
2. Course Course Title (Equal)
3. Completion Status (Equal "Successful")

This report uses the following optional filters:

1. Manager Full Name (Equal)
2. Person Location Name (Equal)
3. Person Organization Name (Equal)

Exception Groups

This report uses the following exception groups:

1. Pending Completion for Course

Dimensions

This report uses the following dimensions:

1. Person Organization Name
2. Person Full Name
3. Person Username
4. Person Job Type Name
5. Manager Full Name
6. Person E-Mail
7. Person Location Name
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Metrics

This report uses the following metrics:

1. Head Count

N/A

Pulse Survey Report By Respondent

This is a new report.

This report provides the Pulse Survey details for each respondent.

This report needs the following services:

• Custom Surveys

Figure 41: Pulse Survey Report By Respondent Example
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Report Details

This section provides high-level details of the Pulse Survey Report By Respondent Report.

Filters

This report uses the following mandatory filters:

1. Is Terminated (Equal "No")
2. Survey Name (Equal)

This report uses the following optional filters:

1. Survey Submitted On within a defined range
2. Person Location Name (In)
3. Person Organization Name (In)
4. Manager Full Name (In)
5. Person Full Name (In)

Dimensions

This report uses the following dimensions:

1. Person Organization Name
2. Person Full Name
3. Person Username
4. Person Job Type Name
5. Manager Full Name
6. Person Location Name
7. Survey Section Title
8. Survey Question Text
9. Survey Question Response
10. Survey Question Comments
11. Survey Participant Score

N/A

Anonymous Pulse Survey Report

This is a new report.

This report provides the details of the Anonymous Pulse Survey.

Note: This report will show data only when at least three or more people have completed the Anonymous Pulse
survey.

This report needs the following services:

• Custom Surveys
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Figure 42: Anonymous Pulse Survey Report Example

Report Details

This section provides high-level details of the Anonymous Pulse Survey Report.

Filters

This report uses the following mandatory filters:

1. Survey Name

This report uses the following optional filters:

1. Survey Submitted On within a defined range

Dimensions

This report uses the following dimensions:

1. Survey Name
2. Survey Section Title
3. Survey Question Text
4. Survey Question Response
5. Survey Question Comments
6. Survey Participant Score

Metrics

This report uses the following metrics:

1. Survey Response Count
2. Average Points for Survey Question
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N/A

New Attributes

Pulse 360

These are new attributes.

This section describes the attributes that have been added under the Pulse 360 reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 86: Pulse 360 Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Pulse 360 CategoryYesDimensionPulse 360 Cat~
egory

Pulse 360 Feed~
back

Location NumberYesDimensionLocation Num~
ber

Pulse 360 Feed~
back

Location NameYesDimensionLocation NamePulse 360 Feed~
back

Organization NumberYesDimensionOrganization
Number

Pulse 360 Feed~
back

Organization NameYesDimensionOrganization
Name

Pulse 360 Feed~
back

Job NameYesDimensionJob NamePulse 360 Feed~
back

CountryYesDimensionCountryPulse 360 Feed~
back
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Created OnYesDimensionCreated OnPulse 360 Feed~
back

Updated OnYesDimensionUpdated OnPulse 360 Feed~
back

Pulse 360 QuestionYesDimensionPulse 360
Question

Pulse 360 Feed~
back

Pulse 360 ResponseYesDimensionPulse 360 Re~
sponse

Pulse 360 Feed~
back

Pulse 360 Question TypeYesDimensionPulse 360
Question Type

Pulse 360 Feed~
back

Positive Response CountYesMetricPositive Re~
sponse Count

Pulse 360 Feed~
back

Negative Response CountYesMetricNegative Re~
sponse Count

Pulse 360 Feed~
back

Keyword Response CountYesMetricKeyword Re~
sponse Count

Pulse 360 Feed~
back

Positive Response Percent for YesNo QuestionYesMetricPositive Re~
sponse Percent

Pulse 360 Feed~
back

for YesNo
Question

Negative Response Percent for YesNo QuestionYesMetricNegative Re~
sponse Percent

Pulse 360 Feed~
back

for YesNo
Question

Note: Analytics will calculate the pulse score for the historical feedback data based on the feedback received for
the selected date/date-range for the report. This will not essentially match the pulse score shown on the UI for that
particular date since the pulse score on the application considers all the latest feedback up to the selected date (which
could be outside of date range selected).
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The Pulse 360 Feedback attributes allow the performance admin to extract responses from Pulse 360 question and also
provide the historical context to how the score has changed over a period of time.

Profile

These are new attributes.

This section describes the attributes that have been added under the Profile reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 87: Profile Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Assessment CommentNoDimensionAssessment
Comment

Person Skills

Assessment Comment Added ByNoDimensionAssessment
Comment Ad~
ded By

Person Skills

Assessment Comment Added OnNoDimensionAssessment
Comment Ad~
ded On

Person Skills

Assessment Comment SourceNoDimensionAssessment
Comment
Source

Person Skills

User's preference about receiving Plan Summary
Email Digest which can be No Mail, Weekly
Mail or Monthly Mail

NoDimensionPlan Summary
Email Digest
Preference

Person Details

Type of business of an external organizationNoDimensionPerson Organiz~
ation Type of
Business

Person Organiz~
ation

Job Code defined for Job assigned to a PersonNoDimensionPerson Job
Type Job Code

Person JobType
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Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports.

Performance

These are new attributes.

This section describes the attributes that have been added under the Performance reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 88: Performance Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Goal Progress Audit Component NameNoDimensionGoal Progress
Audit Compon~
ent

Goal Progress
Audit Details

Goal Progress Audit Reason for Audit entryNoDimensionGoal Progress
Audit Reason

Goal Progress
Audit Details

Old Value of Goal Progress attributeNoDimensionGoal Progress
Audit Old
Value

Goal Progress
Audit Details

New Value of Goal Progress attributeNoDimensionGoal Progress
Audit New
Value

Goal Progress
Audit Details

Date on which Goal Progress audit was doneNoDimensionGoal Progress
Audit Created
Date

Goal Progress
Audit Details

Date and Time for Goal Progress Audit entryNoDimensionGoal Progress
Audited On

Goal Progress
Audit Details

(MM/DD/YYYY
HH:MI:SS)

Name of Goal Progress attribute which was
audited

NoDimensionGoal Progress
Audit Attribute

Goal Progress
Audit Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Full name of the person who changed value of
Goal Progress attribute

NoDimensionGoal Progress
Audit Created
By (Full Name)

Goal Progress
Audit Details

Audit action for which audit entry was addedNoDimensionGoal Progress
Audit Descrip~
tion

Goal Progress
Audit Details

Username of the person who changed value of
Goal Progress attribute

NoDimensionGoal Progress
Audit Created
By (Username)

Goal Progress
Audit Details

Fullname of the Proxy user who changed value
of Goal Progress attribute

NoDimensionGoal Progress
Audit Proxy
Full Name

Goal Progress
Audit Details

Username of the Proxy user who changed value
of Goal Progress attribute

NoDimensionGoal Progress
Audit Proxy
User Name

Goal Progress
Audit Details

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports.

Compensation

These are new attributes.

This section describes the attributes that have been added under the Compensation reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 89: Compensation Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Plan Cycle Audit Component NameNoDimensionPlan Cycle
Audit Compon~
ent

Plan Cycle
Audit Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Plan Cycle Audit Reason for Audit entryNoDimensionPlan Cycle
Audit Reason

Plan Cycle
Audit Details

Old Value of Plan Cycle attributeNoDimensionPlan Cycle
Audit Old
Value

Plan Cycle
Audit Details

New Value of Plan Cycle attributeNoDimensionPlan Cycle
Audit New
Value

Plan Cycle
Audit Details

Date on which Plan Cycle audit was doneNoDimensionPlan Cycle
Audit Created
Date

Plan Cycle
Audit Details

Date and Time for Plan Cycle Audit entryNoDimensionPlan Cycle
Audited On

Plan Cycle
Audit Details

(MM/DD/YYYY
HH:MI:SS)

Name of Plan Cycle attribute which was auditedNoDimensionPlan Cycle
Audit Attribute

Plan Cycle
Audit Details

Full name of the person who changed value of
Plan Cycle attribute

NoDimensionPlan Cycle
Audit Created
By (Full Name)

Plan Cycle
Audit Details

Audit action for which audit entry was addedNoDimensionPlan Cycle
Audit Descrip~
tion

Plan Cycle
Audit Details

Username of the person who changed value of
Plan Cycle attribute

NoDimensionPlan Cycle
Audit Created
By (Username)

Plan Cycle
Audit Details

Fullname of the Proxy user who changed value
of Plan Cycle attribute

NoDimensionPlan Cycle
Audit Proxy
Full Name

Plan Cycle
Audit Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Username of the Proxy user who changed value
of Plan Cycle attribute

NoDimensionPlan Cycle
Audit Proxy
User Name

Plan Cycle
Audit Details

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports.

Using the Plan Cycle Audit Details attributes, the Compensation admin will now be able to create and run audit reports
for any compensation plan.

Learning

These are new attributes.

This section describes the attributes that have been added under the Learning reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 90: Learning Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Assessment Question Response EssayNoDimensionAssessment
Question Re~
sponse Essay

Assessment
Results

Note:  Supports the full essay response
while being exported as a CSV file (in case
of data extract report only) and the first 999
characters on the UI.

Question Response EssayNoDimensionQuestion Re~
sponse Essay

Survey And
Evaluations

Note:  Supports the full essay response
while being exported as a CSV file (in case
of data extract report only) and the first 999
characters on the UI.

Question Response EssayNoDimensionQuestion Re~
sponse Essay

Anonymous
Survey

Note:  Supports the full essay response
while being exported as a CSV file (in case
of data extract report only) and the first 999
characters on the UI.
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Question Response EssayNoDimensionQuestion Re~
sponse Essay

Anonymous
Survey as Con~
tent

Note:  Supports the full essay response
while being exported as a CSV file (in case
of data extract report only) and the first 999
characters on the UI.

Is current course part of any Job RoleNoDimensionIs Course in
Role

Courses

Name of the Job Role in which current course is
added

NoDimensionCourse Job
Role Name

Courses

Custom0 field of Class Owner PersonNoDimensionClass Owner
Custom0

Classes

Custom1 field of Class Owner PersonNoDimensionClass Owner
Custom1

Classes

Custom2 field of Class Owner PersonNoDimensionClass Owner
Custom2

Classes

Custom3 field of Class Owner PersonNoDimensionClass Owner
Custom3

Classes

Custom4 field of Class Owner PersonNoDimensionClass Owner
Custom4

Classes

Custom5 field of Class Owner PersonNoDimensionClass Owner
Custom5

Classes

Custom6 field of Class Owner PersonNoDimensionClass Owner
Custom6

Classes

Custom7 field of Class Owner PersonNoDimensionClass Owner
Custom7

Classes

Custom8 field of Class Owner PersonNoDimensionClass Owner
Custom8

Classes
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom9 field of Class Owner PersonNoDimensionClass Owner
Custom9

Classes

Person Type field of Class Owner Person. It will
have values Internal and External.

NoDimensionClass Owner
Person Type

Classes

Display this curricula to LearnerNoDimensionCurricula
Display for
Learner

Curricula De~
tails

Display this curricula to Call CenterNoDimensionCurricula
Display for
Call Center

Curricula De~
tails

Allow self registration on this curriculaNoDimensionCurricula Al~
low self regis~
tration

Curricula De~
tails

Display this certification to LearnerNoDimensionCertification
Display for
Learner

Certification
Details

Display this certification to Call CenterNoDimensionCertification
Display for
Call Center

Certification
Details

Allow self registration on this CertificationNoDimensionCertification
Allow self re~
gistration

Certification
Details

Is current course part of any Job RoleNoDimensionIs Course in
Role

Courses Catalog

Name of the Job Role in which current course is
added

NoDimensionCourse Job
Role Name

Courses Catalog

Is current certification part of any Job RoleNoDimensionIs Certifica~
tion in
JobRole

Certification
Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Name of the Job Role in which current certifica~
tion is added

NoDimensionCertification
Job Role
Name

Certification
Details

Is current Curricula part of any Job RoleNoDimensionIs Curricula
in JobRole

Curricula De~
tails

Name of the Job Role in which current curricula
is added

NoDimensionCurricula Job
Role Name

Curricula De~
tails

Custom0 field of Class Owner PersonNoDimensionClass Owner
Custom0

Classes Catalog

Custom1 field of Class Owner PersonNoDimensionClass Owner
Custom1

Classes Catalog

Custom2 field of Class Owner PersonNoDimensionClass Owner
Custom2

Classes Catalog

Custom3 field of Class Owner PersonNoDimensionClass Owner
Custom3

Classes Catalog

Custom4 field of Class Owner PersonNoDimensionClass Owner
Custom4

Classes Catalog

Custom5 field of Class Owner PersonNoDimensionClass Owner
Custom5

Classes Catalog

Custom6 field of Class Owner PersonNoDimensionClass Owner
Custom6

Classes Catalog

Custom7 field of Class Owner PersonNoDimensionClass Owner
Custom7

Classes Catalog

Custom8 field of Class Owner PersonNoDimensionClass Owner
Custom8

Classes Catalog

Custom9 field of Class Owner PersonNoDimensionClass Owner
Custom9

Classes Catalog
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Person Type field of Class Owner Person. It will
have values Internal and External.

NoDimensionClass Owner
Person Type

Classes Catalog

Description for the ClassNoDimensionBlended
Class De~

Classes Catalog

scription / In~
structor-Led
Class De~
scription /
Remote Lab
Class De~
scription /
Simulation
Class De~
scription /
VoD Class
Description /
Web Based
Class De~
scription /
Virtual
Classroom
Description

Custom0 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom0

Content Details

Custom1 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom1

Content Details

Custom2 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom2

Content Details

Custom3 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom3

Content Details

Custom4 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom4

Content Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom5 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom5

Content Details

Custom6 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom6

Content Details

Custom7 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom7

Content Details

Custom8 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom8

Content Details

Custom9 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom9

Content Details

Person Type field of Content Owner Person. It
will have values Internal and External.

NoDimensionContent
Owner Per~
son Type

Content Details

Name of the Video fileYesDimensionVideo file
Name

Content Details

Size of the Video fileYesDimensionVideo file
Size

Content Details

Date on which video was uploadedYesDimensionVideo Up~
loaded on
Date

Content Details

Time on which video was uploadedYesDimensionVideo Up~
loaded on
Time

Content Details

Full Name of the person who uploaded the videoYesDimensionVideo Up~
loaded By

Content Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Username of the person who uploaded the videoYesDimensionVideo Up~
loaded By
(Username)

Content Details

Indicates whether the is content is evaluation or
not

NoDimensionIs EvaluationContent Details
Catalog

Name of the Video fileYesDimensionVideo file
Name

Content Details
Catalog

Size of the Video fileYesDimensionVideo file
Size

Content Details
Catalog

Date on which video was uploadedYesDimensionVideo Up~
loaded on
Date

Content Details
Catalog

Time on which video was uploadedYesDimensionVideo Up~
loaded on
Time

Content Details
Catalog

Full Name of the person who uploaded the videoYesDimensionVideo Up~
loaded By

Content Details
Catalog

Username of the person who uploaded the videoYesDimensionVideo Up~
loaded By
(Username)

Content Details
Catalog

Custom0 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom0

Content Details
Catalog

Custom1 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom1

Content Details
Catalog

Custom2 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom2

Content Details
Catalog
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom3 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom3

Content Details
Catalog

Custom4 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom4

Content Details
Catalog

Custom5 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom5

Content Details
Catalog

Custom6 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom6

Content Details
Catalog

Custom7 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom7

Content Details
Catalog

Custom8 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom8

Content Details
Catalog

Custom9 field of Content Owner PersonNoDimensionContent
Owner Cus~
tom9

Content Details
Catalog

Person Type field of Content Owner Person. It
will have values Internal and External.

NoDimensionContent
Owner Per~
son Type

Content Details
Catalog

Content Question Response EssayNoDimensionContent
Question Re~
sponse Essay

Module Details

Note:  Supports the full essay response
while being exported as a CSV file (in case
of data extract report only) and the first 999
characters on the UI.

Fullname of the Person who has updated the
transcript entry for Certification Learning Item

NoDimensionCertification
Learning
Item Tran~

Learner Certific~
ation Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

script Up~
dated By
(Fullname)

Username of the Person who has updated the
transcript entry for Certification Learning Item

NoDimensionCertification
Learning
Item Tran~

Learner Certific~
ation Details

script Up~
dated By

Target Date for Certification Progress History.
This will be available for records created post
Update 36

NoDimensionCertification
Progress Tar~
get Date

Learner Certific~
ation Details

Target Date for Curricula Progress History. This
will be available for records created post Update
36

NoDimensionCurricula
Progress Tar~
get Date

Learner Cur~
ricula Details

Fullname of the Person who has updated the
transcript entry for Curricula Learning Item

NoDimensionCurricula
Learning
Item Tran~

Learner Cur~
ricula Details

script Up~
dated By
(Fullname)

Username of the Person who has updated the
transcript entry for Curricula Learning Item

NoDimensionCurricula
Learning
Item Tran~

Learner Cur~
ricula Details

script Up~
dated By

Percentage of Curricula completed by learnerNoMetricCurricula
Compliance
Percentage

Learner Cur~
ricula Details

Total Cost for each order item in the orderNoDimensionOrder Item
Total Cost

Orders and Or~
derItems

Purchase Order amountNoDimensionPurchase Or~
der Purchase

Orders and Or~
derItems

Order
Amount

 | Analytics | 271



DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Amount booked for a Purchase OrderNoDimensionPurchase Or~
der Amount
Booked

Orders and Or~
derItems

Amount paid for the order under a given payment
mode

NoDimensionOrder Pay~
ment
Amount

Orders and Or~
derItems

Count of Courses which are currently in Pending
Registration Status

NoDimensionPending Re~
gistrations

Registration

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports.

Recruiting

These are new attributes.

This section describes the attributes that have been added under the Recruiting reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 91: Recruiting Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Position associated with Job OfferNoDimensionJob Offer Posi~
tion

Job Offer

Date on which Candidate was added to systemNoDimensionCandidate Cre~
ated On

Candidate De~
tails

Custom0 field for Candidate defined on Extern~
alCandidate Component

NoDimensionExternal Can~
didate Custom0

Candidate De~
tails

Custom1 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom1

Candidate De~
tails
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom2 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom2

Candidate De~
tails

Custom3 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom3

Candidate De~
tails

Custom4 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom4

Candidate De~
tails

Custom5 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom5

Candidate De~
tails

Custom6 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom6

Candidate De~
tails

Custom7 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom7

Candidate De~
tails

Custom8 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom8

Candidate De~
tails

Custom9 field for Candidate defined on External
Candidate Component

NoDimensionExternal Can~
didate Custom9

Candidate De~
tails

Custom10 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom10

Candidate De~
tails

Custom11 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom11

Candidate De~
tails

Custom12 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom12

Candidate De~
tails

Custom13 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom13

Candidate De~
tails
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom14 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom14

Candidate De~
tails

Custom15 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom15

Candidate De~
tails

Custom16 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom16

Candidate De~
tails

Custom17 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom17

Candidate De~
tails

Custom18 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom18

Candidate De~
tails

Custom19 field for Candidate defined on Extern~
al Candidate Component

NoDimensionExternal Can~
didate Cus~
tom19

Candidate De~
tails

Region of CandidateNoDimensionCandidate Ca~
reer Site

Candidate De~
tails

Region of Job RequisitionNoDimensionJob Requisition
Career Sites

Job Requisition
Details

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports.

Social

These are new attributes.

This section describes the attributes that have been added under the Social reports model in the Saba application.
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Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 92: Social Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Name of the external Organization to which the
learner who voted for idea belongs

NoDimensionIdea Voter
Company
Name

Idea

Name of the internal Organization to which the
learner who voted for idea belongs

NoDimensionIdea Voter Or~
ganization
Name

Idea

Title of the VideoYesDimensionVideo TitleFile/URL/Video

Number of tags on VideoYesMetricNumber of tags
on Video

File/URL/Video

Count of Ratings for VideoYesMetricCount of Rat~
ings for Video

File/URL/Video

Average Rating for VideoYesMetricAverage Rating
for Video

File/URL/Video

Total views for VideoYesMetricTotal views for
Video

File/URL/Video

Total Video commentsYesMetricTotal Video
comments

File/URL/Video

Name of the Video fileYesDimensionVideo file
Name

File/URL/Video

Size of the Video fileYesDimensionVideo file SizeFile/URL/Video

Date on which video was uploadedYesDimensionVideo Up~
loaded on Date

File/URL/Video

Time on which video was uploadedYesDimensionVideo Up~
loaded on Time

File/URL/Video
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Full Name of the person who uploaded the videoYesDimensionVideo Up~
loaded By

File/URL/Video

Username of the person who uploaded the videoYesDimensionVideo Up~
loaded By
(Username)

File/URL/Video

Name of the Video fileYesDimensionVideo file
Name

Blogs/Work~
space/Chan~
nelVideo

Size of the Video fileYesDimensionVideo file SizeBlogs/Work~
space/Chan~
nelVideo

Date on which video was uploadedYesDimensionVideo Up~
loaded on Date

Blogs/Work~
space/Chan~
nelVideo

Time on which video was uploadedYesDimensionVideo Up~
loaded on Time

Blogs/Work~
space/Chan~
nelVideo

Full Name of the person who uploaded the videoYesDimensionVideo Up~
loaded By

Blogs/Work~
space/Chan~
nelVideo

Username of the person who uploaded the videoYesDimensionVideo Up~
loaded By
(Username)

Blogs/Work~
space/Chan~
nelVideo

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports and
reporting on video meta-data.

System

These are new attributes.
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This section describes the attributes that have been added under the System reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 93: System Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Full name of the person who created surveyNoDimensionSurvey AuthorAnonymous
Pulse Custom
Survey

Date on which Survey closesNoDimensionSurvey Closes
On

Anonymous
Pulse Custom
Survey

Date on which person completed surveyNoDimensionSurvey Com~
pleted On

Anonymous
Pulse Custom
Survey

Name of the content used in SurveyNoDimensionSurvey Content
Name

Anonymous
Pulse Custom
Survey

Description of SurveyNoDimensionSurvey Descrip~
tion

Anonymous
Pulse Custom
Survey

Full response for Essay Type Question in SurveyNoDimensionSurvey Essay
Type Question
Response

Anonymous
Pulse Custom
Survey

Exam ID for Content used in the SurveyNoDimensionSurvey Exam
ID

Anonymous
Pulse Custom
Survey

Date on which Survey ExpiredNoDimensionSurvey Expired
On

Anonymous
Pulse Custom
Survey

Survey ID for Pulse Custom SurveyNoDimensionSurvey IDAnonymous
Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Name of the Pulse Custom surveyNoDimensionSurvey NameAnonymous
Pulse Custom
Survey

Score of the participant in Pulse custom surveyNoDimensionSurvey Parti~
cipant Score

Anonymous
Pulse Custom
Survey

Completion Status of Participant in Pulse Custom
Survey

NoDimensionSurvey Parti~
cipant Status

Anonymous
Pulse Custom
Survey

Comments added for questions in Pulse Custom
Survey

NoDimensionSurvey Ques~
tion Comments

Anonymous
Pulse Custom
Survey

Question ID for Pulse Custom Survey QuestionsNoDimensionSurvey Ques~
tion ID

Anonymous
Pulse Custom
Survey

Response of Participant for Question in Pulse
Custom Survey

NoDimensionSurvey Ques~
tion Response

Anonymous
Pulse Custom
Survey

Sequence in which the participant responded to
questions

NoDimensionSurvey Ques~
tion Response
Sequence

Anonymous
Pulse Custom
Survey

Time take to respond question in Pulse Custom
Survey (in HH:MI:SS)

NoDimensionSurvey Ques~
tion Response
Time

Anonymous
Pulse Custom
Survey

Question Text for Pulse Custom SurveyNoDimensionSurvey Ques~
tion Text

Anonymous
Pulse Custom
Survey

Type of Question in Pulse Custom SurveyNoDimensionSurvey Ques~
tion Type

Anonymous
Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Question weight for question in Pulse Custom
Survey

NoDimensionSurvey Ques~
tion Weight

Anonymous
Pulse Custom
Survey

Rating given for Scale Type Questions in Pulse
Custom Survey

NoDimensionSurvey Rating
for Scale Type
Questions

Anonymous
Pulse Custom
Survey

Section score summary rating for Pulse Custom
Survey

NoDimensionSurvey Section
Score Summary
Rating

Anonymous
Pulse Custom
Survey

Section title for Pulse Custom SurveyNoDimensionSurvey Section
Title

Anonymous
Pulse Custom
Survey

Date on which survey will be availableNoDimensionSurvey Start
Date

Anonymous
Pulse Custom
Survey

Status of the Pulse Custom SurveyNoDimensionSurvey StatusAnonymous
Pulse Custom
Survey

Date on which Survey was assigned to parti~
cipant

NoDimensionSurvey Submit~
ted On

Anonymous
Pulse Custom
Survey

Summary Score rating for Pulse Custom SurveyNoDimensionSurvey Sum~
mary Score
Rating

Anonymous
Pulse Custom
Survey

NoMetricAverage Points
for Survey
Question

Anonymous
Pulse Custom
Survey

NoMetricAverage Sur~
vey Score

Anonymous
Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

NoMetricAverage Sur~
vey Section
Score

Anonymous
Pulse Custom
Survey

NoMetricHighest Survey
Score

Anonymous
Pulse Custom
Survey

NoMetricHighest Survey
Section Score

Anonymous
Pulse Custom
Survey

NoMetricLowest Survey
Score

Anonymous
Pulse Custom
Survey

NoMetricLowest Survey
Section Score

Anonymous
Pulse Custom
Survey

NoMetricSurvey % Re~
sponse

Anonymous
Pulse Custom
Survey

NoMetricSurvey Aver~
age Rating For
Scale

Anonymous
Pulse Custom
Survey

NoMetricSurvey Re~
sponse Count

Anonymous
Pulse Custom
Survey

NoMetricSurvey Section
Score Summary
Rating

Anonymous
Pulse Custom
Survey

NoMetricSurvey Sum~
mary Rating

Anonymous
Pulse Custom
Survey Scale Maxim~

um Score
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

NoMetricSurvey Sum~
mary Rating

Anonymous
Pulse Custom
Survey Scale Minimum

Score

NoMetricSurvey Sum~
mary Score
Rating

Anonymous
Pulse Custom
Survey

NoMetricSurvey Total
Participants

Anonymous
Pulse Custom
Survey

NoMetricSurvey Total
Students Re~
sponded

Anonymous
Pulse Custom
Survey

Full name of the person who created surveyNoDimensionSurvey AuthorPulse Custom
Survey

Date on which Survey closesNoDimensionSurvey Closes
On

Pulse Custom
Survey

Date on which person completed surveyNoDimensionSurvey Com~
pleted On

Pulse Custom
Survey

Name of the content used in SurveyNoDimensionSurvey Content
Name

Pulse Custom
Survey

Description of SurveyNoDimensionSurvey Descrip~
tion

Pulse Custom
Survey

Full response for Essay Type Question in SurveyNoDimensionSurvey Essay
Type Question
Response

Pulse Custom
Survey

Exam ID for Content used in the SurveyNoDimensionSurvey Exam
ID

Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Date on which Survey ExpiredNoDimensionSurvey Expired
On

Pulse Custom
Survey

Survey ID for Pulse Custom SurveyNoDimensionSurvey IDPulse Custom
Survey

Name of the Pulse Custom surveyNoDimensionSurvey NamePulse Custom
Survey

Score of the participant in Pulse custom surveyNoDimensionSurvey Parti~
cipant Score

Pulse Custom
Survey

Completion Status of Participant in Pulse Custom
Survey

NoDimensionSurvey Parti~
cipant Status

Pulse Custom
Survey

Comments added for questions in Pulse Custom
Survey

NoDimensionSurvey Ques~
tion Comments

Pulse Custom
Survey

Question ID for Pulse Custom Survey QuestionsNoDimensionSurvey Ques~
tion ID

Pulse Custom
Survey

Response of Participant for Question in Pulse
Custom Survey

NoDimensionSurvey Ques~
tion Response

Pulse Custom
Survey

Sequence in which the participant responded to
questions

NoDimensionSurvey Ques~
tion Response
Sequence

Pulse Custom
Survey

Time take to respond question in Pulse Custom
Survey (in HH:MI:SS)

NoDimensionSurvey Ques~
tion Response
Time

Pulse Custom
Survey

Question Text for Pulse Custom SurveyNoDimensionSurvey Ques~
tion Text

Pulse Custom
Survey

Type of Question in Pulse Custom SurveyNoDimensionSurvey Ques~
tion Type

Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Question weight for question in Pulse Custom
Survey

NoDimensionSurvey Ques~
tion Weight

Pulse Custom
Survey

Rating given for Scale Type Questions in Pulse
Custom Survey

NoDimensionSurvey Rating
for Scale Type
Questions

Pulse Custom
Survey

Section score summary rating for Pulse Custom
Survey

NoDimensionSurvey Section
Score Summary
Rating

Pulse Custom
Survey

Section title for Pulse Custom SurveyNoDimensionSurvey Section
Title

Pulse Custom
Survey

Date on which survey will be availableNoDimensionSurvey Start
Date

Pulse Custom
Survey

Status of the Pulse Custom SurveyNoDimensionSurvey StatusPulse Custom
Survey

Date on which Survey was assigned to parti~
cipant

NoDimensionSurvey Submit~
ted On

Pulse Custom
Survey

Summary Score rating for Pulse Custom SurveyNoDimensionSurvey Sum~
mary Score
Rating

Pulse Custom
Survey

NoMetricAverage Points
for Survey
Question

Pulse Custom
Survey

NoMetricAverage Sur~
vey Score

Pulse Custom
Survey

NoMetricAverage Sur~
vey Section
Score

Pulse Custom
Survey

NoMetricHighest Survey
Score

Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

NoMetricHighest Survey
Section Score

Pulse Custom
Survey

NoMetricLowest Survey
Score

Pulse Custom
Survey

NoMetricLowest Survey
Section Score

Pulse Custom
Survey

NoMetricSurvey % Re~
sponse

Pulse Custom
Survey

NoMetricSurvey Aver~
age Rating For
Scale

Pulse Custom
Survey

NoMetricSurvey Re~
sponse Count

Pulse Custom
Survey

NoMetricSurvey Section
Score Summary
Rating

Pulse Custom
Survey

NoMetricSurvey Sum~
mary Rating

Pulse Custom
Survey

Scale Maxim~
um Score

NoMetricSurvey Sum~
mary Rating

Pulse Custom
Survey

Scale Minimum
Score

NoMetricSurvey Sum~
mary Score
Rating

Pulse Custom
Survey

NoMetricSurvey Total
Participants

Pulse Custom
Survey
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

NoMetricSurvey Total
Students Re~
sponded

Pulse Custom
Survey

Owner name for the Prescriptive Rule.NoDimensionPrescriptive
Rule Owner

Prescription
Rules

Note:  Reports created using the attributes from the Anonymous Pulse Custom Survey entity will show data only
when at least three or more people have completed the Anonymous Pulse survey.

Customers can now pull these new attributes (Dimensions/Metrics) while creating or updating the Analytics reports and
reporting on video meta-data.

Exceptions

These are new exceptions.

This section lists the exceptions that you can add to reports using the Configure exceptions page.

Table 94: Exception Details

Filter Default ValuesOperatorFilters
Attributes
Used

DescriptionException
Name

Group
Name

Open, Closed, CancelledInStatus Type
Description

This report displays the users who
have not been assigned any goals

Not As~
signed Any
Goals

Goal De~
tails

EqualGoal TitleThis report displays the users who
have not been assigned a selected
goal

Not As~
signed a
Goal

Goal De~
tails

Open, Closed, CancelledInStatus Type
Description

This report displays the users who
have not been assigned a selected
goal

Not As~
signed a
Goal

Goal De~
tails

Adding this exception group gives
all those who have not registered
for a course

Pending re~
gistrations
for Course

Courses
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Filter Default ValuesOperatorFilters
Attributes
Used

DescriptionException
Name

Group
Name

Adding this gives all those who
have not registered for a class

Pending re~
gistrations
for Class

Courses

Adding this gives all those who
have not completed despite regis~

Pending
completion
by Course

Courses

tration for the course AND all
those who have completed since
they haven’t been registered for the
course

The certificate title and the selected
certification statuses are used as

Unassigned
Certification

Certifica~
tions

exclusion criteria to present the
data representing those who have
not been assigned this certificate.

The curricula title and the selected
curricula statuses are used as exclu~

Unassigned
Curricula

Curricula

sion criteria to present the data
representing those who have not
been assigned this certificate.

You can now use these exceptions while creating reports where you have the ability to report on data facts that are NOT
EXISTING in the recorded storage.

Additional extended custom fields

These are new extended custom fields.

The section indicates where you can find the extended custom fields listed. They will appear just above the Metrics
towards the bottom of the attribute list in the respective entity. These fields will show the data as per the UI Configuration
i.e. if the extended custom field is configured as Date, it will show the date data in current user's date format.

Note:  Extended custom fields cannot be used as filters.

Analytics provide rich text support for extended custom fields.
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Table 95: Component Details

Entity NameComponent Name

Candidate DetailsExternalCandidate

N/A

New operator (Logged-in Person's Organization)

This is a new operator.

The following operator has been added for the Organization Name filter:

• Logged-in Person's Organization

Figure 43: Logged-in Person's Organization

You do not need to explicitly add a person's organization name. You can now use this new operator. Selecting this
operator will use the Logged-in Person's Organization name as the filter value.
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Updated Attributes

Learning

N/A

This section describes the updated attributes under the Learning reports model in the Saba application.

Attributes that support full description
This section lists the attributes that show first 1000 characters in Flatlist, Grouped or Crosstab report. When they are
added to Data Extract report and CSV is exported from that report, you can get all the data entered into these fields from
the UI.

Table 96: Attributes Details

Attribute NameEntity NameParent Entity
Name

Prerequisite Course DescriptionCoursesLearning

Course DescriptionCourses CatalogLearning

Subscription DescriptionOrders and Order ItemsLearning

Certification DescriptionCertification DetailsLearning

Certification Learning Item DescriptionCertification DetailsLearning

Curricula DescriptionCurricula DetailsLearning

Curricula learning item descriptionCurricula DetailsLearning

Blended Class Description / Instructor-Led Class Description / Remote Lab
Class Description / Simulation Class Description / VoD Class Description
/ Web Based Class Description / Virtual Classroom Description

Classes CatalogLearning

 | Analytics | 288



Attributes that do not support full description
This section lists the attributes that will continue to show the same data as they are showing currently. If user wants to
see the full data, then the user can use the attributes with same name present under Catalog group entities i.e. Courses
Catalog and Classes Catalog respectively.

Table 97: Attributes Details

Attribute NameEntity NameParent Entity
Name

Course DescriptionCoursesLearning

Blended Class Description / Instructor-Led Class Description / Remote Lab
Class Description / Simulation Class Description / VoD Class Description
/ Web Based Class Description / Virtual Classroom Description

ClassesLearning

Customers can pull these new attributes while creating or updating the Analytics reports.

Social

The following entity names / attributes are renamed:

Entity name:

• File/URL

Attributes:

File or URL Description 

File or URL Domain

File/URL flagged by

File/URL flagged on

Reason for flagging File/URL

Is File/URL flagged

File/URL certified by

File/URL certified on

Is File/URL certified

Social resource state File/URL
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File/URL Viewed By

File Version Number

File Version Created By

File Version Status

Is File Version Current

File/URL Created On Date

File/URL Updated On Date

File Comment Text

File Commented By

This section describes the updated attributes under the Social reports model in the Saba application.

Updated Attribute NameCurrent Attribute NameEntity NameParent Entity

File/URL/Video DescriptionFile or URL Description File/URL/VideoSocial

File/URL/Video DomainFile or URL DomainFile/URL/VideoSocial

File/URL/Video flagged byFile/URL flagged byFile/URL/VideoSocial

File/URL/Video flagged onFile/URL flagged onFile/URL/VideoSocial

Reason for flagging
File/URL/Video

Reason for flagging
File/URL

File/URL/VideoSocial

Is File/URL/Video flaggedIs File/URL flaggedFile/URL/VideoSocial

File/URL/Video certified byFile/URL certified byFile/URL/VideoSocial

File/URL/Video certified onFile/URL certified onFile/URL/VideoSocial

Is File/URL/Video certifiedIs File/URL certifiedFile/URL/VideoSocial

Social resource state
File/URL/Video

Social resource state
File/URL

File/URL/VideoSocial

File/URL/Video Viewed ByFile/URL Viewed ByFile/URL/VideoSocial

File/Video Version NumberFile Version NumberFile/URL/VideoSocial

File/Video Version Created
By

File Version Created ByFile/URL/VideoSocial
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Updated Attribute NameCurrent Attribute NameEntity NameParent Entity

File/Video Version StatusFile Version StatusFile/URL/VideoSocial

Is File/Video Version Cur~
rent

Is File Version CurrentFile/URL/VideoSocial

File/URL/Video Created On
Date

File/URL Created On DateFile/URL/VideoSocial

File/URL/Video Updated On
Date

File/URL Updated On DateFile/URL/VideoSocial

File/Video Comment TextFile Comment TextFile/URL/VideoSocial

File/Video Commented ByFile Commented ByFile/URL/VideoSocial

N/A

Compensation

The following attributes used to display data in the English locale only:

• Compensation Code
• Plan Name
• Compensation Category
• Dimension Modified
• List of Dimensions Modified

The following attributes now display localized data:

Attribute NameEntity NameParent Entity

Compensation CodeCompensation Cycle DetailsCompensation

Plan NameCompensation Cycle DetailsCompensation

Compensation CategoryPerson Compensation Cycle DetailsCompensation

Dimension ModifiedPerson Compensation Cycle DetailsCompensation

List of Dimensions ModifiedPerson Compensation Cycle DetailsCompensation

Compensation admin will be able to add locale for their different regions.
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Assessment

Search enhancements for tests, surveys and questions

Searching for questions with Question field as the only criteria in a test or survey question pools took a long time when
the number of questions in the pool were large. Additionally, the test/survey search experience in Manage Test &
Survey was not consistent with question search in assessments.

This update enhances the test and survey question search to provide a consistent search experience for all assessment
types as follows:

Enhancements to search in Test/Survey Question Pool
Saba Cloud provides the following enhancements to search in Test/Survey Question Pool:

• Displays the selected question folder by default in the Folder Name dropdown list. You can select a different folder
anytime later.

• Introduces the Include questions from sub-folders checkbox as a question search criteria. If this checkbox is selected
during the question search, then Saba Cloud searches for the matching test or survey questions even in all sub-folders
of the selected folder. By default, this checkbox is not selected.

• If the search is performed using Question field as the only criteria, then Saba Cloud now displays the following
warning message:

In addition to specifying question text, select a folder from the search criteria to narrow down your search results
and speed up search. Click OK to proceed, else click Cancel.

Clicking the OK button proceeds the search based on the specified criteria. However, clicking the Cancel button
lets you change the search criteria and perform a fresh search.

If there are a large number of questions in the test or survey question pool, then performing a search with only
Question as the criteria slows down the search. Therefore, it is recommended that you select a folder as well to
narrow down your search results and speed up search.

• Adds a new Note search filter, which allows searching test or survey questions by notes.
• Hides the Author column in the search results table by default.
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Figure 44: Question search enhancements in Test/Survey Question Pool

Enhancements to search in Manage Test & Survey

Saba Cloud provides the following enhancements to search in Manage Test & Survey:

• Adds the following new search filters to the Advanced Search:

• Folder
• Type
• Status
• Description
• Author

• Adds the following new columns in the search results table:

• ID
• Folder - This column is hidden by default.
• Updated On

• Hides the Author column in the search results table by default.
• Adds the Include questions from sub-folders checkbox as a question search criteria. If this checkbox is selected

during the question search, then Saba Cloud searches for the matching test or survey questions in all sub-folders of
the selected folder. By default, this checkbox is not selected.

Figure 45: Search enhancements in Manage Test & Survey
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Figure 46: Question search enhancements in Manage Test & Survey

Note: These search enhancements are applicable to both Learning and Recruiting tests, surveys, or questions.

The test, survey and question search in assessments needs to be enhanced so that it provides better usability and
performance.

Learning Activity

Add video content to courses using course wizard

Prior to this update, videos hosted by content providers such as Panopto could not be added as formal learning to courses
through the quick online course creation wizard. They could be added to course as activities only through the Activities
tab during standard course creation steps.

With this update, Saba Cloud provides support to import video content of content providers such as Panopto to courses
through the quick online course creation wizard so that learners can access such videos as formal learning.

Prerequisite

For this functionality to work, the relevant content provider must be already configured and enabled.

Adding a video as an activity to a quick online course:

To add a video as an activity through the quick online course wizard, learning administrators must:

1. Go to Learning > Manage Learning Catalog > Learning Catalog.
2. Either search for an existing course or create a new course.
3. If you are adding the video to a new course, then:

a. Click the New Catalog Item link.
b. Click the Online Course link. The course wizard appears.
c. Add course information and class information and proceed to add activities.

4. On the Activities page, select Content from the Add Activity field.
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5. Select the New Content option.
6. Select the Video Content option.
7. Select the required content provider from the Content Provider dropdown list.

Figure 47: Add video content as an activity using course wizard

8. Click the Choose file button to add the required video. The Select Video popup page opens.
9. Either click Upload tab to upload a new video or click Choose tab to select an existing video.
10. Click Upload.
11. On the Activities page, click the Add button. If the upload is successful, then the Activity Details popup page

appears; else, the wizard displays an error message.
12. Add the required activity details and click Save. The selected video content is added as an activity to the course.

The quick online course creation wizard needs to be enhanced so that learning administrators can quickly to add videos
while creating a course.

Handle deletion of Saba Meeting event in a class session

If a Saba Meeting administrator deleted a Saba Meeting event for a past, ongoing or future virtual session of a class or
a recording for a past event, and if users tried to access the details page for the class, then Saba Cloud did not display
the activity section to users.

With this update, if a Saba Meeting event for a past, ongoing or future virtual session of a class or a recording for a past
event is deleted, then users can still view the activity section of the class details page. However, the Attend or Playback
link is not displayed to users for such a session whose event or even recording is deleted.

Learning administrators can also access the Activities tab of the class whose virtual session's Saba Meeting event is
deleted.

Additionally, this update fixes the behavior of the View Summary popup page from the following workflows:

• My Plan
• My Plan > Calendar View > Click on deleted events > Activities Popup
• My Plan > To Do List View
• My Plan > Completed Learnings
• Home tab > My Learning portlet
• Course Details Page
• Certification/Curriculum Details page
• Global Search
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There is a need to modify the integration of Saba Meeting with Saba Cloud such that even if a Saba Meeting event or
an event recording is deleted, then learners can still view the activity section for the class and download documents and
WBT content.

Edit Is Sensitive field while updating a course

Prior to this update, the Is Sensitive field in a course became non-editable once a course was created, thereby preventing
learning administrators from changing its value post creation.

With this update, Saba Cloud makes the Is Sensitive field editable even after course creation. That is, learning
administrators can change the value of the field while updating the course.

Changing a course from sensitive to insensitive and vice-versa after course creation has the following effects:

• Changing a course from sensitive to insensitive:

• Cannot create a group, although course is not sensitive now.
• Notifications, which were not available for sensitive course, are now made available.
• The course now appears in all workflows where it was earlier hidden.

• Changing a course from insensitive to sensitive:

• If the course or its classes have associated groups, then all such groups are made inactive.

Note:  However, such inactive groups are visible and members can be added to them.

• Sensitive notifications are hidden for the course and its associated classes.
• The course is hidden in all workflows where it was earlier available.

Learning administrators often find the need to mark a course as sensitive and vice-versa after the course is created.

One click registration for external users

Saba Cloud did not support one-click registration of certification/curriculum for external users even when the total price
of order was zero but when pricing was enabled. Instead, users were redirected to the normal registration flow.

With this update, Saba Cloud supports one-click registration of certification/curriculum for external users when the total
price of order is zero, even when pricing is enabled.

So, if the final price of an order after discount is zero, then external users are not redirected to the normal registration
flow; rather, they are directly registered for the certification/curriculum and shown the confirmation window.

Note:  Only implicitly calculated discounts are considered for the final price of an order. Promotion codes that
require a coupon code to be explicitly provided by the user, are not considered.
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External users were not able to realize the full benefits of the application as one-click registration was not available to
them while registering for certifications and curricula.

Control the display of custom course fields during bulk registration

Prior to this update, Saba Cloud allowed learning administrators to determine if custom fields must be displayed to users
during registration of a particular course using the course-level setting Show custom fields during registration..
However, bulk registration workflows did not support this ability. For all bulk order workflows for learner and manager,
the custom fields popup page was displayed only if the Enable order custom fields for Learner and Manager setting
was enabled for Orders service. It was not dependent on the course-level setting though.

For Registrars creating bulk orders, the custom fields popup page was displayed only if the custom fields were enabled
at the component level; this was governed neither by a course-level setting nor a system level setting.

With this update, for all bulk order workflows for learner and manager, the course custom fields popup page is now
dependent on both the course-level setting and system-level setting.

• For learner and managers:

• If an enrollment contains a single class or course, then Saba Cloud displays the custom fields popup page only
if Enable order custom fields for Learner and Manager setting is enabled and the Show custom fields during
registration checkbox is selected for the course in the enrollment.

• If an enrollment contains multiple classes or courses, then Saba Cloud displays the custom fields popup page
only if Enable order custom fields for Learner and Manager setting is enabled and the Show custom fields
during registration checkbox is selected for at least one course in the enrollment.

• For Registrars:

• If an order contains a single class or course, then Saba Cloud displays the custom fields popup page only if the
Show custom fields during registration checkbox is selected for the course in the order.

• If an order contains a multiple classes or courses, then Saba Cloud displays the custom fields popup page only
if the Show custom fields during registration checkbox is selected for at least one course in the order.

• For certifications or curricula:

• If a certification or curriculum contains only certifications or curricula and no courses or classes, then Saba Cloud
displays the custom fields popup page only if the Enable order custom fields for Learner and Manager setting
is enabled.

• If a certification or curriculum contains only courses or classes, then Saba Cloud displays the custom fields popup
page only if the Enable order custom fields for Learner and Manager setting is enabled and the Show custom
fields during registration checkbox is selected for at least one course that is selected in the certification or
curriculum.

• If a certification or curriculum contains certifications or curricula and courses or classes, then Saba Cloud displays
the custom fields popup page only if the Enable order custom fields for Learner and Manager setting is
enabled and the Show custom fields during registration checkbox is selected for at least one course that is
selected in the certification or curriculum.

The following bulk registration workflows are affected by this change:

• Placing an order from bulk enrollment (Me, My Team and Registrar)
• Registration for certification or curriculum
• Enrolling for a package
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• Adding to a cart
• One-click registration for certification or curriculum

Learning administrators are forced to enable the custom fields during registration on every course based on the current
parameters of the system. However, users would like the ability to determine which courses trigger the behavior versus
providing an all or nothing solution. This flexibility in turn provides a better workflow and ease of use for those learners
who do not need to fill in the custom fields during registration.

New named queries for learning activities

Prior to this update, Saba Cloud sent notification emails to learners when a completed learning activity on their plan
was reassigned to them.

With this update, Saba Cloud introduces the following named queries for learning activities including courses, recurring
courses, certifications and curricula:

Table 98: New named queries

Applicable NotificationsDescriptionNamed Query

Learner whose learning activity is
complete/acquired

• Course added to profile• Considers certification, curriculum,
and recurring course that are in the • Recurring course added to profile
Acquired status and are not already • Certification added to profile
added to learner's plan Or Granting
Cert / Curr / Recurring Course."

• Curriculum added to profile

• Considers courses that are added
to learner's plan with Successful
completion status OR courses that
are self registered and completed
successfully OR courses that are
self registered and completed and
later archived.

Learner whose learning activity is not
acquired

• Considers certification, curriculum,
and recurring course that are either
in Assigned or In-progress status.

• Considers courses that are assigned
to the learner for the first time
through a source other than self.

• Considers recurring courses that
are either in Expired-Reassigned
or Acquired-Recertification Re~
quired status.

So, administrators can now select the required named query based on the learning activity status and notify learners
accordingly. Saba Cloud triggers the notifications when the learning items are added to a learner's profile for the first
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time. When same learning item is added to a learner's profile again through another source, the notifications are not
triggered and emails are not sent to learners.

Notes

• If a learner is directly registered for a course and the course is completed unsuccessfully and later, if the learner is
assigned the same course through another source, then the "Course added to profile" notification is triggered for the
"Learner whose learning activity is not acquired" named query.

• If a learner directly registered for a class and completed it successfully and later, if the course is added to the learner's
profile, then the notification "Course added to profile" is triggered for successful completion for the "Learner whose
learning activity is complete/acquired" named query.

• If a learner is registered for a course but the course is not added to plan, and later if the learner is assigned the same
course through another source, then the "Course added to profile" notification is triggered for the "Learner whose
learning activity is not acquired" named query.

• If a learner is assigned a certification/curriculum through one source and the certification/curriculum is already on
a learner's plan, and later if the learner is assigned the same certification/curriculum through another source, then
the "Certification added to profile" or "Curriculum added to profile" notification is not triggered for the "Learner
whose learning activity is not acquired" named query.

• If a learner registers for a recurring course and acquires it OR if a learner creates an ad hoc transcript for a recurring
course and later, if the recurring course moves to the Acquired-Recertification Required status, then the "Recurring
course added to profile" notification is triggered for "Learner whose learning activity is complete/acquired" named
query.

There is a need to stop notifying learners when completed learning activities on plan are reassigned.

Create audience type/sub-type on-the-fly for certifications and
curricula

Saba Cloud did not provide the ability to create and retain audience type or audience sub-type on-the-fly while creating
a certification or curriculum.

With this update, Saba Cloud allows learning administrators to create and retain audience type or audience sub-type
on-the-fly while creating a certification or curriculum.

Creating a new audience type or sub type from within a certification or curriculum

To create a new audience type or audience sub-type from within a certification/curriculum:

1. Click Admin > Learning > Manage Learning Catalog > Learning Catalog.
2. Search for the required certification/curriculum.
3. Click the link for the certification/curriculum in the search results. The Certification or Curriculum Details or

page opens.
4. In the Main tab, click the Add Audience Type / Sub Audience Type link. The Select Audience Type / Audience

Sub Type popup page opens.
5. Click either the New Audience Type or New Audience Sub Type link.
6. Specify the required details for the audience type or sub-type.
7. Click the Save button.
8. Define the criteria and save them.
9. Click the Add to the source button. The audience type of sub-type is added to the certification/curriculum.
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Figure 48: Add an audience type or sub type

Retaining an audience type or sub type for future usage

Saba Cloud also provides the Available to Others checkbox while creating an audience type or sub-type in a certification
or curriculum. Enabling this checkbox allows learning administrators to retain the audience type or sub-type for usage
in other certifications or curricula. If disabled, then the audience type or sub-type is not available for use in future and
learning administrators cannot edit it. The default value of this checkbox depends on its related component attribute
default value.

Figure 49: Add an audience type or sub type

Saba Cloud displays the Available to Others checkbox only if your system administrator has enabled the isretained
attribute for the Audience Type or Audience Sub Type component. To enable this attribute, navigate to Admin >
System > Configure System > Services > Audience Type > Components > Audience Type/Audience Sub Type >
Attributes > isretained, and select the Display checkbox. By default, the Display checkbox is disabled, which means
that the Available to Others checkbox is not displayed to learning administrators.

There is a need to create audience type and sub-types while creating a certification or curriculum and retain them for
future usage in other certifications or curricula.

Hide unsuccessful completions from learner's transcript

The My Completed Learning page of learners displayed all of their learning completions, irrespective of they being
successful or unsuccessful and learners did not have the ability to filter out the unsuccessful ones.
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Saba Cloud now provides learners with the option to filter their completed learnings on the My Completed Learning
page based on the learning's completion status.

Learners can view their completed learning by navigating to Me > Completed Learning. They can select one of the
following options:

• Successful
• Unsuccessful
• All

For example, to view only successful completions, select the Successful option from the Status dropdown list. The page
refreshes to display only successful completions. The default selected value of the Status dropdown list depends on the
system configuration, though.

Figure 50: Status filter on My Completed Learning page

Setting the Default value of Status filter

To set the default value of the Status dropdown list on the learner's My Completed Learning page, system administrators
must configure the following new setting under the Transcript service:

• Display default type of completed learning

Select the default type of completed learning to show users on their completed learning page. You can select from
the following options:

• Successful
• Unsuccessful
• All

The default value is All.
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Figure 51: Default value of Status filter

For certain organizations, unsuccessful completed learnings of users are not relevant and they prefer that only successful
completions are displayed on the user's transcript page.

Display for Learner, Display for Call Center, and Self-registration
options for certifications and curricula

The Display for Learner and Display for Call Center checkboxes for a course allowed administrator to control the
visibility of the course. However, these options were not available in both certification and curriculum.

Saba Cloud adds the Display for Learner, Display for Call Center and Allow Self Registration checkboxes to both
certification and curriculum.

These checkboxes are displayed only if the following new setting is enabled by your system administrator:

• Control Display and Registration of Certification/Curriculum for Learners and Registrars
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If this setting is enabled, then the Display for Learner, Display for Call Center, and Allow Self Registration fields
for a certification/curriculum are displayed on the Saba Cloud UI. These fields govern the display and registration
of a certification/curriculum for learners and registrars.

If the value of Allow Self Registration field is set to false when this setting is enabled, then, even after disabling
this setting, learners cannot register for any learning items in the certification/curriculum from within the
certification/curriculum. But, they can register for those learning items outside of the certification/curriculum.

When configured, this setting is applicable to both certifications and curricula. It cannot be configured only for
certifications or only for curricula.

Note: This is a system-level setting and is not domain aware.

The default value of this setting is 'false'.

If this setting is enabled, then it is mandatory to generate the full index for the site.

Note: To generate the full index, submit a support request. For assistance, contact Saba support.

Display for Learner

This checkbox is meant to prevent learners from discovering the certification/curriculum in the system.

If cleared, then the certification/curriculum is hidden from learners in all search areas, including:

• Global Search
• Browse
• Assign Learning
• Add Learning to Goal
• Portlets (Popular Learning, Resources, Featured, Recommendation, and Shared With You)

If a parent certification/curriculum has "Display for Learner" checkbox enabled and its child certification/curriculum
has the checkbox disabled, then the learner can still view the child certification/curriculum from the parent
certification/curriculum.

Display for Call Center

If cleared, then the certification/curriculum is hidden from all registrar and local learning registrar searches.

Figure 52: Display for Learner and Display for Call Center checkboxes

In addition to these two new checkboxes, this update also introduces the following checkbox for certification and
curriculum.

Allow Self Registration

Selecting this option allows learners to register for the certification/curriculum and learning items in it. If disabled, then
learners cannot register for any learning items in the certification/curriculum from within the certification/curriculum.
But, they can register for those learning items outside of the certification/curriculum.
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Figure 53: Allow Self Registration checkbox

If the Allow Self Registration checkbox is disabled for a certification/curriculum, then the View Classes link is not
displayed against the course module. But, if learner clicks any of the module and opens a detailed version of the module,
then the Enroll link is displayed.

By default, the three fields are enabled at the component level.

The three fields support only Silent Auditing. If system administrators try to change Attribute properties for any of these
three attributes, then the following actions are not supported and the attribute continue to behave as per their default
values:

• Change UI Label
• Check / Uncheck "Display" option
• Check / Uncheck "Required" Option

There is a need to control the visibility of certifications and curricula in different searches of learners and registrars, so
that administrators can decide who can register for them.

Remove discontinued courses from learner's plan

When learning administrators discontinued a course, Saba Cloud did no post processing other than discontinuing the
course in the system. For example, neither a discontinued course was automatically removed from learners' plans nor
were the corresponding class registrations dropped. Learners or administrators had to manually perform these tasks post
course discontinuation.

With this update, Saba Cloud allows learning administrators to select different options when they try to discontinue a
course.

Note:  Currently, this feature is not available for recurring courses.

When a learning administrator specifies the Discontinued From date for a course and saves the course, Saba Cloud
displays a popup page with the following options:

Table 99: Discontinue course options

Default ValueDescriptionOption

Off
If this option is selected, then on reaching the Discontinued From
date, the course is removed from learning plans of learners to whom

Remove course from all
plans
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Default ValueDescriptionOption

the course is assigned only if the course is in the Pending Registration
status.

Off
If this option is selected, then on reaching the Discontinued From
date, all class registrations based on the course are dropped for learners
registered for such classes only if:

Drop registrations

• the class registration is not in the Completed status, or
• the class's start date is later than the course's Discontinued From

date.

Off
If this option is selected, then on reaching the Discontinued From
date, all session-based classes are canceled and WBT classes are
discontinued only if:

Cancel/Discontinue classes

• the classes are not marked as Delivered, or
• any class based on the course is completed by the learner, or
• the class's start date is later than the course's Discontinued From

date.

Figure 54: Discontinue course options

By default, none of the options are selected. Administrators can select either a single option or a combination of options
or all of them. Once they select the required options and click the Save and Close button, Saba Cloud processes a
periodic event Course Discontinue Post Activity. System administrators must configure this event to handle the post
processing activities accordingly.

Note:  If no option is selected, then Saba Cloud discontinues the courses, but does no post processing. This is the
behavior prior to this update.

Saba Cloud displays the options every time the Discontinued From date for a course is changed and the changes are
saved. However, after the first change, the options displayed are read-only and administrators cannot modify them. Once
the discontinued course are processed by the notification event, they are not processed again.

Note:  Currently, the ability to specify and perform post activities for discontinued courses is not supported through
bulk data import and REST APIs.
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There is a need to automatically perform certain tasks such as removing courses from the learning plans of learners
when the courses are discontinued. This would eliminate the need for learners or administrators from manually performing
such tasks.

Enhanced View Classes popup page

Prior to this update, the learners had to click the View more link on the View Classes popup page to see classes that
were not shown on the initial page view. However, clicking the link displayed only a limited number of classes out of
the available ones, and learners had to click the link multiple times till they found the required class.

With this update, Saba Cloud enhances the View Classes popup page for learners by replacing the View more link by
pagination at the bottom of the page. When there are a large number of classes, pagination makes the class search easy
for learners. The page displays a scroll bar to view up to 10 classes per page. Learners can click the previous and next
arrow icons to move between pages to toggle betwee pages and view more classes.

Learners can access this page from their My Plan, Course Details, Find More classes, and Continuing Education Credits
pages.

Figure 55: Pagination on View Classes page
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Figure 56: Pagination on View Classes page

Clicking the View more button on the View Classes popup page only showed the learners a limited number of classes
at a time, which hampered usability. By adding pagination to this page, learners can more easily navigate between the
pages to find a specific class.

Add lab sessions to a class activity

Prior to this update, Saba Cloud learning administrators were unable to add LAB sessions as part of their course activity.

From this release, Saba Cloud learning administrators can add and track LAB sessions as part of their course activity.

To create LAB Content, at least one LAB Vendor should be configured.

To add a new content vendor, navigate to:

1. Admin>Learning Home>Manage Content>Content Vendors
2. In Vendor Integration Model select Vendor Type, Customer ID, Password, Access URL and Enroll URL. (all

these fields are required)

Customer ID/Password: these credentials will be used to login to the customer site before any API call.

Enroll URL: Complete URL with tenant name should be provided.

The tenant name should be URL Param. Example: tenant=<tenantName>

Sample Enroll URL: https://<hostname>/?tenant=<tenantName>

This URL will be used to POST Entitlement and Start Entitlement.

Access URL: This URL will be used to launch the content.
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3. Click Save.

Figure 57: New content vendor

In addition, the following details from the user profile are used to register the user: Email, First Name, Last Name and
Organisation. If those fields are left blank, user will have to update them; otherwise, launch will not work.

To add LAB content to Saba content repository:

1. Navigate to Admin>Learning Home>Manage Content>Content Library
2. In the Import Content screen: Enter a Name
3. Select content format LAB
4. Select Active LAB Content Provider
5. Click Next
6. Enter Valid LAB Code
7. Click Verify Code
8. Click Import

Figure 58: Import Content

Figure 59: Import Content - Content Details
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Note:  If the LAB code is not valid, you will not be able to create LAB content.

You are now ready to add content to Class Activity.

1. Navigate to Admin>Learning>Classes
2. Select the Activities tab and click Add Activities

Once the LAB Content is added, you can launch the content for the learner to access. The status will be incomplete till
result is reported back to Saba. To report results the Result report API is used.

Figure 60: Launch content for learners

Note:  For LAB contents – The Time Spent column on the results screen will always show the time spent on the
latest attempt.

When launching the LAB content,  the following APIs are called to construct the Launch URL.

Figure 61: API calls
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Saba Cloud users can add lab sessions as course activity and learners can launch these lab sessions as class activity.

Increased default max count for VLE providers

Prior to this update, the default max count for VLE providers was set to 50 per tenant. To increase this limit, organizations
were required to contact Saba support.

With this update, Saba Cloud increases the default max count for the following VLE providers to 500 per tenant:

• Saba Meeting
• Adobe Connect
• Cisco Webex

The VLE provider max count is updated only for those tenants where the existing max count for the VLE provider was
set to 50 prior to this update. If the max count was set to a value other than 50, then it remains unchanged after this
update.

Administrators are not allowed to enter "<Max Seats on Class> + <Additional Seats for VLE Provider>" value if it is
greater than the max count for VLE provider. If the total value goes beyond the VLE provider max count, then Saba
Cloud displays an appropriate error message.

Note: To increase this limit, submit a support request. For assistance, contact Saba support.

Limitations

• There is no check for the max seat count of blended classes and VLE Provider max count when virtual session is
added to the blended class.

• There is no check for max seat count with respect to the max count on VLE Provider for blended and virtual classes
when the administrator marks a waitlisted learner as Confirmed by increasing the class count.
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There is a need to increase the default max count for VLE providers so that organizations do not need to contact Saba
support for the same.

Registrars and managers can enroll learners to certifications and
curricula

Prior to this update, registrars or managers did not have the ability to enroll learners to certifications or curricula.

With this update, Saba Cloud allows registrars and managers to assign and enroll learners to certifications and curricula.

The order creation wizard for registrars and managers now includes the following new option:

• Assign and enroll certifications and curricula

Selecting this option allows registrars or managers to assign certifications or curricula to learners and automatically
enroll them to the classes in those certifications or curricula. This option supports a maximum of 100 order items,
beyond which the order is considered very large and can affect performance.

This option is applicable only to:

• Certifications and curricula that have one-click learning enabled.
• Both internal and external orders.
• Zero cost orders. This is the effective cost of the order after considering any discounts.

Criteria for selecting Learners in the order

When a person is selected while creating the order, and if the person satisfies certain underlying criteria, then Saba Cloud
internally automatically enrolls the person for the classes in the certification or curricula for which the order is being
placed. When a person is selected in step 2 of the order creation wizard, internally, Saba Cloud searches for blended
programs that match the learner's domain, audience type and profile preferences; that is, it follows the same criteria that
are used during one-click registration. If one and only one such blended program is found, then the enrollment proceeds.
If more than one matching blended programs are found, then the learner is not enrolled.

If any error occurs, then the learner is not enrolled. Saba Cloud displays error and warning messages and registrar or
manager has the option to continue or cancel the order. However, canceling the order removes all learner enrollments
to classes in the certification or curriculum.

Figure 62: New Assign and enroll certifications and curricula option

To assign and enroll certifications and curricula to learners:

1. In the order creation wizard, select the Assign and enroll certifications and curricula option.
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2. In step 1, select the required person as the order contact. (applicable only for registrars)
3. Search for and select one or more certifications and/or curricula.

Note:  Only certifications and curricula having a single path and having one-click registration enabled are
searched.

4. Click Next.
5. In step 2, select on or more learners to whom you want to assign and enroll.

Note:  Learners are added only if they meet certain underlying criteria; else, an appropriate error message is
displayed. When a learner is selected successfully, Saba Cloud internally enrolls the learner to classes in the
selected certification or curriculum.

6. Click Next.
7. In step 3, review your order. The review page displays only assigned certifications and curricula, and not the classes

in those certifications and curricula to which the learners are enrolled.
8. Click the Register button to confirm the order.

Additional UI label changes

As part of this enhancement, the following existing option labels in the order creation wizard are changed:

Table 100: Label changes

New LabelOld Label

Register for classesRegister

Add learning events to planAdd to Plan

However, there is no functional change for these existing options.

Organizations need managers and registrars to automatically enroll learners to classes in certifications and curricula.

Bookmarklet for recording informal learning resources outside of
Saba Cloud

Saba Cloud did not have the support to track informal learning resources taken by users outside of Saba Cloud into a
Learning Record Store.

This update introduces the Bookmarklet (Beta) service in Saba Cloud. Enabling this service enables tracking of informal
learning resources taken by users outside of Saba Cloud in a Learning Record Store (LRS).

System administrators must enable the Bookmarklet (Beta) service under Learning Record Store to activate this
feature. The service is disabled by default.
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Figure 63: Bookmarklet service

LRS Registry

Once the Bookmarklet (Beta) service is enabled, Saba Cloud allows learning administrators to control the informal
activities of users that need to be recorded in the Saba LRS using the LRS registry. A new Manage LRS Registry link
is available under Learning. They can create new LRS records in the registry or search for existing ones. They can use
predefined LRS verbs such as completed, initialized, experienced, passed, and so on to create and search LRS records.

Figure 64: LRS Registry

To create a new LRS record, click the New Record button and specify the required details.

 | Learning | 315



Figure 65: New LRS record

Learning administrators can configure a list of Websites that they want to be registered as informal learning activities
in Saba's LRS. The requests coming from only those Websites that are mentioned in the list, are captured as informal
learning activity in the LRS. For example, if you create a registry record for the URL https://www.mysite.com
but the page URL that you want to track is
https://www.mysite.com/Photography-training-tutorials/, then Saba LRS records the URL
because the parent domain of the site matches the one defined in the LRS registry. However, if you specify the URL as
https://www.mysite.com/Design-training-tutorials/ and try to track
https://www.mysite.com/Photography-training-tutorials/, then Saba LRS does not record this
URL.

For a particular resource of a Website, if the administrator has configured a record to generate a formal learning record
using the Generate Transcript option, then an ad hoc transcript is generated for that user. Users can view such transcripts
under Me > Plan > Learning & Certifications.

Bookmarklet (Beta)

Once the Bookmarklet (Beta) service is enabled, users can see the Bookmarklet widget in their Downloads page.

Figure 66: Bookmarklet widget
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Users can drag and drop the Bookmarklet widget to their browser's bookmarks bar. A Bookmarklet is added to the
bar.

Figure 67: Bookmarklet

Now, if users want to record a particular site activity to Saba LRS, then they must click Bookmarklet in the browser's
bookmark bar when the site is open in their browser. A popup with the Mark Complete action appears. Click Mark
Complete to record the activity to LRS.

Note:  In case of an authentication error, the Saba Cloud login page is displayed to users in a popup page. Once
the users specify their login details and are authenticated, they are redirected to the popup with the Mark Complete
action.

Figure 68: Mark Complete
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Figure 69: Activity added to LRS

Activity Stream

The contributions captured in the LRS are displayed in the user's Activity Stream under Me > Activity > Learning
Activity. The statement format is as follows:

<User Name> <Verb mentioned in LRS Registry> link <URL Name mentioned in LRS
Registry>

Figure 70: Informal activities in Learning Activity stream

There is a need to maintain a Learning Record Store for tracking informal learning activities of users outside of Saba
Cloud.
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E-commerce

Add private video channel or group to subscription

The learning admin had no provision to add video channels or groups to a subscription.

From this update, the learning admin can now add groups and video channel to the subscription. A new Community
detail section has been added on the Subscription details page where you can use Add group link to add groups and
use Add video channel link to add video channels to the subscription. This section appears only when the Social service
is enabled.

Figure 71: Add group and video channel

While creating a subscription, the learning administrator can select the Create group checkbox to create a private group
for the subscription. The administrator can select this checkbox only during the creation. Once the subscription is saved,
a corresponding group will be formed by concatenating the subscription name and the number. The admin will not be
able to set the visibility of this group as it will always be private. The administrator who creates the subscription will
be added as the group owner. The Create group checkbox and Add group is available only when Group service is
enabled. Also, the Add video channel link is available only when the Video channel service is enabled.

If a learner successfully enrolls to such a subscription, then he/she is automatically added to the respective Video Channel
or group. The existing workflow of notifications and access will be used. When the learner's subscription order is
confirmed, the learner is automatically subscribed to all the channels and groups included as a part of the subscription.
Once subscribed, the learner can view the groups and video channels in Me > Groups and Me > Video Channels,
respectively. The same groups and video channels are accessible from Groups tab > Groups Home and Groups tab >
Video Channels. For unassigned users, the channels will be added when a user is assigned to the subscription order. If
a learner is changed for a subscription order, then the original user will be unsubscribed from the channels and groups,
and at the same time the new learner will be subscribed. If a subscription is bought at an organization level, there is no
logic to choose which learners should be subscribed to that group.

If any learner from such an organization wants to access group or video channel, then that learner has to subscribe to
that group from My Subscription screen. A Join button will be shown next to the video channel or group.
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Figure 72: Subscription details page

If the learner's subscription expires or the subscription becomes invalid for any reason, then the learner will be removed
from the video channel or group.

Users will be more eager to purchase a subscription of learning offering, which includes social resources.

Bulk import of states within country

The system administrator had to manually create state entries for each country by navigating to System > Configure
System > Countries > Search for and edit country > New State. There was no provision to import the state details.

From this update, the system administrator ca now bulk import states within each country using a CSV file.

To bulk import states within each country:

1. Log into the application as a system administrator.
2. Navigate to System > Configure System > Countries > Search for and edit country.
3. Click Import States.
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Figure 73: Import States

4. Click Download sample file here button to download the sample file.
5. Edit the file to add the required details of the States that need to be imported.

a. In the CSV file, enter the state details as Name, ISO_Code, and Short_Name.

Note: The CSV file is UTF-8 encoded.

Figure 74: Internationalize icon

b. Save the file.

6. Choose the required file and click Import to begin the import process.

Each country has many states, hence CSV import functionality will help in faster creation of the data.

Currency conversion for class price is dynamic

If a class is created with This Class is available in all the active currencies in the system. multi-currency pricing
option, then whenever the defined and applicable exchange rate is updated, the base price of the class was not getting
updated.
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From this update, the class will pick the latest conversion rate defined in the system. A new setting Update catalog
price based on the updated exchange rate has been added in Orders > Pricing. By default, this setting is disabled.

Figure 75: New setting under Pricing

If this setting is enabled, then whenever the exchange rate is updated, the class price will be updated accordingly. This
is applicable only to those classes for which This Class is available in all the active currencies in the system.
Multi-Currency pricing option is enabled. This update process will be an asynchronous process, as the prices will not
get reflect on real time. The price will not be changed on updating the exchange rate in the following scenarios:

• Added price is not as per the exchange rate
• Base currency is not set
• Price is overridden

This change is applicable for all the catalog across system for the following objects:

• Course
• Delivery Type
• Class
• Package
• Subscription (price and cost limit)
• Training Unit
• Marketing Campaign

The users will now get accurate prices in E-commerce, where exchange rates are defined.
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Country and State fields shown as LOV in organization details

Prior to this update, the Country and State fields were shown as LOV only in the addresses details on the order checkout
page. There was a need to make these fields as LOV across the application.

In this update, the Country and State fields will be shown as LOV only in Internal and External organization address
fields and in Billing addresses.

On internal/external organization's Create and Update pages, the Country field will be shown as LOV. The HR admin
can now select the country and the respective state from the existing list.

Figure 76: Internal Organization details
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If the country has valid states, then the State field will be shown as LOV or it will be shown as text field only. If the
existing data in Country or State contains invalid or incorrect values, then those values will be underlined in red. This
will not mandate the user to change the values but just indicate about invalid values.

Figure 77: Country LOV and State textbox

To facilitate migration of current incorrect values of countries and states, an easy to use migration tool is provided in
System > Configure System > Countries. On clicking Migrate, it detects incorrect country or state names and lets the
admin update the correct values for selected object.

To update incorrect country or state details:

1. Navigate to System > Configure System > Countries.
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Figure 78: Migrate incorrect values

2. Click Migrate. The tool detects all the invalid names in the system for the selected object.

Figure 79: Migrate incorrect values

3. Enter the following details.
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Table 101: Migrate fields

DescriptionField name

Select the object in which the incorrect entries are avail~
able. The options are:

Select Object

• Internal Organization
• External Organization

Enter the token number against which you will make the
changes.

Search Token

Select Country or State whose incorrect entries you need
to update.

Select Type

Select the correct value against each incorrect/invalid
country or state name.

Update correct values

4. Click Update. The updated entry is removed from the list.

This feature will ensure there is consistent data across the system and it improve the integrations with other systems.

Expand Tax API

There was a need to improve Tax integration to send additional information, such as class details, course details,
organization details, and learner custom fields in the API call made to client tax system.

The following attributes are now added to Tax Information and Tax Exemption JSON request:

• Class location address
• Class number
• Class custom fields
• Course title
• Course no
• Course version
• Course custom fields
• Delivery type id
• Delivery type name
• Organization number
• Organization custom fields
• Learner custom fields - In case of an unassigned learner, all these fields will be blank
• Learner username
• Learner person number
• Learner full name

Points to remember
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1. Learner location information is not included since learner addresses are already part of request.
2. Course/subscription/training unit custom fields are sent in customPrimary attributes.
3. Class custom fields are sent in customSecondary attributes.
4. Registration ID is generated only after completion of order, so registration ID is not available while calling the tax

engine.

If the request structure is changed, it will impact existing customers who are using tax service with old structure. Hence,
new properties are introduced under the Tax Configuration properties of the microsite so that the new information will
be sent only if these properties are enabled.

To enable the new properties:

1. Log into the application as a system administrator.
2. Navigate to System > Configure System > Microsites > Search for a select a site whose tax configuration properties

need to be updated.
3. Click Site properties.
4. Click Tax Configuration.
5. Enable the following new properties:

Table 102: New properties in Tax configuration

DescriptionName

Sends the following learner specific details with the tax
request.

Enable Learner's details in Tax Service

• learnerId
• userName
• personNo
• fullName
• customUser
• orgId
• orgName
• customOrg

The possible values are:

• On
• Off

Sends the location of class with the tax request. This
property is applicable for session-based classes only. The
possible values are:

Enable Location of class in Tax Service

• On
• Off

Sends the following class specific details with the tax
request:

Enable details of class in Tax Service

• courseId
• courseTitle
• version class
• No delivery
• TypeId
• deliveryTypeName

 | Learning | 327



DescriptionName

The possible values are:

• On
• Off

Sends the following additional learner related details with
the tax exempt service. These will be part of the new at~

Enable Learner's details in Tax Exempt Service

tribute learnerDetails. This attribute will have the follow~
ing sub attributes like:

• learnerId
• userName
• personNo
• fullName
• personCustom
• orgId
• orgName
• companyCustom

The possible values are:

• On
• Off

Set up an endpoint to send additional tax call whenever
order gets confirmed. The JSON request will have the
following additional attribute:

REST API URL to send tax action on order confirmation

• "orderAction" : "Confirm"

Set up an endpoint to send additional tax call whenever
the payment gets refunded or adjusted. The JSON request
will have the following additional attribute:

REST API URL to send tax action on refund of order

• "orderAction" : "Refund"
• "refundAmount" : 3.2
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Figure 80: New properties of Tax Service

6. Click Save.
7. Click Done. Now if the above properties are enabled, the new details will be sent with the tax request.

Tax Info JSON request (New attributes are highlighted)

{
    "addresses":[
        {
            "zip":"400709",
            "country":"US",
            "addressCode":"SHIP_FROM",
            "city":"400003",
            "region":"MH",
            "line3":"",
            "line2":"line2",
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            "line1":"line 1"
        },
        {
            "zip":"61820",
            "country":"AX",
            "addressCode":"SHIP_TO",
            "city":"Champaign",
            "region":"AS",
            "line3":"",
            "line2":"",
            "line1":"2109 fox dr"
        },
        {
            "zip":"co3bzip",
            "country":"CA",
            "addressCode":"BILL_TO",
            "city":"co3bcity",
            "region":"BC",
            "line3":"",
            "line2":"ADDR2",
            "line1":"co3baddress1"
        },

{
            "zip":"400059",
            "country":"india",
            "addressCode":"00200040",
            "city":"Mumbai",
            "region":"MH",
            "line3":"",
            "line2":"",
            "line1":"address line1"
        }
    ],
    "orderNo":"00209767",
    "custom0":"",
    "custom1":"",
    "custom2":"",
    "lines":[
        {
            "itemCode":"class000000000201088",

"orgId":"cmpny000000000001002",
"courseTitle":"MultiCurrency_Price@Offering",

            "lineNo":"ioreg000000000004941",
"learnerId":"persn000000000001031",

            "billTo":"BILL_TO",
            "currency":"USD",

"personNo":"001031",
"courseId":"cours000000000201439",

            "shipFrom":"SHIP_FROM",
            "amount":30,

"orgName":"Company3",
            "quantity":1,

"customUser":[
                {
                    "custom9":"CTHREE2 Custom 9\t",
                    "custom0":"CTHREE2 Custom0",
                    "custom3":"CTHREE2 Custom3",
                    "custom4":"CTHREE2 Custom4",
                    "custom1":"CTHREE2 Custom1",
                    "custom2":"CTHREE2 Custom2",
                    "custom7":"CTHREE2 Custom7",
                    "custom8":"CTHREE2 Custom8",
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                    "custom5":"CTHREE2 Custom5",
                    "custom6":"CTHREE2 Custom6"
                }
            ],
            "classLocation":"00200040",
            "fullName":"Client2 Three2",
            "userName":"CTHREE2",
            "version":null,
            "customPrimary":[
                {
                    "custom1":"Course custom1",
                    "custom7":"Course custom7"
                }
            ],

"deliveryTypeId":"eqcat000000000000004",
            "deliveryTypeName":"Instructor-Led",
            "customSecondary":[
                {
                    "custom0":"ILT Offering custom0",
                    "custom6":"ILT Offering custom6"
                }
            ],

"classNo":"ILT",
            "customOrg":[
                {
                    "custom0":"co3custom0",
                    "custom3":"co3custom3",
                    "custom4":"co3custom4",
                    "custom1":"co3custom1",
                    "custom2":"co3custom2"
                }
            ],
            "shipTo":"SHIP_TO"
        }
    ],
    "orderDate":"08-18-2016"
}

Tax Exempt JSON request (New attributes are highlighted)

{
    "firstName":"Client2",
    "lastName":"Three2",
    "custom0":null,
    "profileCustom":[
        {
            "custom9":"CTHREE2 Custom 9\t",
            "custom0":"CTHREE2 Custom0",
            "custom3":"CTHREE2 Custom3",
            "custom4":"CTHREE2 Custom4",
            "custom1":"CTHREE2 Custom1",
            "custom2":"CTHREE2 Custom2",
            "custom7":"CTHREE2 Custom7",
            "custom8":"CTHREE2 Custom8",
            "custom5":"CTHREE2 Custom5",
            "custom6":"CTHREE2 Custom6"
        }
    ],
    "shippingAddress":{
        "zip":"61820",
        "country":"AX",
        "addressCode":"SHIP_TO",
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        "city":"Champaign",
        "region":"AS",
        "line3":"",
        "line2":"",
        "line1":"2109 fox dr"
    },
    "custom1":null,
    "custom2":null,
    "personNo":"001031",

"learnerDetails":[
        {
            "orgName":"Company3",
            "learnerId":"persn000000000001031",
            "personCustom":{
                "custom9":"CTHREE2 Custom 9\t",
                "custom0":"CTHREE2 Custom0",
                "custom3":"CTHREE2 Custom3",
                "custom4":"CTHREE2 Custom4",
                "custom1":"CTHREE2 Custom1",
                "custom2":"CTHREE2 Custom2",
                "custom7":"CTHREE2 Custom7",
                "custom8":"CTHREE2 Custom8",
                "custom5":"CTHREE2 Custom5",
                "custom6":"CTHREE2 Custom6"
            },
            "fullName":"Client2 Three2",
            "userName":"CTHREE2",
            "personNo":"001031",
            "orgId":"cmpny000000000001002",
            "companyCustom":{
                "custom0":"co3custom0",
                "custom3":"co3custom3",
                "custom4":"co3custom4",
                "custom1":"co3custom1",
                "custom2":"co3custom2"
            }
        }
    ],
    "username":"CTHREE2"
}

Enabling Order Payment Refunded notification

The users, who are using Webhooks action to achieve additional tax API calls can use Order Payment Refunded
notification. By default, this notification is disabled. The system admin must navigate to System > Configure System
> Services > Orders and enable this notification. This notification will be triggered when an order payment is refunded.
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Figure 81: Order payment refund notification

Some users use tax models that considers the location of the ILT class rather than the location of the user. Also, the
information about the user's organization may also influence the tax rate. Hence, the Tax API has been updated with
more information so that user gets more flexibility in taxing based on their own requirements.

Invoice Me enhancements

If the payment is processed outside of Saba Cloud, then select the Invoice payment option. Specify the required
payment-related details. This invoice data is then referenced by an external system that actually processes your payment.
There was a need to enhance this payment option, by making it configurable and a provision for registrar to approve the
invoice payment before confirming the order.

The following enhancements are made to the Invoice Me payment type:

1. New setting

A new setting Enable Invoice Payment Approval has been introduced under Order > Internal Orders service.
By default, this setting is disabled. When this setting is enabled, all the orders with Invoice payments will be in
Payment Initiated status. Only Registrar will be able to approve such orders from the invoice details.
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Figure 82: New setting for invoice

2. New notification

A new notification Order invoice payment approval pending has been introduced under the Orders service. By
default, this notification is disabled. When its enabled, the notification will be triggered when a new order is created
with an Invoice in the pending payment status.

Figure 83: New notification for invoice

3. Ability to approve invoice payments

The registrar now has the provision to approve the invoice payments for an order. Once the learner buys the course
using an invoice, the order will be moved to Payment Initiated state. The registrar will go to the order details and
approve the payment. Once the payment is approved, the order will be confirmed. If the registrar is not convinced
with the invoice details, then he/she can reject the payment and the order will be cancelled.
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Figure 84: New notification for invoice

4. Enhancements to Invoice form

The Details field on the Invoice form can be configured to be LOV field. The learning admin and registrar can
configure and add default values. By default, this field is mandatory.

Figure 85: Configuration for Details field
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Figure 86: New notification for invoice

Users needed purchasing process to handle the tracking of payments that are not made in Saba. The new enhancements
in invoice fill these gaps.

Make payments to course owner's organization

Prior to this update, when a learner buys any course, the payments are made to the learner's organization instead of the
course owner's organization.

From this update, the admin will be able to configure the microsite in such a way so that the learner can directly make
the payment to the course owner, who owns the content instead of the learner's organization. To support this, the following
changes have been made:

1. New setting

A new setting After registration, make payments to course owner/creator has been added under the E-commerce
service. By default, this setting is disabled. When it is enabled, the catalog admin will be able to select the Microsite
in class and course so that the payments will be made to the organization associated with it.
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Figure 87: New setting under E-commerce

2. Configuration in Microsite

A new checkbox Enable Payment has been added to the Microsite. This checkbox appears only when the above
setting is enabled. By default, this checkbox is disabled. When it is enabled, this Microsite will appear on the course
and class details page.

Figure 88: Configuration at Microsite

3. Configuration at course & class details page

A new Microsite field has been added to the course and class details page under Pricing Information section. This
field appears only when the above setting is enabled. The catalog admin must select the Microsite to which the
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payment will be sent. If a course is created through a wizard, then the Microsite field will not be displayed. This
field appears only on editing the course.

Figure 89: Configuration at class & course details page

The catalog search page is updated by including Microsite as a search filter. By default, this field will not appear.
The admin must enable the new setting to use it as a search filter.

Figure 90: New search filter

When a class is created from a course including a microsite, then the microsite will be inherited to the newly created
class as well.

When a learner purchases such a class, the payment will be made to the selected microsite, regardless of the microsite
associated with the learner's domain and the microsite used by logged-in learner.

This is not applicable to a course in a multiple items order. In such a case, the Payment Goes To field will be ignored
and default payment logic will be used (where it will either consider the microsite associated with the user's domain or
microsite associated with the logged-in user) depending on the configuration. This includes:

• Shopping cart orders with more than one catalog items
• Packages
• Purchase of Curricula/Certification with multiple items
• Registrar purchases where multiple items are chosen in one order
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This is applicable only to the credit card and paypal payments. Due to this, only credit card properties will be picked up
whereas other properties like tax etc, will be picked from the logged-in microsite only. When such a order gets cancelled,
then the refund will be returned to the account from where the initial payments were done. If a learner or a registrar tries
to make the payment later with Add payment flow and all conditions are fulfilled, then the payment will be made to the
selected microsite.

This supports an organization where different business units are creating content and sharing content with all users. The
money for the class should not go to the user's organization but rather to the organization that owns the content.

New notification for pay later functionality

If a user creates an order and chooses to pay later, then a notification is not sent to the user to inform about the complete
payment details.

A new notification Order pay later has been added under System > Configure System > Services > Orders.

Figure 91: New notification to order and pay later

By default, this notification is disabled. When this notification is enabled, then it will be triggered when a user chooses
to make the payment later.

If a user creates an order and completes the payment, they receive a confirmation notification with details on how to
access the course. But if a user creates an order and chooses to pay later, then the Order pay later notification is sent
to the user which includes admin's comments on how to complete the payment and make the content available once the
full payment is received.
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Content

Track number of attempts for unlimited attempts on content

Saba Cloud did not track the learner attempts on content when the number of attempts on the content was set to unlimited.
This resulted into inconsistent data during reporting.

With this update, Saba Cloud tracks learner attempts on content even when the number of attempts on the content is set
to unlimited. Basically, the content attempt count is now tracked irrespective of the attempts set on a content module.

Learner's attempts are counted for both new and existing content where the number of attempts is set to unlimited;
however, learner's attempts on such content made prior to this update are not restored and taken into consideration. So,
the count is not displayed for any such content that was completed prior to this update.

After this change, for content with unlimited attempts the behavior of Content Attempt definition setting is same as
it is for content with limited attempts.

There is a need to report content attempts for content where the number of attempts is unlimited.

Import Panopto videos as SCORM content

Saba Cloud imported videos by content providers such as Panopto as Video content format while adding them to the
content library.

With this update, Saba Cloud allows learning administrators to import Panopto videos as SCORM packages while adding
them to the content library.

To import video as a SCORM package:

1. Click Admin > Learning > Manage Content.
2. Select the required folder.
3. Click the Import link.
4. On the Content Details page:

a. Select Content Format as SCORM Package.
b. Select Content Type as Panopto Video.
c. Select Player Template as Standard Content Player Template.

5. Specify any other details and click Next.
6. On the Import Content page, either select an existing video or upload a new one.
7. Click Save and then click Import.
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The resulting SCORM zip file is stored on the Saba Content Server but the video is served through Panopto.

Note:  Panopto must be configured and enabled by the system administrator.

If Panopto is disabled, and if you try to edit an existing content, then the Upload Video option is disabled so that you
cannot upload a new Panopto video. However, you can edit remaining content details. If you click Preview Content,
then Saba Cloud displays a message indicating that video service is not configured.

Notes

• Video as SCORM content is of SCORM 1.2 format.
• Since the annotation functionalities such as bookmarks, notes, and discussions are provided by Panopto, they are

visible by default and cannot be configured for Video as SCORM content.
• Every attempt on Panopto video SCORM content after a successfully completed attempt is marked as a completed

attempt.
• Currently, Panopto video content is not supported by the Saba Cloud mobile app.

There is a need to import videos by third-party content providers such as Panopto as SCORM packages into Saba's
content library.

Deployed SCORM content support for mobile

Deployed SCORM content imported to the content library was not compatible with mobile devices.

With this update, Saba Cloud now supports mobile device compatibility for Deployed SCORM content imported into
the content library.

Only the following version of Deployed SCORM content format can be imported with mobile compatibility:

• Deployed SCORM 1.2

For newly imported Deployed SCORM 1.2 content, the Mobile Device Compatibility dropdown list is editable. By
default, the value set is Not Compatible, but content administrators can select the required value. For any Deployed
SCORM 1.2 content imported prior to this update, the Mobile Device Compatibility dropdown list value can be modified
by editing the content.
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Figure 92: Mobile Device Compatibility for Deployed SCORM 1.2

Currently, Deployed SCORM 2004 and Deployed SCORM 2004 ED3 formats cannot be imported with mobile
compatibility because these formats are not supported by the Saba Cloud mobile app.

For such content, the Mobile Device Compatibility dropdown list is not editable.

Figure 93: No Mobile Device Compatibility for Deployed SCORM 2004 ED3
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Saba Cloud app on mobile devices supports Deployed SCORM 1.2 content. Therefore, there is a need to support mobile
device compatibility for Deployed SCORM 1.2 content while importing it to the Saba Cloud content library.
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Organizational Chart available under People tab

Prior to this update, the organizational chart was available only under the Me and My Team tabs. It was not available
under the People tab.

With this update, the organizational chart in Saba Cloud is now available under the People tab as well.

To access the organizational chart, click the People link under the People tab. If the corresponding service is enabled,
then the organizational chart appears in the top left-side of the page while the People I'm Following portlet appears
below the chart. If the service is disabled, then the chart is not displayed.

Additionally, this update enhances the look and feel of the organizational chart.

All existing features of the organizational chart remain as they are.

Figure 94: Organizational chart under People tab

Users need to easily find the organizational chart to look up a person in the organization.
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Control access to workspaces

Prior to this update, a workspace in Saba Cloud was accessible to users via the workspace URL, irrespective of the users'
access privileges and irrespective of whether the workspace was shared with them or not.

This update enhances the access control for workspaces in Saba Cloud by introducing a new field.

While creating a workspace, users can now define access control for a workspace by setting the following new field:

• Public Workspace

The value of this checkbox defines whether a workspace is available publicly to all users or it is restricted to selected
users or groups with whom the workspace is shared.

• If selected, then it allows users to access the workspace, irrespective of users or groups listed in the Share with
field.

• If cleared, then it restricts access to the workspace only to users or groups that are listed in the Share with field.

By default, this checkbox is selected. This ensures that existing users who are accessing a workspace can continue
accessing the workspace until the author of the workspace explicitly marks a workspace as secured by clearing the
Public Workspace checkbox.

Figure 95: Public Workspace checkbox

If you want to restrict your workspace to a set of users or groups, then you must edit the workspace and clear the Public
Workspace checkbox. Such a workspace is available only to users or groups with whom you have shared the workspace.
If other users try to access such a private workspace, Saba Cloud displays an "Insufficient Privileges" error message.

In case of a workspace hierarchy, where a parent workspace has one or more levels of child workspaces and pages, the
access is controlled as follows:

• If the parent workspace is private while the child workspace is public, then authorized users can access the child
workspace and see the parent workspace title in hierarchy view. However, clicking the parent workspace title displays
the insufficient privileges error.
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• If a level-1 private child workspace itself has level-2 private child workspaces, then those level-2 child workspaces
are not displayed either. However, if those level-2 child workspaces are public, then authorized users can access
them. But their parent workspace is not displayed.

• If pages under a workspace are shared, then they are available to authorized users, irrespective of the workspace
being public or private. However, private workspace-related details such as workspace title, Welcome page,
Announcement portlet, and Workspace Contacts portlet are not displayed.

• The topmost level (Parent) workspace in a workspace hierarchy is always displayed regardless of it being Public or
not. At other levels second and third, the parent workspace is not displayed if it is not Public and if a user does not
have sharing privileges.

Notes

• Users can add a workspace as a parent or child workspace to any other workspace they own if:

• It is a public workspace
• It is a private workspace but is shared with those users

• While editing a child workspace, its parent workspace is always listed in the Parent Workspace picker field,
irrespective of whether the parent workspace is public or private.

• A private child workspace is not listed in the Child Workspace picker field when:

• Editing a parent workspace
• Adding a child workspace to the parent workspace

• The accessibility of a workspace that is designated as a Wiki or company Intranet under Microsite > Workspace,
is not affected by the Public Workspace checkbox value.

If users have access to a workspace URL, but they are not in a group that has permission to view the workspace, then
they must not be able to access the workspace. This security enhancement allows users to create workspaces for specific
purposes.

Display images and videos inline in group and activity
stream

Prior to this update, any images or videos contributed to Saba Cloud were not displayed inline in the user or group
activity stream. The stream displayed only the image or video title, which users had to click to see the actual image or
video.

Saba Cloud now displays images and videos inline in the user and group activity streams.

Note:  Currently, only embedded videos are displayed inline in the activity stream; uploaded video files are not
displayed.

Inline Images

When users contribute an image using the File option in the Contribute panel, the contributed image is shown inline
as a thumbnail in the Home or Group Activity stream and on the resource details page. On clicking the image, it opens
in the preview screen.
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For images uploaded prior to this update:

• If they supported preview, then they are displayed inline.
• If edited and uploaded again, then they are displayed inline, irrespective of whether they support preview or not.

Figure 96: Inline image in Activity stream

Inline Videos

This update enhances the video contribution ability to include the new Embed option. So, when users click the Video
option in the Contribute panel, Saba Cloud now displays the following two options:

• Embed

Selecting this option displays the Embed code text box along with other regular fields like title, description, and so
on. Users can add the embed code of an external video to this text box. The contributed video is displayed inline in
the Home or Group Activity stream and on the resource details page.

By default, this option is selected.
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Figure 97: Embed option for video contribution

• Upload

The ability to upload videos works as before and there is no functional change to this feature.

Note:  If video integration is not enabled, then just the Embed option is available.

Figure 98: Inline video in Activity stream

Users need to see the thumbnails of images and videos they contribute in their activity stream itself. This helps to avoid
multiple clicks and provides a better user experience.
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Learning Record Store for recording social resource
contributions in Saba Cloud

Prior to this release, Saba Cloud did not have the support to track social resources such as files, links and videos contributed
by users into a Learning Record Store. Only Tin Can statements received from Tin Can content were recorded by the
Learning Record Store.

This update introduces the Social LRS service in Saba Cloud. Enabling this service allows users to track the social
resources they contribute to Saba Cloud in a Learning Record Store (LRS).

System administrators can configure this feature by navigating to System > Configure System > Services and clicking
the Social LRS service under Learning Record Store. The service is disabled by default.

Figure 99: Social LRS service

Recording Contributions

Once the Social LRS service is enabled, when users contribute a social resource such as file, link, and videos to Saba
Cloud, a new Mark Complete link is displayed besides the contributed resource.

User can click the Mark Complete link to record the resource contribution to Saba's LRS. Once clicked, the link for
that resource changes to Marked Complete and is disabled, indicating that the resource is already marked for tacking
in the LRS. If versioning is allowed and if the user versions the resource, then the Mark Complete link is displayed for
the new version of the resource, and the user can record the new version to Saba's LRS.
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Figure 100: Mark Complete link in Activity

Figure 101: Mark Complete link on resource details page

When Social LRS recording is enabled for social resources, Saba Cloud also captures activities for the following actions
on those resources:

• File

• Download
• Preview

For example, a user Charles sees the following statements in his activity stream - Charles downloaded file "Salesforce
document" or Charles previewed file "Salesforce document"

• Link

Launch

For example, a user Jena sees the following statement in her activity stream - Jena launched file "Salesforce document".

Note:  Even if the LRS activity capturing fails due to some reason for activities like Download, Launch or Preview,
the actions are still performed.

Configuring the Display of Mark Complete Link

Note: To enable the feature, submit a support request. For assistance, contact Saba Support.
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Saba Cloud controls whether social resource contributions can be recorded or not to the Saba LRS. By default, Saba
Cloud displays the Mark Complete link for social resources including files, links and videos so that resource contributions
can be recorded.

However, Saba Cloud "admin" users can configure the display of the Mark Complete link using certain site-level
properties for the Learning Record Store. If disabled, then the link is not displayed for a social resource and users cannot
record such resource contributions to the Saba LRS.

Additionally, Saba Cloud provides the ability where only certain resource contributions can be recorded but not all. If
enabled, then resource contributers can decide whether they want to display the Mark Complete link for a resource
they contribute using the Mark as Informal Activity checkbox in the contribution panel under Advanced Settings.
Again, Saba Cloud "admin" users can configure the display of this checkbox using certain site-level properties for the
Learning Record Store.

If the Mark as Informal Activity checkbox is available, then the contributer can select the checkbox while contributing
a resource. If selected, then Saba Cloud displays the Mark Complete link for that resource allowing authorized users
to record the resource contribution to Saba LRS.

Figure 102: Mark as Informal Activity checkbox

By default, the Mark Complete link is displayed while the Mark as Informal Activity checkbox is hidden.

LRS Contributions in Activity Stream

The contributions captured in the LRS are displayed in the user's Activity Stream under Me > Activity > Learning
Activity. The statement format is as follows:

<User Name> <Verb mentioned in LRS Registry> link <URL Name mentioned in LRS
Registry>
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Figure 103: Formal activities in Learning Activity stream

If the Social LRS service is disabled, then the Mark Complete button is not displayed for new and existing resources.
However, the Learning Activity stream continues to show existing feeds.

Note: The Learning Activity feeds do not support locales. For non-English locales, all feeds appear in English
only.

There is a need to maintain a Learning Record Store for tracking informal learning activities of users in Saba Cloud.
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Courses retired in lynda.com should not appear in Saba

Prior to this release, content that were expired or removed from lynda.com catalog were not removed from Saba
Marketplace. When users selected one of these courses, they were facing errors with no specific details.

Starting from this release, content that are retired in lynda.com catalog will be marked as Expired in Saba Cloud. Access
to course created won't be discontinued but any learner who tries to launch content will see an error message.

When Saba performs a sync/bulk import operation with lynda.com, all content offered by lynda.com becomes available
for Saba users. If a subsequent sync operation only shows some of the content and not all imports from the original list,
content that are not available on the second sync are marked as expired by Saba.

Administrators can verify that the content details section under Manage Content show the expired date  that is set by
Saba. (this date is based on the server date and not the sync date).

By marking the content as expired, any confusion regarding the availability of content is eliminated and students will
be in a position to choose alternate courses from an active list.

If a user has already been assigned to a course based on that content and tries to access it, the following error message
will show:

Error occurred, Content is no longer available. You can close the player safely.

When users who are eager to enroll in a course, cannot find it but faces errors, it creates confusion. By providing
meaningful error message and by giving them the details, helps them to plan for alternative options.

Saba Approver can see application details before approval

Prior to this release, when adding and integrating applications into Saba Marketplace, Saba Approvers could not see the
details of the application that they are trying to approve for integration.

In this release, a new interface provides the approvers the capability to launch and view the details of the application
that they are considering to approve to integrate with Saba Cloud.

To view application details:

1. From Admin menu, click  Extended Integration.
2. From the Navigation pane on the side, click on Saba Approvals. Applications are listed by Name, contact Email,

Status and Action columns.
3. Select View from the Actions column.

Figure 104: Saba Approval screen
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A pop-up screen opens and displays the details of the application in read only mode. Saba Approver can view the details
before making a decision to Approve or Reject the integration of that application; however, they cannot edit the content
in the fields.

Figure 105: Application details in non-editable mode

Saba Approvers now have more control over the application content they allow to integrate with Saba Cloud.
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Audit option is available for marketplace configuration
changes

Prior to this release, there were no provisions for capturing configuration changes in Marketplace for published vendors.

In this release, this has been addressed. Audit Details option is added to th configuration screen. After the initial
configuration, changes to all fields are audited except the following:

All vendors:

• Agree to Terms and Conditions field will not be audited.

• Password fields will be audited, but their values will not be visible.

Workday:

Currently, Import and export configurations and mappings are not audited.

To access and view the audit details of the configuration changes for a published vendor:

Navigate to:

Saba Cloud>Admin>Marketplace

From the displayed list of configured vendors, select the vendor name to view audit records of the configuration changes.

The configuration details screen launches.

Figure 106: Configuration screen for Marketplace vendor
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Click on Audit Details to view the details of the configuration changes.

Figure 107: Audit Details of the changes

In the example shown for the password change, the value is not displayed but the Updated By field and the date on
which it was changed are provided.

For the ImportPersonExternal field, the Previous Value, Current Value, Changed by and Updated On field all
provide the details of the change.

Addition of the Audit Details option to Marketplace vendor configuration section provides the capability to track and
analyze changes made to the settings.
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Partner admin can choose which view the microapp should
be available in Saba home page/profile page

Currently Microapps created by a partner admin can be published to home page view and profile page view. The admin
cannot choose where they want the application to be available.

The enhancement in this release enables the partner admin to indicate where they want the microapp to be available.

When creating the microapp, the admin can choose either the Home View option or the Profile View option or both
and based on these selections, the microapp will show on the Home page, Profile page or both pages of the user.

To create a new Micro App:

Navigate to:

1. Admin>Extended Integration>Marketplace Studio>Integration
2. Click on New Micro App link.
3. In the Create Micro App screen enter the details for all required fields and select either the Home View or the

Profile View.
4. Click on Save.

Figure 108: Create Microapp screen

Since you selected the Profile View option, the microapp will be available on the Profile page of the User. If, at a later
time you want to include Home View also, you can click the Edit button on the corresponding MicroApp listing from
the Integration page and select both options.

Partners now have better control over the microapps they create and can make appropriate microapps available in
appropriate views.
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Partners can publish Micro Apps to specific tenants

Currently when a Micro App is published, it gets published to all tenants in Saba Cloud. This limits the ability of the
partners to publish it to a select few. Some applications may be applicable only for a particular vertical or a region.

The enhancement in this release enables the Partner Administrator to indicate which tenant they want the Micro App or
an Integration to be available to. Some applications may be applicable only for a particular vertical or a region. Partner
Administrators can publish their applications and Integrations across Data Centers.

When creating the Micro App, the administrator can select a region North America or EMEA, APAC etc and based
on these selections, the Micro App will be accessible by tenants from those regions only.

To select the tenant to give access to the Micro App:

Navigate to:

1. Admin>Extended Integration>Marketplace Studio
2. Select the  Micro App and click Publish

A pop up screen launches that lists the sites where the Micro App is enabled.

Select the site to publish the Micro App.

Figure 109: Pending Approval for Evaluation

1. Click Add new Site to enter a new site to the list.
2. Click Publish to.

Figure 110: Add New Site to publish the Micro App
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You will see the message that it was published Successfully and the new site will be added to the Data center.

Partners now have better control over the Micro Apps and Integrations they create and can choose and publish them
across Data Centers and to only specific tenants and groups.

Enhancement to the Partner Approval Flow

In the past, partners were not able to control the evaluation flow for Micro Apps and Integrations that they created.

When a Saba Partner receives a request for evaluating a Micro App, the status on the Micro App shows Pending
Approval (Evaluation). Once the partner approves the request and the user starts using the application, the status will
be moved to Configured in Evaluation status.

On evaluation, when an agreement is established between the Partner and the user, the status for the Micro App is moved
to Approved state.

The Evaluate this App option will no longer display once the Evaluate check box is selected.

Partner Approval

To view Micro Apps that are in Pending Approval and to Approve or Reject Micro Apps:

1. Navigate to: Admin>Extended Integration>Marketplace Studio>Integration
2. Click Approval (Partner Approval)
3. A list of Micro Apps with different statuses display.
4. From Actions click on Approve for the Pending Approval (Evaluation). The status is moved to Configured in

Evaluation.
5. Choose Reject if you do not approve the request.

Figure 111: Pending Approval for Evaluation
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Partners will now have a better control over the evaluation process and can choose to approve requests that are only
relevant and applicable for a specific application or integration.

API dashboard available for Micro Apps created in Extended
Integration

N/A

A new API dashboard is available for Partners and Saba Approvers to view and monitor user activity for the Micro
Apps. The dashboard provides access to API data for each Micro App.

Micro App API dashboard

To access the Micro Apps API dashboard:

1. Navigate to: Admin>Extended Integration>MicroApp Dashboard>
2. The dashboard screen launches.
3. Select the Data center name, Site name and the MicroApp name
4. Click Apply.

Figure 112: MicroApp Dashboard Showing API activity
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A summary tab displays the Summary data and the API chart. All successful activities are marked in Green and all
Failed activities are marked in Blue.

Below the chart, a table displays the following: MicroApp name, Data center name, API name, tenant name, Success
Count, and Failure Count.

Error tab details

The Error tab provides the following data:

ID, API Name, Action (Get, Post) Status (failed, passed) Response time and the Request date.

Click on the Id link to launch the details of the API and the error data.

Figure 113: Dashboard with Error Tab
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Saba Partners and Approvers can now view the Micro App API usage information with summary, chart and error logs.
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Add locale to Additional Info section of review form

The performance administrator could only add questions in English in the Additional Info section of the review form
in the review cycle.

The performance administrator can now add questions in the required locales in the Additional Info section of the
review form.

To add questions in required locale:

1. Go to the required review form.
2. Create an Additional Info review section type.
3. First add questions in English locale and save the form.
4. Click the section name and then view the Internationalize icon on the New Question page.

Figure 114: Internationalize icon

5. Click the Internationalize icon.
6. Select a new locale, update the question details in the selected locale, and click Save. The question will be updated

in the selected locale.
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Figure 115:Translate questions in selected locale

The missing localisation support has now been added for Additional Info section specifically Multi-Choice Questions.

Assign skill through PR without any goal

A goal is automatically created and added to user's plan while pushing skills through prescriptive rule (PR).
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Figure 116: Skill and goal assigned via PR

Once the PR is processed, the goal & skill is pushed to the user's plan with a source as PR.

When the administrator tries to remove the skill or respective goal from the PR, then the PR removes ONLY the respective
goal from the user's plan. The skill is not removed.

From this update, when a skill is processed through PR, the goal will not be created automatically and only skill will
get pushed to the user's plan. The skill details will show the PR name in the source. When the administrator removes
newly added skill from the PR, the PR process will remove the skills from user's plan.
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Figure 117: Updated PR behavior

If the administrator has changed the skill's proficiency level after processing the PR, then the administrator must remove
the newly added skill and before processing the PR, add the same skill again to the PR with a different proficiency
level. Once the PR is processed, the updated proficiency level will be pushed to the user's plan.

The goals will not be assigned to the user while pushing skills through PR.

Anniversary reviews update

The anniversary reviews are triggered after the x number of days from user's joining date or job starting date. These
details are mentioned in the review cycle. For example, if Jane joins the company on 5th April, 2016 and in review cycle
the review trigger time is 365 and the trigger is based on Joining Date, then she'll receive the review on 5th April, 2017.
After joining, if Jane starts her job on 10th April, 2016 and in review cycle the review trigger time is 365 and the trigger
is based on Job Starting Date, then she'll receive the review on 10th April, 2017. Once the review is pushed, then the
review is not triggered for the subsequent year.

From this update, multiple anniversary reviews will be created for the same user until the user's job change or termination.
Once the anniversary review is triggered, the next review will be triggered based on the timeframe mentioned in the
anniversary review cycle and it will be pushed to only those who fulfill the criteria. If the prescriptive rule criteria is
changed in future, then the person matching with the old criteria is not processed even if the anniversary review was
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pushed to the learner. Thus, after x number of days only those users who matches with the current criteria for the review,
will be processed.

Figure 118: Anniversary review cycle

Note: The review's created on date is appended to the anniversary reviews to differentiate them from other reviews.

Figure 119: Anniversary reviews

If the previous anniversary review is still active for an employee, then it will remain active, but an anniversary review
for the current year will be created. Manager has the provision to cancel the old review. If the review cycle is marked
as complete or cancel, then the anniversary reviews will not be created for that cycle.

If the system admin is trying to override the overall score through data import, then it will not override the score for
anniversary reviews as its not supported. The system admin will be able to create historic reviews for anniversary review
cycle using the Review Score object name in data import. Such reviews will be named as ReviewCycleName_date where
date is the review creation date.
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Performance administrator can now create a single anniversary cycle and it will continue to create reviews until the
cycle is either cancelled or closed.

Edit or delete goal progress comments

A user associated with a goal can add comments and change the progress of the goal, but there was no provision to edit
or delete any comments, once given.

The people administrator and end user can now edit or delete their comments on the goal provided the following new
privileges are enabled. The privileges have been introduced in the Shared Goal component:

• Can Edit Self Comments - By default, this privilege is enabled. When enabled, the user can edit their own comments
on the goal. An edit icon appears next to the self comments.

• Can Delete Self Comments - By default, this privilege is enabled. When enabled, the user can delete their own
comments on the goal. A delete icon appears next to the self comments.

• Can Edit All Comments - By default, this privilege is enabled for Performance admin only. When enabled, the user
can edit all the comments on the goal. An edit icon appears next to all the comments.

• Can Delete All Comments - By default, this privilege is enabled for Performance admin only. When enabled, the
user can delete all the comments on the goal. A delete icon appears next to all the comments.
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Figure 120: New privileges in Shared goal

The user will not be able to take any actions on the first comment of the goal. The user can edit and delete only his/her
comments. Once the goal is completed, if the user tries to reactivate the goal and delete the last comment (about goal
reactivation), then the goal moves to its previous state.

Note: The progress of the goal is dependent on the goal's last comment.
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Figure 121: Edit or delete goal

The goal progress comments being entered, edited, or deleted are being captured in the audit trail on the Goal progress
details page. This supports only silent auditing.
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Figure 122: Goal Audit Trail

This feature now enables manager and employee to edit or delete their own comments as well as any comments if they
have the correct permissions.

Export and import review cycle

For a review cycle, a copy feature exists that creates an exactly same review cycle using the existing review cycle. It
copies the cycle on the same environment, hence there was a need to have a provision to copy the review cycle from
one environment to another.

In this update, export and import functionality has been introduced for review cycle where the performance administrator
can export the required review cycle and import the same on another environment. The export functionality will capture
all the details associated with the review cycle including forms and audiences in an XML file. Administrator can export
the review cycles at any state.

To export and import review cycle:

1. Navigate to Performance > Manage Reviews > Review Cycles.
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2. Search for an review cycle which needs to be exported.
3. Click Export Cycle under Actions column corresponding to the review cycle. The XML file is downloaded. The

file will be named as review cycle and export date timestamp.

Figure 123: Export and Import review cycle

Figure 124: Exported review cycle XML file content

4. Go to the environment where you want to import the review cycle.
5. Log into the application and perform step 1.
6. Click Import Cycle.

Figure 125: Import review cycle

7. Click Browse to locate the exported file.
8. Click Upload. The review cycle is imported. If the import is successful or failed, the details will be added in the

logs.

The following items are not available in the XML file:

• Internationalization of cycle, form, or a section name and instructions
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• Internationalization of questions for a review cycle with an Additional Info review form
• Any search criteria set or saved for the forms
• Audiences set on the third step of cycle creation and on summary page

If any of the following objects do not exist in the target environment, then on successful import the object will be empty:

• To-Do List
• Goal categories
• Skills and skills groups
• Organization
• Adhoc approvers (specify individual) in an approval chain - If a specific individual added to an approval chain does

not exist in the target environment, then that user will be skipped and the approval chain with remaining users will
be imported with updated approval level.

If a review form with a same name already exists on the target environment, then it will be associated to the existing
form or new form will be created. Once the review cycle is imported, the review cycle will be moved to Draft state. The
administrator must activate the review cycle manually.

This feature is applicable for all review types.

The performance administrator can now utilize the export and import review cycle functionality to copy the review
cycles from one environment to another like from sandbox to production environment. This will greatly improve
implementation time and reduce potential re-key errors.

Filter skills by skill group

Prior to this update, the end users could filter the skills using Type, Source, Filter by To-Do List on the My Plan and
My Team > <Team Member> > Plan page.

Figure 126: Filters on Skills Development tab
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A new filter Skill Group has been added to the Skills Development tab that allows the user to sort the skills based on
the group name. The Skill Group filter displays all the skill groups that are available in the system irrespective of any
skill belonging to the group, is assigned to the user or not. The user can select only one skill group at a time. If any skill
group is not selected, then all the skills assigned to the user will be displayed in the search results.

Figure 127: Skill Group filter for Skills on My Plan page

The same filter is also available when the manager accesses team member's plan.

Figure 128: Skill Group filter for Skills on Team member's Plan page

Users will now be able to filter skills by groups under ME > My Plan.
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Limit access to reviews for new managers

A current manager, who is a review owner can access employee's review by navigating to My Team > <team-member>
> My plan and clicking the desired review. But, once the manager is changed, then that new manager can still access
the employee's review who has the previous manager. There is a need to update the behavior since the old reviews need
to be confidential between the old manager and the employee.

Figure 129: Old review access behavior

The access to the reviews owned by the old managers is now governed by the following privileges introduced in the
Person, Internal component for the Internal Manager Basic Privileges security role:

• Reviews - Direct Managers and Indirect Managers Can View Sensitive Information - Allows the new direct
and indirect managers to view the sensitive information, such as ratings and comments in the reviews owned by the
old managers. By default, this privilege is enabled. When this privilege is disabled, the new manager will not be able
to view the team member's sensitive review information.

• Reviews - Alternate Managers Can View Sensitive Information - Allows the alternate managers to view the
sensitive information, such as ratings and comments in the reviews owned by the old managers. By default, this
privilege is enabled. When this privilege is disabled, the new alternate manager will not be able to view the team
member's sensitive review information.

Note:  If the above privileges are disabled, then the pie chart shows the count of review but the listing will not be
shown due to the mismatch between the numbers shown on the pie chart and the listing.

Figure 130: New privileges for reviews for managers
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The new privileges added to restrict new managers from viewing past reviews where they were not the review owner.
This supports EMEA Work Council regulations.

New policy for review owners to release review

Prior to this update, review owner could release review to the reviewee. In case the review owner is not available,
performance administrator could release the review on behalf of the review owner. There was no provision to restrict
the review owner from releasing the review.

From this update, the performance administrator can choose whether the review owner can release the review or not. A
new policy Review owner can release reviews is introduced in the Review Cycle > Cycle Description tab that decides
whether the review owner can release the review or not.

Figure 131: New policy on the review cycle

By default, this checkbox is enabled. If it is disabled, the Release option is not shown to the review owner on the approved
reviews. Only performance administrator can release those reviews on behalf of the review owner.

Note: This policy is available only for anniversary, focal, and off cycle reviews.

On the My Plan page, when the reviewee hovers on the Release the review milestone, the tool tip indicates that the
Performance admin will release the review.

 | Performance | 381



Figure 132:Tool tip on Release the review milestone

Performance administrator can now restrict managers from releasing reviews. This will allow admin to release approved
reviews in bulk.

New question in Company category for Pulse 360

Prior to this update, the Company category in Pulse 360 had the following questionnaire.

Figure 133: Old questions under the Company category

In this update, the following enhancements has been made to Pulse 360.

New question in Company category

A new question Describe your preferred future culture in three words or less has been added to the Company
category to capture the FUTURE culture. This will allow companies to understand not only their current culture but
also the kind of culture their employees would like to see in the future. By default, its enabled for all the emoticons.

Figure 134: New questions under the Company category
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It will appear on the How's it going? portlet on selecting the desired emoticon. The end user will have to enter 3 words
that will describe the company's culture in future, one keyword per box.

Figure 135: New question on How's it going? portlet

Once all the employees are done with the survey, these words will then be shown in the dashboard Manage Pulse 360
> Dashboard > Expand Company category.
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Figure 136:Tags mentioned in culture

Pulse will now list top 10 keywords for both Current and Future culture. It also provides supporting statements based
on an algorithm. The admin can also filter these words by clicking the Current Culture and Future Culture labels.
The admin can click the TOP 10 WORDS label to view the maximum entered words for both current and future culture.

Figure 137:Top 10 words about culture

Based on the top 10 words, an auto-generated culture statement is shown in the widget. The algorithm used to create
this statement is:

1. Create a Top 10 list for the current culture.
2. Create a Top 10 list for future culture.
3. From the future culture list, go through the words with highest votes to the lowest votes and find the first two words

that are NOT on the current culture list. Add these keywords as 1 and 2 in that auto generated statement.
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Note:  If algorithm 3 cannot be computed, then the auto-generated statement will appear as We have a culture
that aspires to be more <Future 1> and <Future 2> while continuing to be very <Future 3> and <Future 4>.

where <Future 1> and <Future 2> are the top two unique words from the future list and <Future 3> and <Future
4> are next top two unique words from the future list that are not part of <Future 1> and <Future 2>.

4. From the future culture list, go through the words with highest votes to the lowest votes and find the first two words
that are on the current culture list. Add these keywords as 3 and 4 in that statement.

Note:  If algorithm 4 cannot be computed, then the auto-generated statement will appear as We have a culture
that is <Current 1> and <Current 2> and aspires to be more <Future 1> and <Future 2>.

where <Current 1> and <Current 2> are top two unique words from the current list and <Future 1> and <Future
2> are top two unique words from the future list and not in current top two words.

This enhancement will now allow the business to get a better understanding of the working culture that the employees
want to see in the future.
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New question in Company category for Pulse 360

Prior to this update, the Company category in Pulse 360 had the following questionnaire.

Figure 138: Old questions under the Company category

In this update, the following enhancements has been made to Pulse 360.

New question in Company category

A new question Describe your preferred future culture in three words or less has been added to the Company
category to capture the FUTURE culture. This will allow companies to understand not only their current culture but
also the kind of culture their employees would like to see in the future. By default, its enabled for all the emoticons.

Figure 139: New questions under the Company category

It will appear on the How's it going? portlet on selecting the desired emoticon. The end user will have to enter 3 words
that will describe the company's culture in future, one keyword per box.
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Figure 140: New question on How's it going? portlet

Once all the employees are done with the survey, these words will then be shown in the dashboard Manage Pulse 360
> Dashboard > Expand Company category.
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Figure 141:Tags mentioned in culture

Pulse will now list top 10 keywords for both Current and Future culture. It also provides supporting statements based
on an algorithm. The admin can also filter these words by clicking the Current Culture and Future Culture labels.
The admin can click the TOP 10 WORDS label to view the maximum entered words for both current and future culture.

Figure 142:Top 10 words about culture

Based on the top 10 words, an auto-generated culture statement is shown in the widget. The algorithm used to create
this statement is:

1. Create a Top 10 list for the current culture.
2. Create a Top 10 list for future culture.
3. From the future culture list, go through the words with highest votes to the lowest votes and find the first two words

that are NOT on the current culture list. Add these keywords as 1 and 2 in that auto generated statement.

 | Pulse 360 | 390



Note:  If algorithm 3 cannot be computed, then the auto-generated statement will appear as We have a culture
that aspires to be more <Future 1> and <Future 2> while continuing to be very <Future 3> and <Future 4>.

where <Future 1> and <Future 2> are the top two unique words from the future list and <Future 3> and <Future
4> are next top two unique words from the future list that are not part of <Future 1> and <Future 2>.

4. From the future culture list, go through the words with highest votes to the lowest votes and find the first two words
that are on the current culture list. Add these keywords as 3 and 4 in that statement.

Note:  If algorithm 4 cannot be computed, then the auto-generated statement will appear as We have a culture
that is <Current 1> and <Current 2> and aspires to be more <Future 1> and <Future 2>.

where <Current 1> and <Current 2> are top two unique words from the current list and <Future 1> and <Future
2> are top two unique words from the future list and not in current top two words.

This enhancement will now allow the business to get a better understanding of the working culture that the employees
want to see in the future.

Pulse custom surveys

Surveys in Saba Cloud could be consumed only through class evaluations. There was no means of delivering and
consuming surveys independent of a class.

With this update, Saba Cloud introduces the Saba Pulse Custom Surveys feature, where administrators can create
custom surveys that can be delivered and consumed independent of a class.

Note: You cannot use custom surveys in Learning or Recruitment surveys.

To use this feature, administrators need to make the following configurations:

New Service

To enable this feature, system administrators must enable the following service under Pulse 360 service:

• Custom Survey

By default, this service is disabled.

Figure 143: Custom Survey service
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New Security Role

System administrators must grant the following security role to users who need to administer Pulse 360 custom surveys:

• Pulse Custom Survey Admin

By default, this role is granted the required privileges on the following components:

• Pulse Custom Survey
• MenuVisibility-PulseAdmin

Figure 144: Pulse Custom Survey Admin role

New Notifications

System administrators can configure the following notifications for custom surveys:

• Assign Pulse Custom Survey to Users
• Send Email to assigned Users
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Figure 145: Custom Survey notifications

Pulse Custom Survey Administration

Once all configurations are in place, the Pulse custom survey administrators can create and monitor custom surveys
from the new Survey Administration menu under Pulse 360.

To create a new custom survey, click the Create Custom Survey menu link, select the required folder in the assessment
library and click the New button. Specify the details in the new survey wizard and publish the survey. Once you create
a custom survey, you can use this survey in the launch survey wizard and assign it to designated users. Pulse custom
surveys cannot be reused in any other areas of Saba Cloud, such as in class evaluations.

Figure 146: Custom survey creation

To launch a new custom survey, click the Custom Surveys > Create Custom Survey link. This opens the custom
survey creation wizard. This is a 4-step wizard where you can perform the following:

1. Survey Launch Information - Add basic information such as survey name, ID, start and end dates, and so on.
2. Add Survey - Select an existing survey either from Custom, Learning and Recruiting options. Only one survey can

be added.
3. Assign Survey - Assign the survey to designated members who can be selected manually and/or using smartlists.

Smartlists are processed only when the custom survey is activated. However, administrators can preview members
selected by the smartlist even before activation.

4. Summary - Preview the survey details and either save as draft or activate the survey.

Figure 147: Custom survey launch wizard
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Custom Survey Consumption

Once a custom survey is activated, Saba Cloud assigns it to designated members through the Assign Pulse Custom
Survey to Users periodic notification. Users can take the survey only when the survey's start date is reached. When
users attempt the survey, Saba Cloud launches it in a new content player template Pulse Custom Survey Player template.

Organizations need to use surveys not only as part of class evaluation, but also for several other reasons such as to
measure the training department's effectiveness in delivering quality training or to launch a opinion poll for a selected
set of users or groups, and so on. Additionally, an important use of surveys is to present the survey results data to
administrators in the organization for analysis. Therefore, Saba Cloud needs to have the ability to create and deliver
standalone surveys that can have varied consumption and reporting patterns.

 | Pulse 360 | 394



Chapter

8

Talent

Topics:

• Control display of experts in
career planning

• Display Career Planning section
on Talent Profile irrespective of
career paths

• Display talent attributes on
hovering person in N-box view

• Export/print n-box view to Excel
and PDF

• Hover messages for potential
rating and departure risk on
Talent pool views

• Surface job details and
attachments from Job details on
Profile page and in Career
Planning

• Surface Actions menu on N-box
view



Control display of experts in career planning

The people who have gained expertise in skills associated with the job appears in the Experts tab of the job added in
the career path. This tab displays all the people who have attained expertise in the skills of the job. There was a need to
display the most qualified people as expert resources instead of all.

From this update, the Experts tab of the job will display only the most qualified people as experts. This will be dependent
on the value mentioned in the new setting Enter the threshold percent at which someone is considered to be an
expert under Succession@Work > Career Planning service.

Figure 148: New setting for Experts in Career Planning

The default value of this setting is 0%. The value must be in the range of 0% to 100%. This value is required and cannot
be blank. Now, based on this value, the people in the Experts column will be shown accordingly. For example, if you
specify 80% in the setting, then the people who have attained 80% proficiency in the skills associated with that job will
be shown in the Experts tab.
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Figure 149: Experts tab

If there are many people with the same level, then such experts are grouped and shown in random order while others
will be shown in descending order of the level.

A company is training its employees in a new skill area. While the overall competency level is low (because the skill is
new), the company does not want anyone flagged as an expert until a certain threshold level of expertise is attained. In
this case, the company decides to set that threshold at 80% of the max attainable value. The company uses a 5-point
scale for this skill so a worker must be rated at 4 or 5 to have the system flag them as an expert in that skill.
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Display Career Planning section on Talent Profile
irrespective of career paths

The Career Planning section on the person's Talent Profile was governed by the Career Planning service. But, if the
person had not created any career paths, then the section would not appear, even though the service was enabled.

From this update, the Career Planning section will appear on the person's Talent Profile even when the person has not
created any career paths. In such a case, the No career paths have been created. message appears. When the Career
Planning service is disabled, the section is hidden.

Figure 150: Career Planning section

A manager can do a better job of prompting the team to create career paths, if there is a visual reminder like an empty
career path on the Talent Profile page. With this reminder, the manager will be able to trace the missing information
and inform people about it.

Display talent attributes on hovering person in N-box view

On hovering the person in N-box view, it only use to show the person's name and designation.

From this update, along with the name and designation, person's following talent attributes are also shown on hovering
the person in N-box:

• Ethnically Diverse - Display values as Unknown and Yes. If the Ethnically diverse for their region of origin,
other than due to gender. checkbox in the person's full profile is selected, it will be shown as Yes or as Unknown.
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This attribute will appear only when is_diverse attribute is enabled in Configure System > Services > User Profile
> Components > Core profile.

• Retirement Risk - Display person's retirement risk. This attribute will display the options based on the values selected
in the person talent profile data.

• Performance Review Score - Display person's focal review score. This attribute will appear only when the Reviews
service under Performance is enabled.

Figure 151:Talent attributes in N-box view

These changes will reflect in all the N-box across the application.

A manager or a talent administrator calibrating people within a N-box needs to be able to evaluate a lot of information
quickly. Hence, having the talent information readily available can greatly improve the efficiency of the decision making
process of placing a person on the grid. The metrics for a person's diversity, retirement risk, and most recent performance
review score will now be visible when hovering over a person's box.

Export/print n-box view to Excel and PDF

There was no provision to either export the n-box view to excel or print it to PDF.

From this update, the manager, talent administrator, and performance administrator can now export the current n-box
view to excel and print it to PDF. Launch the n-box and then click Export to Excel or Print from the Actions dropdown
list.
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Figure 152: Actions dropdown list

Based on the selected option, the current n-box view will be shown.

To export the n-box to excel:

1. Navigate to talent pool where you want to compare people.
2. Click Compare > N-box.
3. Click Actions > Export to Excel. The .xls file gets downloaded.
4. Click the file to open and verify the details.

Note:  Only 8 people can be shown per box. If more people exist, then additional pages will be generated to
accommodate the coverage.

Figure 153: N-box view in Excel

To print the n-box to PDF:

1. Navigate to talent pool where you want to compare people.
2. Click Compare > N-box.
3. Click Actions > Print.
4. Click the Printer Friendly View icon. The Printer Friendly View opens.
5. Change the destination to save it as PDF. Ensure Background graphics is selected in Options.
6. Click Save. The file will be saved in the chosen destination folder and the PDF opens in browser.
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Figure 154: N-box view in PDF

A user needs to capture data at a point in time. Since there is no provision to save the n-box view in Saba Cloud, an
export and print would preserve the data at a point in time.

Hover messages for potential rating and departure risk on
Talent pool views

On hovering the bar images of Potential Rating and Departure Risk in the Talent pool, there was no clear indication
about the selected ratings.

From this update, hover messages will be shown on the bar image under the Potential Rating and Departure Risk
columns. The messages on the popup will be updated based on the changes made in the person's Talent Profile.

Note:

These messages appear in both Manager and Talent admin views.
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Figure 155: Hover message on Potential Rating column

Figure 156: Hover message on Departure Risk column

A manager working on talent pools for her organization couldn't relate with the bar images shown under Potential
Rating and Departure Risk. Hence, on hovering the bar images, a popup appears that explains the criteria to determine
the rating.

Surface job details and attachments from Job details on
Profile page and in Career Planning

An employee's profile page and their career path did not provide the job description, responsibilities, and attachments
associated with the job.

From this update, attachments can now be added to the job object and seen in both Career Planning, and Profile views.

Profile page

On the Profile page, the Job title is now hyperlinked which opens a popup with job description, responsibilities associated
with the job, and attachments. This data is fetched from the Job details filled by the HR admin. If the HR admin has
attached any documents related to skills, then those documents will surface on the popup under the Attachments heading.
The employee can click the attachment name and access the file.

Note: The visibility of attachment is based on the privileges assigned to the logged-in user on attachments. The
security rules still apply so if an attached document is marked as private, then only those individuals with Can view
private attachments enabled on the System component, can view.
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Figure 157: Job description with Attachment section on Profile

Career Planning

The Attachments section is also added under the JOB OVERVIEW tab of a career path. The employee can click the
attachment name and access the file.

Figure 158: Job description with Attachment section in career path

If the Recruiting@Work + Internal Opportunities service is enabled and a job requisition exists for the same job,
then additional details, such as Qualifications, Years of Experience and job requisition template description appears at
the top of the profile page.
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A user, who does not have Career Planning feature, can still make the pertinent job information, such as the job description
and associated skills available to employees via their Profile page. The HR administrator fills the job information into
the job and attaches a list of skills to the same job. Employees associated with that job can now go to their profile page,
click the job title to view its details in a popup. They can also view attachments with skills on the profile page as well.

Surface Actions menu on N-box view

The manager could assign learning, reviews, skills, and etc to his/her direct and alternate team members through MY
TEAM > Overview > Team Actions. There was a need to assign the same to the members who are plotted on n-box.

From this update, the manager will be able to assign the following to the members who are plotted on n-box:

• Learning
• Completed course
• Checklist
• Goal
• Review
• Skill

In the n-box view, Actions dropdown list has been added from where the manager can assign the above plan items to
the ones who are plotted on the n-box. The manager will be able to assign plan items to his direct, alternate, and other
team team members that are plotted on n-box.

Figure 159: Plan actions

While assigning the plan item to people, the manager will be able to choose between Currently plotted, Direct team,
or Alternate team. Once the plan item is assigned, it will appear in the person's plan.
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Figure 160: Assign goal to currently plotted people on N-box

A user is performing a calibration and wants to add something to an employee's plan. With this new functionality, they
can click Actions button and easily add a goal, assign learning, or a variety of other items. There is no longer a need to
navigate away from the N-box page.
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Auto reject candidates with incomplete profile

When the candidate's profile is incomplete (mandatory fields are not filled after the job application), then the candidate
is moved to the Complete status in the New tab.

Candidates can now be auto-rejected if the mandatory fields are missing or not added on the profile so that only the
genuine candidates are processed further who have added the necessary and required details on their profiles.

In this update, new settings Candidate has not filled the mandatory fields X days post application and X Days
Notification-Candidate Auto-rejection for Incomplete profile have been introduced under Recruiting@Work +
Internal Opportunities.

Figure 161: New settings for candidate auto rejection

By default, the Candidate has not filled the mandatory fields X days post application setting is disabled. When it
is enabled and the number of days are mentioned in the X Days Notification-Candidate Auto-rejection for Incomplete
profile setting, then the candidate's profile will be rejected after the mentioned days. These settings will work only after
the periodic notification Candidate Auto Rejection event is triggered. Based on the information provided in the above
settings, the candidates will be auto rejected from the system. In the Hiring team group, the candidates with incomplete
profile appears in the New tab > Incomplete link.
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Figure 162: Incomplete profile candidates in New tab

If the candidate does not fill the information before X days, the candidate will be rejected with the reason as Incomplete
profile.

Figure 163: Auto rejected candidates

Such rejected candidates will be then moved to All tab > Rejected.

Note: These candidates can once again re-apply for the same job requisition.

Candidate is auto-rejected if the mandatory fields are missing or not added on the candidate's profile.
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Display custom and extended custom fields on candidate's
profile

Prior to this update, if any details are added in the candidate's custom fields (under Additional details section), then
those fields are not populated on the candidate's Profile tab.

Figure 164: New setting to pull job description

Also, there was a need to update the look and feel of the Career site login page.

From this update, any additional details available in the candidate's custom fields will now be surfaced on the candidate's
Profile tab.
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Figure 165: New setting to pull job description

The Profile tab is accessible from:

• Go to My Team > Jobs > Job Requisitions > Go to Hiring Team > Click any candidate > View candidate details >
Profile tab.

• Go to People > Jobs > My Job Requisitions > Go to Hiring Team > Click any candidate > View candidate details >
Profile tab.

• Go to Admin > Recruiting > Manage Candidates > Search any candidate > Click candidate name link > Profile tab.

The custom fields are also shown on Step 2 Candidate details when a candidate applies for a job.
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Figure 166: Fill custom fields while applying for job

This now improves the candidate's profile view by showing the custom fields.

Job requisition summary digest

Prior to this update, there was no provision to receive any digest notifications or summary updates for requisition.

From this update, the recruiter and hiring manager will be able to receive a requisition summary through email either
weekly or monthly. A new field has been introduced on the <user name> > Account Preferences > Job Requisition
Summary.
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Figure 167: Job Requisition Summary

By default, No email will be selected for this field. The user may select either Weekly email or Monthly email. The
emails will be triggered only when the Job Requisition Summary Digest Monthly Email Dispatch and Job Requisition
Summary Digest Weekly Email Dispatch notifications are enabled. By default, these notifications are enabled. These
notifications will be triggered only when the Process mailer service queue notification under the Collaboration service
is enabled.

Figure 168: Job Requisition Summary notifications

Based on the option selected for Job Requisition Summary on your account preferences, an email will be sent to the
recruiter and/or hiring manager.
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Figure 169: Job Requisition Summary email (Part 1)

The notification email will show detailed report on each requisition associated with the logged-in user. The details shown
are:

• Job requisition name - On clicking this link the user is navigated to requisition's hiring team page.
• Status
• Hiring Manager's name, Recruiter's name, and Interviewer's name
• Latest candidates applied
• Older candidates - Displays older candidates so that the hiring team screen these candidates quickly and take some

actions on them.
• Upcoming interviews
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• Schedule interviews
• Offers made
• Recent Activity - Shows the updates that appears in the activity stream.
• Click here link to navigate the user to hiring team view

If there is no data, then the hiring manager and recruiter will not receive any email. You can download the candidate's
resume by clicking the candidate's name. Under every candidate, the candidate's current status is mentioned. It also
indicates with whom the job requisition or candidate's job offer is pending with for an approval.

The above sections of the job requisition will be repeated for every Active and Pending Approval job requisitions
provided the data is available for each section. If the data is unavailable, then the section will not be displayed in the
notification.

The individual hiring managers and recruiters can now opt to get job requisition summary email digests at weekly or
monthly interval. Hiring managers and recruiters are well-informed and stay up-to-date with the latest happenings around
their job requisitions with hyperlinks to directly access the job requisition's hiring team view.

Multiple career sites

Prior to this update, the recruiting administrator could create only one career site which was a default site where all the
job openings across all the locations were published.

From this update, the recruiting administrators can create multiple career sites, associate each with a region or group
and also brand them independently. This will maintain the look and feel to various job sites that ties back to sites or
regions. The administrator can also publish the job openings to the selected career site. The administrator can also set
a default time zone for each career site. Analytics enables user to distinguish between the job sites while reporting on
applications and provides an ability to users to view all the available jobs from an All Jobs site or toggle to other available
job sites.

The recruiting administrator must navigate to the default career site and click Add Career Site to add multiple career
sites.

To add multiple career sites:

1. Navigate to ADMIN > Recruiting > Manage Career Sites > Career Sites > <career-site-name>.
2. Click Add Career Site.
3. Enter the following details.

Table 103: Career Site Fields

DescriptionField Name

Provide a name for the career site.Name

URL identifier that is appended to your site's URL to
form the URL for the career site. For example:ht~

URL Identifier

tps://<your_default_career_site_url>-<new_ca~
reer_site_url_identifier>
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DescriptionField Name

Provide a description for the new career site.Description

Select the checkbox to make it as private career site. This
site will be accessible only to those with whom the career
site URL will be shared.

Is Private

Select the desired time zone based on your current local~
ity.

TimeZone

Address potential applicants with information about your
company. The marketing communication appears in the

Marketing Communication

front section of the career site home page. Use the rich
text formatting bar to add images and apply formating.
The width must be around 862 pixels.

Select the locate in which you want to display the text.Locales

Change the theme based on the career site's location.Edit Theme

Figure 170: Multiple career site

4. Click Save. The new career site - location wise is created.
5. Click Activate corresponding to the newly created site to activate it. Click De-activate to deactivate the site.

Note: The user will not be able to deactivate the default career site.
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Figure 171: Multiple career site

6. Click Save.
7. Navigate to System > Configure System > Services > Recruiting@Work + Internal Opportunities > Components.
8. Click JobRequisition.
9. Navigate to attributes > regions.
10. Select the Display checkbox.

Figure 172: Regions attribute

11. Click Save twice.

Once the career site is created and the attribute is enabled, the Career sites dropdown list starts appearing in the Job
Postings & Services tab of the job requisition. The admin and hiring manager will be able to select multiple career sites
to post the job requisition on multiple sites. Every job by default will be posted on the default site and then on the selected
multiple career sites. Also, all the deeplinks and emails that includes an URL, gets the URL of the default site.
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Figure 173: Job Postings & Services tab

While logging into the Career site, the user can also search for the job based on the career site's location.

Figure 174: Career site login page

Data Import

In the job requisition import via CSV, a new column REGION1 has been added to provide the regions where the job
will be posted. The admin can mention multiple regions by separating it by commas. This column is optional. If the
value is not provided, the job will be by default posted to the global region.

Figure 175: Job Requisition data file

This feature now allows recruiting administrators to post job requisitions specific to certain regions which are individually
branded.
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New setting to pull job description in requisition

When a recruiting administrator or a manager tries to create a job requisition using a template, then the job description
is pulled from the template. If a new requisition is created, then the job description field is blank and there was no
provision to pull this data from any source.

From this update, whenever a recruiting admin or a hiring manager creates any new job requisition, the Job Description
field on the job requisition now has the value pulled directly from the jobs defined by HR. To support this, a new setting
Do you wish to inherit Job Description from the Job defined by HR? If no, it will be inherited from the Job Req
Template. has been introduced in Recruiting@Work + Internal Opportunities service. By default, this setting is
disabled. When this setting is enabled, the job description and key responsibilities are pulled from the job that is created
by an HR (HR > Manage Jobs > Jobs), clubbed, and displayed under the Job Description on the requisition. If the
HR has not mentioned any information in these fields, then the Job Description field in the requisition will be blank.

Figure 176: New setting to pull job description

If an administrator or manager tries to update the job in the existing requisition, then a confirmation message appears
that asks whether you want to overwrite the existing job description from the new job or not.
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Figure 177: Confirmation message to overwrite job description

The job requisition used to inherit majority of information from the template itself. It would have been more usable if
the requisition pulls the data from the job defined by the HR. Through this enhancement, the job description can now
be pulled from the respective job instead of an existing requisition template, based on the business rule.

New keywords in offer letter template

The candidate's address fields and custom fields were not part of the offer letter since the corresponding keywords were
not part of the offer letter template. In addition to this, the offer letter template had keywords related to candidate's full
name instead of first name and last name.

From this update, the hiring manager or recruiter can now use candidate's first name and last name instead of a full name
and address keywords in the offer letter template so that the offer letter will show the corresponding details. The following
keywords are now part of the offer letter template:

• @JobOffer_JobOffer_Candidate_First_Name@
• @JobOffer_JobOffer_Candidate_Last_Name@
• @JobOffer_JobOffer_Candidate_Address_Line_One@
• @JobOffer_JobOffer_Candidate_Address_Line_Two@
• @JobOffer_JobOffer_Candidate_City@
• @JobOffer_JobOffer_Candidate_State@
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• @JobOffer_JobOffer_Candidate_Country@
• @JobOffer_JobOffer_Candidate_Zip_Code@
• @JobOffer_JobOffer_Custom0@
• @JobOffer_JobOffer_Custom1@
• @JobOffer_JobOffer_Custom2@
• @JobOffer_JobOffer_Custom3@
• @JobOffer_JobOffer_Custom4@
• @JobOffer_JobOffer_Custom5@
• @JobOffer_JobOffer_Custom6@
• @JobOffer_JobOffer_Custom7@
• @JobOffer_JobOffer_Custom8@
• @JobOffer_JobOffer_Custom9@

Figure 178: New keywords for offer letter

If the above keywords are added to the offer letter template, then when the hiring manager or recruiter appends this
letter template to the offer, the name, address, and custom details from the Candidate Information tab will be shown
in the offer letter.

The users will now be able to use the full fledged offer letter wizard to generate offer letters for the candidates.
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Smarter one click approval from email

There were security issues with the job requisition and the job offer approval notifications.

In this update, one time certificate functionality has been introduced for the job requisition and job offer deeplinks within
the notifications, where once the certificate (associated with the deeplink) is used, it expires.

Figure 179: Job requisition summary

When the approver clicks the job requisition/job offer deeplink from the notification, the requisition summary/offer
summary page opens without the navigation panel and control panel. The logged-in user's information will not appear
on the top. The approver can either approve or reject it.

Note: The approver must not forward such emails to another user. A disclaimer is mentioned in the notification
emails too.
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Once the approver takes any action, he/she is logged out from the system. Also, the certificate also expires, which means
if the approver clicks on the same certificate again, then he/she needs to log into the application. The same thing happens
when the approver duplicates the browser page after taking any action.
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Figure 180: Job requisition notification

The security breach can now be minimized if the email is accidentally forwarded to any other user. This feature will
enhance the security around unauthorized access of the one click URL (attached with authorized user's auto-login
certificate).

Manage onboarding forms in HR admin flow

The recruiting administrator could view candidate's shared and personal type of onboarding forms by navigating to HR
> Manage Onboarding Forms.

The recruiting administrator can now only view Global type of onboarding forms by navigating to HR > Manage
Onboarding Forms. Also, the documents are sorted in alphabetical order.

Figure 181: Onboarding forms

This feature will help in maintaining the privacy of the documents, hence only Global type of documents will be visible
to the recruiting administrator.

Reposition Terms and Conditions

There was a need to reposition the Terms and Conditions section to make it a conspicuous hyperlink.

The following changes are made on the Career site:
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1. The Complete form to apply link is now changed to a button on the Career site Login page.
2. The position of the Terms and Conditions hyperlink has been changed. This is applicable to all the Career site login

pages where Terms and Conditions appear.

Figure 182: Login page after applying for job

 | Recruiting | 425



Figure 183: General resume submission view

3. The Login page is now updated.

Note: The text Apply with and Sign in! can now be localized.

Figure 184: Career site Login page

The Terms and Conditions link is now a conspicuous hyperlink under the browse-wrap agreement policies.
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UI enhancements on the Hiring Team page

Prior to this update, the following actions were performed on the Hiring Team page:

1. Once the hiring manager or recruiter creates an offer for candidate, the candidate cannot be marked as hired until
the candidate is in Offered state.

2. Once an offer is sent to the candidate, the candidate could view the offer in Career site. But, as soon as the candidate
is marked as hired, he/she was not able to view the offer.

3. Once the candidate is hired, there was no provision to reject the candidate.
4. View assessments link is not shown in More actions corresponding to the candidate once the requisition is closed.

The following enhancements are made on the Hiring Team page:

1. Once the hiring manager or recruiter creates an offer for the candidate, they can hire the candidate once the offer is
approved by approvers. The Mark hired link will appear in the More actions even when the candidate's status is
in Offer Approved state.

Figure 185: Mark hired candidate in Offer Approved state

2. Once the candidate is marked as Hired, the candidate will be able to view the offer on the Career site > My Job
Applications page. A View offer button will be shown next to the requisition that will preview the offer to the
candidate.
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Figure 186: Hired candidate can view offer

3. Once the candidate is hired, a recruiter or hiring manager can reject the candidate since it is quite possible that the
hired candidate accepted the offer but did not join the company. Once the candidate is marked as Rejected after
hiring, then the Mark Interested-Medium action will not be visible. These candidates will not be processed further
for the same job requisition but can be copied to some other job requisition.

Figure 187: Reject hired candidates

4. View assessments link is now shown in the More actions corresponding to the candidate irrespective of the
requisition's status.
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Figure 188: View assessments for any type of requisitions

This improves the usability on the Hiring Team page.
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Send notifications when compensation letter is published

Currently, when compensation letters are published to managers and released to employees, there is no communication
sent to either a manager or the employee.

In this release, a new feature enables this. When the compensation administrator publishes the Compensation Letter to
a manager, and when the administrator releases the compensation letter to an employee, a notification is sent via email
to the manager and the employee respectively.

Manager

Compensation administrator clicks on Publish to Manager.

Figure 189: Publish to Manager

All managers associated with that plan will receive a notification via email.

Employee

Compensation administrator clicks on Release to Employee

Figure 190: Release to employee
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All employees from the manager's team who are eligible to receive the compensation package will receive a notification
via email.

Note:  In a situation where a manager has several direct reports who are all eligible for a certain
 compensation plan, when you publish the compensation letter, the manager will only receive a single
message.

If the administrator revokes the compensation letter by clicking Revoke, the notifications to the manager and the
employees will not be sent. When the administrator is ready to republish the Compensation Letter, he needs to click on
Publish to Manager again to republish. Similarly, administrator clicks on Release to Employees again to notify the
employees.

This update enables the notification to be sent to a manager when the Compensation Letter is published to a manager
and when it is released to an employee. This enables better communication among managers, employees and
administrators.

Import and export plan cycle worksheets

Prior to this release, when creating worksheets for a compensation plan, compensation administrators had to manually
copy their plan settings and worksheet configurations to a new plan they needed to create. This manual process is tedious
and sometimes lead to errors.

In this update a new feature has been added to the worksheet page which allows a Compensation administrator to import
and export an existing plan cycle worksheet in a simple and automated method.

Import and Export steps:

To download an existing worksheet that you choose to import to a new plan cycle:

1. Navigate to ADMIN>Compensation>Plan Cycles>All Plan Cycles
2. Search for the specific Plan Cycle and click to open the Plan Cycle.
3. From the Worksheet tab, select the component that you choose to export.
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4. Click Download.

Figure 191: Import and export options for plan cycle worksheet

To upload the desired worksheet to a new Plan cycle on the new tenant:

1. Navigate to Plan Cycle>Worksheet>Component
2. Click Upload. The Upload Worksheet pop-up screen opens.
3. Browse and select the file to upload and click Upload. The plan cycle page will now display the new worksheet.

Figure 192: Browse to select file

Compensation administrators can now import and export Plan Cycle worksheets from a previous plan and use it for
deployment on a new production environment. This method of using an existing worksheet saves a lot of time and effort
for the compensation administrators and minimizes errors when manual process is involved.

Freeze header row in manager's worksheet
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Currently, Compensation Managers cannot see headers, columns and labels simultaneously while scrolling on worksheets
with many entries.

In this release, this interface has been improved. The header row and the first column containing employee names are
kept visible when using the scroll bars. The vertical scroll bar helps to move up and down the list of entries below the
header row and the horizontal bar allows navigation left to right adjacent to a fixed column of Employee names.

This improvement provides more flexibility for a manager to scroll through a large list of data and to efficiently locate
relevant information - thereby eliminating accidental errors and deletion of data.

Figure 193: Worksheet showing slide bar

N/A

Delete Compensation Plan Cycles

Until this release, Compensation administrators could not delete Plan Cycles that were no longer needed.
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Starting from this release, Compensation administrators can delete Plan Cycles that are no longer needed in the system.

Note:  Plan cycles can be deleted only when they are in Draft or Cancelled state.

To delete a Plan cycle:

1. Navigate to All Plan Cycles page.
2. Choose either Draft or Cancelled from the Status option.
3. Search for the specific Plan Cycle that needs to be deleted.
4. Click on Delete Plan Cycle from Actions.
5. A warning message will display to indicate that you are about to delete the Plan Cycle.
6. Click OK, and the selected Plan Cycle will be deleted from the list.

Figure 194: Delete a Plan Cycle

Compensation administrators needed the ability to remove from the system old and incomplete Plan Cycles that were
no longer relevant to their scenario. By enabling this option, they are now able to work with more relevant data and a
less cluttered environment.

Support for string translation in Compensation

Until this release, support for string translation was not available in Compensation module.

Starting from this release, when users log in to Saba Cloud Compensation module using a non-English locale, they will
see all the strings translated into their locale.

Figure 195: Compensation Dashboard page localized
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Non-English speaking users can now use Compensation module in their preferred locale, provided, it is one of Saba
Cloud's supported languages.

I18N support for Plan Cycle names and descriptions

NA

Starting from this release, Compensation Administrators can provide Plan Cycle names, Plan Component names and
the description text for the Plan cycle, with their locale name.

Steps to localize Plan Cycle names and description

1. Navigate to: Admin>Compensation>Plan Cycles> Add a New Plan Cycle> Guide Me

The Plan Detail page will display.

2. On the Plan Detail page, enter the Plan Name and the description for the plan.
3. Enter other required field data and click Continue.

You will see the Plan Timeline page.

From this page, you need to go back to the Plan Detail page where you will see a Globe icon added to the top of
the page.

4. Click on this Globe icon.

Figure 196: Globe icon shown on Plan Cycle Details page
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The Standard EXTJS I18N Translate screen launches.

Figure 197:Translate Plan Details to Selected language

In this screen, you select the language to which you want this Plan cycle name and description content translated.

1. Enter the Plan Cycle name in the selected language and add the description details as well.
2. Click on Save.

The Plan cycle name in the locale selected will be used in all subsequent references in the plan.

Steps to translate the Component name on a Plan Cycle:

1. Navigate to the Plan Detail step in the Plan Cycle wizard.
2. From the list of components, choose the component name that you need to translate.
3. Click Edit.

The Add New Component screen will open with the component name displayed.

4. Click on the Globe icon located at the top right corner.

Figure 198: Component Name screen showing the Globe icon
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You will see the Translate Compensation Component screen.

Figure 199:Translate Compensation Component name to Selected language

In this screen, you will select the language to which you want the component name translated.

1. From the drop down option for the Locale, select the locale name.

The component name in the specified language will be added to the Name field.

2. Click on Save.

The component name will appear in the translated language in subsequent references within the plan.

Compensation administrators can now create plan cycles for different locale for different regions.

Localization support for Library Fields

NA
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Saba Cloud provides OOB (out-of-the-box) translations for OOB fields in the OOB locales for Compensation. When
you log into the application using a locale that is different from English and if that locale is supported by Saba Cloud,
the library fields will be displayed in that locale. Additionally, you can see the OOB fields in the user's local language
in Analytics reports as well.

Figure 200: Library fields names in selected locale

Field descriptions support UTF8 characters, but field display names are restricted to ASCII letters and digits.

The table below presents the locale names supported in Saba Cloud:

key word entryLocale Name

ar_SAArabic

bf_BGBulgarian

zh_CNChinese

zh_TWChinese Traditional

cs_CZCzech Republic

da_DKDanish

nl_NLDutch

en_GBEnglish (Britian)

fr_CAFrench Canadian

fr_FRFrench

fi_FIFinnish

de_DEGerman

el_GRGreek

hu_HUHungarian

he_ILHebrew

it_ITItalian

ja_JPJapanese

ko_KRKorean
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key word entryLocale Name

ms_MYMalay

no_NONorwegian

pl_PLPolish

pt_BRPortugese Brazilian

pt_PTPortugese

ru_RURussian

es_ESSpanish

es_MXSpanish Mexican

sv_SESwedish

sk_SKSlovak

tr_TRTurkish

th_THThai

uk_UAUkranian

vi_VNVietnamese

This story enables compensation administrators, managers and employees to see labels of compensation amounts (i.e.
library field names) in their own language.

Translation support for compensation categories

NA

Starting from this release, Compensation users can define their own locale names for Compensation Categories both
custom and out of the box.

Steps to localize Compensation Category names.

1. Navigate to: Admin>Compensation>Configuration> Categories>
2. Click on Add New Categories link.
3. On the Compensation Category screen, under Field Details, enter the Category Name.
4. Select the status >Active or Inactive. Only Active categories will be displayed on the Library Fields page.
5. Select the Display options: No, Profile and Statement or Profile option.
6. Click Save.

Figure 201: Add new Category

 | Compensation | 441



The new category will be added to the list of categories.

To add your locale name to this custom category:

Click on the Edit icon under Actions for the category you created.

You will see a Globe icon added to the top of the page.

Figure 202: Compensation Category page with globe icon

Click on this Globe icon to launch the Standard EXTJS I18N Translate screen.

In this screen, select the language to which you want the Category name translated.

Figure 203: Select Language for Translation
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Enter the new name in the selected language and click on Save.

The Category name in the selected locale will display according to the options chosen when created.

You will follow similar steps to translate the out of the box category names to local languages.

Users can localize the category names for out of the box category names and for custom created category names and
the translated names will be part of the employee history section and profile page as well as the library fields when
logged in that locale.

Comment field added

Prior to this release, managers and approvers could not add appropriate comments and notes on employees when making
budget calculations and compensation plan decisions. Existing options were limiting and without a proper mechanism
to keep a record of these observations and notes.

In this update, the comment field has been enhanced to address this. Now, all out of the box templates have comments
field added and during plan cycle creation, an admin can add the comment field from the library to be included in the
worksheet.

Note:  During compensation historical data import via RDI template, comments cannot be imported; they can be
added as a text field using the library fields.

Note: When using worksheet export feature, comments are also exported and the modifications to the comment
are also available in the audit log option.

On the worksheet, comment column is available for each user and anyone who has view access to the manager's worksheet
will be able to view all comments for that person. For each field, a maximum of 1020 characters are allowed. Clicking
on the comment icon will display all comments in reverse chronological order and each comment will display the text,
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the date/time it was last updated, name of the person who added the comment, and the name of the person who updated
it. If a comment has not been updated or edited, then, the date/time it was created will display.

Based on the security privileges, add, edit and delete options will also display.

On the worksheet page for each employee under comments column either the + sign icon or a comment icon will display.
The + sign icon means no comment has been added yet for this employee; the comment icon means at least one comment
is added for this employee. You can view the existing comment by clicking the comment icon.

Figure 204: Worksheet with comments column

To View comments added on the worksheet page:

Click on the comments icon against the employee's name. The comments screen will display the comments added for
that person with the following details:

• The comment text

• Created By, Edited By and Last Updated on

• The Edit and Delete options show if you have the privilege to edit and delete.

Note:  If you have the privilege to edit values on the worksheet grid (in any fields that are designated as editable),
then you also have the privilege to create comments, and to edit and delete your own comments. (Compensation
admin and HRBP can also edit and delete comments created by other users.)
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Figure 205: View comments

In the comment text box at the top, you can also add your comments and save.

To add a new comment:

1. Click on the + sign next to the person that you want to add your comments. (Or, click on the Comment symbol, if
you are adding a comment for an employee who already has one or more comments).

2. The comment screen will display.
3. Enter your comments and save.

Figure 206: Add new comments

Edit and delete privileges for comments are given only on the security based allocation and the worksheet status.

• Compensation Admins - can edit comments on any status of the worksheet except the Completed status.

• HRBP - can edit comments on any status of the worksheet except the Completed status.

• An allocated manager - can edit the comments only in the Allocation in Progress status and Returned to Manager
status.

• An Approver - can edit comments during Awaiting Approval status of the worksheet.

An approver's ability to edit depends on the worksheet status and whether the Approver can edit allocation values
policy for the plan cycle is turned on.
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Compensation managers and approvers can include comments in the worksheet that they are authorized to view and
edit. This feature provides a mechanism to record details associated with compensation decisions made for each member
in an organization.

Out of the Box notifications to display text

Until this release, out of the box notifications did not contain any text or attachments.

Starting from this release, when notifications are triggered, messages associated with each notification will be displayed.

Example:

Notification Name: Compensation Plan Assigned

Message Subject Line: Compensation Plan Assigned

Target Audience: Managers

Email text:

A Compensation Plan has been assigned to you.

Plan Name

Allocation Due Date

Click here to access the plan. [link to the plan]

Figure 207: Notification Generated

Following table provides compensation specific notification details and when they are triggered during each stage of a
compensation plan.
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Table 104: Notification Details

ActionComponentTrigger PointNotificationNo

Predefined - Send No~
tification to adminis~
trator

Predefined - Send No~
tification to approvers

ManagerPlanCycleRelTriggered when approval is
required for compensation
allocation

Approval required for compens~
ation allocation

1

Predefined - Send No~
tification to adminis~
trator

ManagerPlanCycleRelTriggered when compensa~
tion plan has been approved
by all approvers in the ap~
proval chain

Compensation plan has been
approved by all approvers

2

Predefined - Send No~
tification to manager

ManagerPlanCycleRelTriggered when compensa~
tion plan has been approved
by any approver in the ap~
proval chain

Compensation plan has been
approved by any approver

3

Predefined - Send No~
tification to manager

ManagerPlanCycleRelTriggered when compensa~
tion plan has been rejected

Compensation plan has been re~
jected

4

Predefined - Send No~
tification to approvers

ManagerPlanCycleRelTriggered when compensa~
tion plan has been reopened
by compensation admin.

Compensation plan has been re~
opened by compensation admin

5

Predefined - Send No~
tification to manager

Predefined - Send No~
tification to Approver

ManagerPlanCycleRelTriggered for compensation
distributions that are in
pending approval and due

Due date for approval is ap~
proaching

6

date for approval is approach~
ing

Predefined - Send No~
tification to managers

ManagerPlanCycleRelTriggered when compensa~
tion plan is available for
budget distribution and alloc~
ation 

Compensation plan is assigned7

Predefined - Send No~
tification to compensa~
tion administrator

CompensationPlanTriggered when a compensa~
tion plan has been marked
completed.

Compensation plan marked
completed

8

Predefined - Send No~
tification to compensa~
tion administrator

CompensationPlanTriggered when a compensa~
tion plan is activated.

Compensation plan activated9

Predefined - Send No~
tification to managers

CompensationCycleTriggered when due date of
the compensation plan is ap~
proaching

Due date of the compensation
plan is approaching

10
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Out of the box notifications now convey appropriate messages. Managers, approvers, and compensation administrators
can now be alerted by clear messages and links to actual documents that they need to review to complete their actions.

Allow compensation managers to access compensation
data on profile page

Until this release, a manager captured in a snapshot view as the manager for a specific employee but no longer the Line
manager (current), did not have access to the employee's compensation historic data, compensation statements, letters
and other necessary data from the profile page.

Starting from this release, line managers, approvers and others who are assigned to a worksheet can access compensation
specific data from the worksheet and will also have access to employee compensation profiles, compensation letters and
statements.

A manager who is assigned to a worksheet for an employee and needs the profile details, can click on the name link on
the employee's profile mini card. The link will launch a new view that displays the following compensation specific
details for the employee:

• Basic Information

• Current Job Information

• Compensation

• Compensation History

• Compensation History - Additional Data

• Compensation Statement

• Compensation Letters

To launch and view an employee profile page:

1. Log in to Compensation module as a manager.
2. Navigate to My Team > Compensation>Compensation Plans
3. From the list of plans select the Plan which lists the employee whose profile you want to view.
4. On the worksheet, click on the employee's name.

The employee's profile mini card will display on the side.
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Figure 208: Manager accessing the employee profile

On the employee mini card, click on the name link.

This will launch the Compensation Profile view for the selected employee.

Figure 209: Compensation Profile view

Compensation managers can now access information that they need to complete a worksheet process even if they are
not the current line manager for an employee.

 | Compensation | 449



Cancelled/Deleted plan data can no longer be reported in
Analytics

Until this release, after cancelling/deleting a compensation plan cycle, the attributes which were associated with current
cycle were still available in an analytics report.

This has been addressed in this release. If a compensation plan is deleted or cancelled, the associated attributes will be
removed from Analytics.

Note:  Plan cycles can be deleted only when they are in Draft or Cancelled state.

To delete a Plan cycle:

1. Navigate to All Plan Cycles page.
2. Choose either Draft or Cancelled from the Status option.
3. Search for the specific Plan Cycle that needs to be deleted.
4. Click on Delete Plan Cycle from Actions.
5. A warning message will display to indicate that you are about to delete the Plan Cycle.
6. Click OK, and the selected Plan Cycle will be deleted from the list.

Figure 210: Delete a Plan Cycle

Compensation administrators needed the ability to remove from the system old and incomplete Plan Cycles that were
no longer relevant to their scenario. By enabling this option, they are now able to work with more relevant data and a
less cluttered environment.
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Data sync between Compensation and Analytics – Plan
Activation

Until this release, compensation plan activation could not complete until data synchronization in Analytics was completed.
This was causing delays in plan activation.

This has been addressed in this release. When a plan activation is initiated, data synchronization is automatically triggered
in Analytics. However, this process may take some time to complete. The plan activation process once initiated can be
completed independent of the data sync process. This improves the plan activation time and also reduces the risk of plan
activation failing due to unexpected issue with Analytics module.

Activate a Plan cycle:

1. Navigate to All Plan Cycles page.
2. Choose  Draft from the Status option.
3. Search for the specific Plan Cycle that needs to be activated.
4. Click on Check Data.

Note: You may need to execute the Check Data Step explicitly and rectify all the errors before starting the
activation process.  If Check Data step fails, you will not be able to activate the plan.

5. Click on Start to initiate the activation.

As mentioned above, the data synchronization will be triggered and the plan activation process will complete based on
its own workflow. When the data synchronization completes in Analytics module, the associated report can be generated.

Figure 211: Check data and activate a Plan Cycle

Plan activation will no longer be delayed due to the delay in data synchronization with Analytics.
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Improved data Sync between Compensation and Analytics
Reporting

Until this release, update or edit of every single field in compensation data resulted in update to Saba Analytics.

This has been addressed in this release. Compensation data is not synchronized to Analytics after every edit.

Saba Analytics Report will be updated during the following steps:

Table 105: Use Case showing Compensation data update and Saba Analytics synchronization

StatusUpdate to Analytics ReportingCompensation data update/edit scenario

YesIs Analytics reporting model  updated?A Manager launches the worksheet> makes one or more
edits> clicks Submit

YesIs Analytics reporting model  updated?Approver launches the worksheet > makes one or more
edits> clicks Approve link or Return to Manager(Re~
ject)link.

YesIs Analytics reporting model  updated?Compensation Plan is Approved:

Admin > is allowed to change values

YesIs Analytics reporting model  updated?Compensation Admin>closes the plan

YesIs Analytics reporting model  updated?Compensation plan cycle has been Approved >Admin
has the option to reopen the worksheet.

Compensation data is not synchronized to Analytics after every edit and so Analytics Report will be updated only at
specific operations. There is a clear indication of when to expect an update on the Analytics Report.

Create Custom Manager hierarchy to distribute budget

N/A
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Starting from this update, compensation administrators can define who within their organization have budgets to make
compensation recommendations. They can create custom hierarchy for specific plans, so that the allocation and distribution
of compensation amount can be performed by managers who are not the line managers of certain employees but are
identified to perform these responsibilities based on their experience, current organization structure and other aspects.

Compensation administrator can assign a custom hierarchy manager to an eligible employee, by adding the custom
manager details to a template and uploading the file to snapshot data using the import option from the People Snapshots
page.

The People Snapshot page lists all the snapshots created and it indicates whether a Custom Hierarchy exists for a snapshot
by the Yes/No flag under the Custom Hierarchy column. It also features the Edit icon under Actions menu, to allow
the download/import option.

Figure 212: People snapshot screen showing the Edit icon

To add a custom manager hierarchy to a snapshot:

1. Navigate to Admin>Compensation>Configuration>People Snapshots
2. Click the  Edit  icon.
3. Download the snapshot template.

Figure 213: Edit snapshot screen

4. Enter the custom manager user name in their fields.
5. Import the file using the  Import Snapshot data option.

The user name field and the custom manager's user name field are key fields.

Note: The import process may fail and a resulting warning message will show if the following scenarios occur:

1. Adding a nonexistent or terminated person to the list of employee user names
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2. Specifying a nonexistent or terminated person as a custom manager
3. Specifying a cyclic custom manager relationship between some users. (example: User A reports to User B, User

B reports to User C, and User C reports to User A).

You can resume the import step once the issues are addressed.

Adding a new User to a snapshot

The Edit snapshot page also allows you to add a new user to the snapshot. If a new employee has joined the group or
company after a snapshot was created, the Add Users option from the Edit Snapshot page can be used to facilitate the
addition of this user to the snapshot.

To add a new user to an existing snapshot:

Click on the Edit icon for the snapshot that you want the user to be added to. The Edit Snapshot page opens and because
we have new users in the system, the Add Users option displays on this page. If there are no new users for a plan cycle,
this option will not show in the Edit Snapshot screen.

Figure 214: Add new user

Select the names of the users you want to include in the snapshot and click Add.

Budget Distribution

When a snapshot is created for the plan cycle, based on the details of the imported file, the custom hierarchy manager
will have the access privilege to view and edit compensation data for the eligible employees assigned to him and will
be responsible for compensation recommendations, budget distribution and approval of the compensation package
offered to the assigned user.

You can assign custom hierarchy to the compensation plan from the Budget Distribution page, and any update to the
details of the custom hierarchy can also be handled from the Budget Distribution page.

To choose custom manager hierarchy:

From the Budget Distribution page, select Custom Hierarchy:

• Use Line Manager Hierarchy - If you decide to keep the line manager for the current plan.
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• Use Custom Manager Hierarchy - if you decide on the custom hierarchy manager and click Continue.

Figure 215: Budget Distribution page - Select Custom Manager Hierarchy

The custom hierarchy will be applied to all assigned employees in the selected Plan Cycle.

Note: When choosing the custom hierarchy, it is not necessary to define custom managers for all employees in
that snapshot, but all employees in the eligibility criteria should have a valid custom manager. If an eligible person
has no custom manager, then during the Distribute Budget step, the eligible user will be placed into the Reserved
pool. In that situation, the administrator can revisit the Budget Distribution page or the People Snapshot page to
add custom manager to those users and reimport the file. Alternatively, the administrator can also allocate, approve,
and distribute their compensation funds.

Budget Allocation

The following sequence of events will occur with custom hierarchy selection:

• The custom manager will receive the budget funds to be allocated to the employees selected for the plan.

• Check Data step will validate whether compensation managers are assigned for all eligible users.

A warning message will appear at the check data stage, if there are eligible users with no custom manager assigned.
Compensation administrator can update and import custom hierarchy again for the snapshot or choose to ignore the
warning.

• Custom manager will have access to Compensation in My Team.

• The custom manager will have access to the employee's compensation data and will make compensation
recommendations and budget allocations for the employee.

• After activation of the plan, approvers will be selected based on custom hierarchy.

Currency Selection

Whichever hierarchy option you choose, all managers selected for the plan and all eligible users should have valid
currency options assigned. Otherwise, during the check data step, an error message will display and the managers without
a currency selection will not be eligible for budget allocation.

• If a plan cycle is configured with All managers in the organization hierarchy who have eligible direct reports option
is selected, the system will check the currency details only for the direct manager of the user.

• If the plan cycles configured with nth level selected, (example 3rd level) then the system will check the currency
details for the entire hierarchy of the eligible user.

• If the custom manager hierarchy is selected, then the system will check the currency details for the custom manager
selected.
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Compensation managers can now access information that they need to complete a worksheet process even if they are
not the current line manager for an employee. For the compensation administrator, this feature provides the option to
define who within their organization have budgets to make compensation recommendations.
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